EHAVA

SACEE oaToy

VIDYASAGAR UNIVERSITY
DIRECTORATTE OF DISTANGE EDUCATION
4 - MIDNAPORE 721 102 |

M. SC. IN APPLIED MATHEMATICS «

WITH OCEANOLOGY & COMPUTOR PROGRAMMING

PART -1
Paper:V
Module No. : 49, 50, 51, 52, 53, 54, 55, 56, 57, S8, 59 & 60

S S




M.Sc. Course

S in e e
Applied Mathematics with Oceanology
“and

Computer Programming

- PARTI . |
Paper-V : Group-A : Marks-50

.,.

Module No. - 49
(Mechanics of Continuous Media).

STRUCTURE::
L1 Inroduction
12 Objectives
13 Key Words A
14 Conceptof Continuum -
- L5 Continuum Particle ’
B N Configuration .~
1.7 Defoﬁnaﬁon__,
18 ff,Sﬁiin‘Deféﬁﬂaﬁoh
19 Tnmslation
1.10 | Rotation
I..l‘li Moﬁon . _
" 112 Material Method or Lagrangian Method of Describing Deformation
113 Spatial Method or Eulerian Method
114 Displacement
o 1:15 ,Fixﬁte.StrainTensor(lag'rangianMethod)
- L16 - Changeinthe AngleBetween two Line Elements

Directorate of Distance Education



Mechanics of Continuous Media.................... reereuss s athe R as A eRsR bR ebe RS H e rbesresnantonebesens ereurereeraenens R

117 - EulerianFiniteStrain Tensor
118 Chhh‘geinlheAn'glé
119  Small Deformation

120 Geometrical Interpretation of Small Deformation
121 o Volumetnc StramorCubtcal Dllatanon |
122 Umfonnmamnon :
1.23 UmtSummary
1.24 Worked Out Examples
1.25 ‘ | Self Assessment Questions

126  Further suggm?edzaeadings;‘

l l INTRODUCT ION
In thns module we have dxscussed about the basxc concept of the continuum mechamcs whlch is essential to

study about Strain.

120BJECTIVE
* The concept of continuum mechamcs is essential to learn the properties of matter. In this module the.
students will learn the methods and techniques to discuss the Strain and how it acts on the continuous media.

1.3 Key Words : Continuum, Configuration, Stram, Deformation, Displacement Gradient, Strain Tensor, Small
Defoxmation, Nonnal Strain, Shearir}g Stram, Cubical Dilata_tion, Uniform.Dilatation. _

11 Cencept of Continuum :

" It is acommon knowledge that every physxcal object is made of molecules, atoms-and even smaller
E pamcles ’I‘hese pamcles are not continuously distributed over the object; microscopic observations reveal the
. presence of gaps (empty spaces) bet»ve:n particles. While studing the external effects on physical objects, thcse
gaps may or\@y not be taken into éog:sideration dependingon the.hypolhésis made. The study that takes account
of the existence of gaps is called microscopic study. On the other hand, the study that ignores the gaps and treats
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aphysical object as a continuous distribution of matter is called macroscopic study. The subjects of solid and fluid

mechamcs are concerned mainly with macroscopic study

We see various types of materials like milk, water, honey, blood, wood, stone, steel, glass and flesh. Every
"~ such material body occupying a region of space is composed of a nurtiber of discrete molecules separated from
one another by empty space comparable with rholecular size. The matter in the body is evidently discorrtinuous and
each molecule in the body obeys the law of Newtoman mechanics.

* Thus the macroscopic vxewpomt adopted i in the study of solrd and ﬂurd mechamcs leads to the notionofa
contmuous medmm, orbrieflya continnun, ‘Bya contmuum, wemeana hypothetrcal physical ObjeCt in which the
matter is contmuously distributed over the entire obJects So,a continuum rs deﬁned to be a continuously distributed
matter completely f illing up the region of space, it occupzes with no empty space so '‘as to ensure that it
possesses unique physical properties such as unique density, unique dzsplacement, unique velocity at every
point of the space. These physical properties can now be expressed as continous functions of position and time.
L5  Continuum Particle: | , N | .

We can deﬁne the material point or the particle as the smallest piece of matter containing a large number of

molecules thhm aninfinitesimally small volume whose physical dimensions are so small that it may be regarded as

-concentrated ata point. Accordingly in contmuum we can associate a material pomt wrth each and every spatxal ‘
pomt of the regron of space occupied by a contmuum body ' S '

1.6 Conﬁguratron : i b
The complete specxﬁcatnon of the set of positions of all materral points of the body at a given trme is called

' the conﬁguratron of the body at that time. Thxs specrﬁcatlon is the region of space of certain volume havmg a
boundary surface, This region contams the contmpogs body ata giventime. -

1.7  Deformation:
_ Leét us consider a continuum body of material points occupying at ¢ =0, a certain region of space B,

4 consisting'-of volume ¥, and its surface S,. When external forces are applied to the body, the material points of B,

move so that at subsequent time 1, they occupy some other region of space B-consisting of volume ¥ and surface
S. Consequently there are changes in the positions of all the material points of the body. The body is then said to be

deformed and the transformation of YMWV fram its initial configuration to subsequent configuration is called
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_ Asaresultof geneml deformation, acontmuum body will change i xts conﬁguranon and orientation as well as
its shape Our first task is to separate that part of the general deformation which causes a change in conﬁgmahon
and orientation of' ;he body from that part which causes a change in the shape of the body. -

When the deformauon is such that there areno changes inthe relatwe posmons of constxtuent material
~pomts of the continuum ﬁrmly bound togetherso that the length of any linej Jommg any two matenal pomts does not
. | change, then the deformatxon isa combmatxon of translanon and rotation about anaxisat any point causmg a
change in conﬁgurauon and orientation of the body only andis callcd ngxd-body defonnatxon and the body iscalled
the rigid body. o
1.8 Strain Deformatlon -

- When the deformation is such that there: are changes inthe relative posmons of consntuent material pomts '
of the continuum body so that the length and onentatlon of a any line joining any two points' changes then the
' deformatxon causesa change in the shape of the body only and is called st;am deformation and the body is called

defonnable body '
S The idea of strain is of’ relatwe rather than absolute change in 1the posmons of matenal pomts The exlstenoe _
of strain deformation clepends on the occurrence of relatxve displacement of points in the medium w.r.t. each other ‘
| .19  Translation: '
~ Whenboththe length and the onentatxon of the material arc dC are now preserved under the deformatxon, .

| _ then such a deformatxon iscalleda ngxd-tmnslatxon or Just a tmnslatxon.
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1. 10 Rotation :

The effect of the deformation is just to change the orientation of the material arc dC without changing its
length. Sucha deformatxon is called a rigid rotation or just rotation, It is to be noted that, under a rigid rotation, the

_ material arc dC may experience a translation as well.

1.1 Motion:

* When a continuum body undergoes a deformation which continuously varies with time so that there isa -

. continuihg'change m the configuration of the continuum with the passage of time, we say that continuum body isin-

motion. . ;
1.12 Materlal Method or Lagranglan Method of Descrlbmg Deformatlon :
In tlus method we identify mdxvxdual material points and describe the motion of each mdmdual material

. pomt of fixed xdentxty for all time by following its motion through out xts course. Indxwdual matenal pointsare change _

in two ways: as we pass from one matenal point to another and they change astime changes for a fixed material

pomt i.e,the physxcal propertxes of the individual matcnal are consndered as functlons of time and ofthose data

l

Each matenal pomt of the contmuum is xdentlﬁed by the rectangular cartesxan co-ordmates ( X, X, 2 X 3)

~ofi its positioninits xmtlal undeformed state. In this descnptxon the phys1cal properues are assigned to these matenal ' h

pomts labelled by these co-ordinates at the initial conﬁgmatlon All physical propertles associated thh thxs matenal
point will then be functions of X, X, X, s and time ¢, The pnmary quantxty in this method is the position of the

matenal pointinthe dcformed state of the body at subsequent time . If (%;» 20 xa ) be the nectangular cartesian cq-

ordinates ofthtsposmon, then |
| x(x,,x,,x,,f) P=1.2,3 i (1)

Above equatlons descnbes the motxon of the material point completely in material method gwmg the
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" subsequent position at time 1. The co-ordinateé X, X, X, are independent CO-ordinates called material co-
ordinates or Lagrangian co-ordinates, whereas x, s Xy, X, 8re dependem co-ordinates called spatial cu~ordlnates.
1.13  Spatial Method or Eulerian' Method :
In this method we xdenufy the spatial points and descnbe the motion of the medium at each spatxa! point at
dtﬁ’erent t:mes without considering the whereabouts of md:wdual material pomts We focus our attentxon ona fixed
| spatial point in space occupied by different material points at different txmes and observe what changes of various
' propertnes are taking place atthe spatlal pomt The spattal points, m amanner of speaking are endowed with
. physwal propertles and a material pomt is said to acquire these properties associated with the fixed spatial point
whenit happens to pass through that spatial point. In this method, physical properties changes in two ways: when
we pass from one spatial pomt to another point and with time at a fixed spatial point.
o Ifa matenal pomt whnch was at the posmon ( Xy X 1»X;) in'undeformed state at t==0 happens to occupy
,' the posmon 3%y, x, at subsequent time¢, then co-ordinates x,, ) ldenufy the spatxal pointinthe deformad |
state. Thusthe physxcal propemes will be functions of (5%, %) and tune tIn pameular, '
| vX, =X (x,,xz,xs,t) i=12, 3 ........ @)m v e
The pnmary quantity in this method is the velocity of the material point, If v, v,, v; bethe components of
the velocnty of the material poxnt occupymg the position (x, 1 Xy, Xy ) in the deformed state at txme t,then ‘
| | v, =V, (%% X3at), :—l 2 3o Q) "
The velocxty is measured at the current position (%0%3.%5) . It istobe noted that the initial co-ordmates
X, 19 X2 X used in matenal method is irrelevant in spatial method The symbols x,,x,, x, serveas the name of the’

- place in space where material pomt resides. They are called spatxal co-ordinates or Eulerian co-ordmates and they :

are mdependent ‘
Equanons (1) and (2) are inverse to each other. For fixed ume t, wehave

x,«x,(X,,Xz,X) i=1,2,3...... (6}
(and X=X (%,%.%) i=1,2,3 e (S) | o
These equations will only relate initial configuration o subsequent configuration and will naturally characterise

the deformation.
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1.14 Dlsplacement : ,
'I‘ne displacement u, of a typical material pomt fromits posxtxon (X, X, X, ) inthe undeformed state at

r=0toits posmon (%%, %) in deformed state at time / is deﬁned by
u=x-X,i=123 ...... 6)
It ehould be noted that in the material method ie.,in the Lagrangian method u,and x, are regarded as
funetxonsofX,,Xz,X and ¢ so that ) | | | |
4, (x,,x,, Xt ) =x, (X,,X,,X,,:) =X, v (7)
In the spatlal descnptlon ie,in the Eulenan method, »,and X, are regarded as functxons of x;, x2 \ Xy and

. th, (X, %0 X300) = %, X, (X5 X0 X358) vvvens (8)
1.15 Measures of Finite Stram Deformatlon Finite Strain Tensor in Lagrangian Method :

. Weconsidera change in the length of material line element . e., the finite strain deformation from initial

undeformed configuration (B,, Sy, ¥, ) to the deformed configuration (B, S, n.

Let us consider a material element (lme) POy Jommg a paxr of nexghbounng points Po , Q0 of lengthi dL -

onented in the direction (N,,N,,N ) in thie initial undeformed fegxon Bo attime. t—-—O If R, has co-ordinates

(X,,X,,X ) and Q, has co-ordmates (X, +dX.,X2 +dX,,X +dX,) W.Lt, anorthogonal setof co-ordinate

. axes fixed in space, then
}=(X, +dX, - X)+(X+dX X)+(X+dX X)
=dX? +dX? +dX;
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. N =—=~i=]23
and . M=

.' ' where 5}, is the Kronecker delta definedas .
o , i=j '
. 5!’ ] {0 . )
y F# )]
* Whenthe body undergoes def'onnation, the pdsitions of these two points will be Pand Qinthe region Bat
txmet Let dl be the length of the new lme lement PQ orxented in the direction ( n, ,)}2 n,) and the co-ordinates of

PandQ are (x,,x,,x3) and (x, +dx,, x, + dx,,xJ +dx. )respectnveiy wrt. the same fixed set of co-ordmate

axes. Then | ' .
I = (% +dx - x, )z -J-(lx2 +dx - %, ) +(x, +dxy ~x, )
| =dx +dx] +dx] |
' t'gsydx;dx; S—— &)
aﬂd n,—-‘-j,l—-l,»z,:i ............. (4)
In matenal method or Lagrangian method, the deformation is charactensed by equatxon
-xk (X',Xz,XJ,’) cccccccccccc 5) -
&, o,
sodx, --——-—dX —k
ax, T EX
ance x, +dx, are co-ordinates of Qattha same txme t, so,
_ 9% %
- ' dx,,’ -5;\;;‘“'/\’, X dX [—C)
Using (6) in (3), then we get e
B T 7R VR VU
di? =8, —idX —L = L. —LdX, dX
' ”aXp an' . ‘,' aX‘ GX,, k P soavsvccass (7)

| Hence, the differdnoe dl” - dL? isthe measure of changé m length of aline element. |
. & : -

So, dl-dl’ =g &, - dX,d, - O,dXdX;
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"a_X"l" “é‘i"dAXkpr "5@dxkdxp

L dred . ax 4, .
] AlSO, sz "'2’”#'#"’zrle*Npouuuunu(lo)

If 4, be the dxsplacemem of a matérial point fromits positxon R to P then

VIS A, (T ¢3)) v
If u, + du, be the displacement of the material point from its position @, t¢ O, then
ok =(x +dx )= (X, vdX, | R—C

o x-X +duy = x,~ X, + b ~dX, (using (11))
o, - dx adu,-&-dX

Sty § .

A, B Ot (13)
oy oy |

and 5}“*5}* #8p s (14)

Herice from (9), itis clear that

wrif *‘f**')(’é"xt*“ff,Jf‘*%}

_ c?u,k By, 6u,
[axk +ax, ax, | (15)

1.16 Change in the Angle Between Two LineElements:
Next we consider the change in angle between two material line elements £, and }{,Roat ) A mclmed &

anangle @, where BQ, (= dL) oriented mthedmectxon (N,,NZ,N ) and PRO(- &L)oriented inthe direction
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(M‘,Ma,M,)intheregion B, where o and R,, hastheco—ordmatgs (x, +dX,)and (x +8X,) respectively,

egg@ T (»1‘6).
(21 ax,
M, == N,--—‘;Z—.,,f...‘.........(l’i)

Inthe deformed state these line lements amPQandPR respesuvely and @is thegng!e between them. Let

PQ = dl and PR=61 are onentcd in the direction (4,7,,1,) and (m,,m2 my). IanndRhascowrdmams
: x,+dx and x,+5x,,then .

dxvé'x

cose-:ﬂ— 81 —(T.))
Ox, dx,
md htr Sk
Naw frem (6); itisclear that -
. &, «,—;-Léx ax SEdX,
LOP=SL . 8K, 85X, ax X, o
YRR T ¥esn Sl T aL oL = MM e (19)
d”"dL' ‘ ﬁ‘_X_U?_é’.a &, &,
a“d T Yeg e a 2”?”’”'
Agg;n,dxéx dX OX, =dx,0x, - 4,,X¢Sx
Jon o
aX oX, aXoX,-dX X,
~ | 2 B é 729
| | =2 gméx, ......... @)

[where r,, isgiven by (1)

L Ox _dX, 8X, géjgzg 29
"L aL L sL VL 5L

Directorate of Distance Education



Mechanics of Continuous Media

teeTIIITRIYSIIYISHIRIE IR I IO IR I, Seesrecsesrorerersrsrererary P L T Ty T Y YR

o 0% d 8 dx, ) lzde ax,
a8l dL 8L dL SL dl 8L

o, L -él-cosé—cos@):Ze;,N, M. (2D

dL oL
(usmg 16, 17,18)

" Equatlons (10),(19) and (21) shows that if r, =0, thendl=dl, 8l=6L,0=0. Tpus when 7, =0, then
length ofg line element and angle between two line elements remains unchanged during degormanon and the body
has und@rgone only rigid body deformation, -

‘ The necessary and sufficient condition for rigid body dejbrmqnan at eaeh point is r, = 0. In other
words 7, cause achange in the length and oriemtation of a line element when body is deformed. A nonzero tensor
tensor.

7, represents strain defonngtmn and 7, is known as strain tensor, a finite strair
Note -1,

From (10) i.e., %_Z_EP_ = 2@1\’ N. P wg observe ghag 2 N,N ' is a scalar, But product NN of twg

v@gtor compongnts is known to be atensor of order two, Thereferg, by guotxent law eftensor Y isa second order -

 ténsor known as Lagmgian Finite Strain Tensor.
Note -2.

il o ou, u, . o S
From (15); A g[agl, + ax, + o M} » we observe that 1, =ty Therefore, tensor 7, is

Q}'Iﬂmﬁtﬂc .
1,17 Eulerion Finite Strain Tensor 1 Spatial Metbod , -
In Bulerian methad i.e., spatial method of description, x,,x,,%;,fare ;egarded as independent variables

A\
andthe equatign characterising the defom:gtmn as -

) XQ (539:?2;'&3;!) ',999:.':7?9 (2;%) :
= % v (23)
“Then dL’ - =dX,dX, = % Qaﬁ, 4@:,, -
and d] —64&4& ............. (24)
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i!iﬂﬁg' = znyln;(:; oo (25)
where 7, ~i[3,,'_%x& %&} e (26)
‘Now dX,»=dx,,—~du,, |
B g %ﬁ- =6, - Z;
i %‘*”%
-
. _:12_ r:,y,, 8,8, + Z‘;: 5, +Tg:: s, -‘Zf :: }

‘ 118 Change in the Angle :
'Now dxox, ~ dXé’x, ddxéxj dX,,é’X

 =8drox, a;rf_ax,cw

dX, 6X, dL 6L dxé‘

"dx";‘-’s—&-—-—-—~—-—-~-—-—---—-—°2n 2 nm

ael AL Sl dl el i 51 "”"
J

4L 6L | :

on 49950‘"?“,‘1"”3;"0059=277.1””',..‘.....-...(28)

- Now, if 1 7,=0, then dL dl, JL 61,60=0, 'I'hxs corresponds to rigid body deformatlon Hence, the
- 'necessary qnd sufficient condition for rig:d deformatmn at each point. is m = 0 The nonzero tensor 17,, grves
' nseastram defonnat.lon, and it can be regarded as the measure of this strain deformation. Resoning as before, from

" (27) we see that 1, isasymmetric tensor of order two. It is known as Eulenan finite strain tensor,
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1, 19 Small Deformation : Inﬁnitesimal Strain Tensor
- Thete are many common materia!s hke metal 5, concrete, wood experxence only small chaﬁges of shape
when forces of reasonable magnitude are apphed to them.

Ou_ oy
Ifthedisplaoement gradxentsie 3X‘ or 6x . are so small that squaxesandproducts of partial denvanves

of u, are neglxglble, then Lagrangxan finite straxn, tensor reduoes to infinitesimal strain tensor.
" Let E,, and e, be the Lagrangian and Eulerian linear strain tensors respectxvely deﬁned by :

E, = 2[6,\’ ax,. .......... 29)
(x,.x,,x,) ou (x,,x,,x,) o
aﬂd e” 2[&] : . +aXI ooooooooooo (30) :

We f rstassume that all dxsplacement gradxents are numerically small compared to umty, SO that

a;, <<l(x Jj= 123) ............ (31)

and we can neglect the squares and products of these quantxtles because they are small quantities of
‘ second order So, the ﬁrst order inthe dxsplacement gradnents

ou, Ou, .0u, ou
”(X"X”X )= [ax 7 +a); a);] |

’[a"; Z;] E,,(X,,X,,X,) |
r,2E, —— (32)
Also,wehave Izd;',d sz..Z-E”N,N/ .......... (33)
and i{- %cosﬂ—cos@ 2E NM ,,,,,,,,,, 34)
Similarly, for | —- | <1, ,~1 2,3) e ( 35)7
/
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.___1_ [ ou, (x,,x,,x,) au (x,,x,,x,) au 814
weitflave ’Ilj _?2_ ax/ , a’ ax ax
JMou ou]
“2Qox, ox |
My éve,,‘ verseness (36)
dl.-dlf o
Also, 7 =2e”n,n/ ........... 37N
and cos@ --‘%'--%—cos@ = 26,1, covrrr (38)

Secondly we assume.that displacemem themselves are small in addition to displacement gradients so that

.we can neglect the ptoduct terms like u, —= aX

Smce,
' ) ==X,.+u,.v" ' ,
..u,(x,,xz‘,xj)e:u.(X +u,,X '+uz,X,;+u,) -

au
=u (X',Xz’Xs)'* u, ax +e -u(byTaylor Expansxon)
/.

,"\.\. Eu,(X,.XpX;;)
Hence,
(X,,XZ,X) Ou, (xpxpx;) Ou, (x.,x,,x,) o
ax Tox, . oy ax,
AR PR
&‘ . ! an
X5 Xy, X. .
a—‘-( P 3) Oy [Neglectmg product terms] -
k-
ou, (x,,x,,x :
=a—;-‘("’ ) , (39)
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Ou, (XanX:) Ou, (x,,x,,x,)

| 'Sumlarl,aX )
" Therefore, we have |
£ oA o (XX X5) | 3w, (X, X X,)
o2l ex ax,

L)

1 p%(x,,x,,k,)‘*iu_!“(x"xz,x’)
2| &, - Ox,

....... .. (40)

St

[u, LT ] (incomma notatton)
Thus if both the dlsplacements and dtsplaoement gradtents are small compared to one such that theu' '
squaxes and products canbe ncglected, Lagranglan lmear strain tensor E are 1denttcal component by component o

~ totheir counterparts in Eulenan linear stxam tensor e,, 'Ihexefore wedo not requtre any dtstmctton between the

two methods of descnpuon for the mﬁmtesunal stram tensoxs, and snnply call it mﬁmtesunal or small stram tensor _
1. 20 Geometncal Interpretation of Smali Strain Components . :
To gtve a geometncal mterpretatxon of strains E, 1 Eu , E,, we ﬁrst cons:der the change in length of a

matenal hneelement.
a) Extenston of, a material Ilne element Consxder a material lme element RO, of length dL at\' \_

B 5 (X0 X 2 X ) orxented inthe dtrectton of (. N, . N, , N,) m the undeformed body. Aﬁer defonnatlon xt has take
place PQof length dlat P (x, 1 X2 %y ) in the deformed body in the direction (n| n2 , n3 ) Then

dr-dl* . ’
T—.ZE"NN --------- (41)

Ou, Ou,
. where £, =~ —L+—+ bei mﬁmtesxmalstmmtemor

V= {ax +axJ mg
at P,. From(41), we have

2
—‘-1-1-—«1+2E NN,
dL?

Directorate of Distance Education 15
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o 2 [l+2E NN, ]/al+ 2E NN, + ...

Ifthe stram components are so small that we can neglect squares and products of E,, thenwehave

dl
——=1+E,N\N,
dL

dI dL
or, N .............. 42
L E NN e (42)

Now L.H.S. of (42) is the extension per unit length of a lmeelement oriented i in thedirection (N,, N,, N 3)
andxsealled small extensional strain, and xsdenotedby Ey). Hencethe small extensional strain is

Geometrical Interpretation of £, E22 , E,,
' lfthe lmeelementwasuutxally parallel to X, axls,then wehave N, =l N,. 0 N, -0, “ |
'_ A '__Eu,b",," ,' _

_ Thus E’ll is the extensxon per. umt ongma.l length of aline element wlnch is mxtxally parallel to X axls :
.Sumlarly ).‘.‘22 yEqy tepxeeent, teepectxvely, theextensnon ofa lme element perumt ongmal length wlnch ane mmally :
E parallel to X, and X axes. Here E,, E;, ,'E,, anecalled extensxonalstrmnornonnal stram
| To glve geometnoal mterpretatxon of E23 yEyy, By we consxder thechange in anglehetween orthogonal line
elements. < y
(b) Shear (or change in angle) between two orthogonal line elements

| lf the matenal line P(,Qo ancl }:,Ro of lengths dL and dL are orthogonal to each other inthe undeformed

state, i.e. © —5-, then from (34)we get,
-g—ll:- %cosﬁ cos%-— ZE' NM,

where &, < L[ 2, 94 ] _ i 6riecimal araintensérat B.
- ox, ox, - "

16 Directorate of Distance Education
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of i % L) o 2ENM, s
; s'“(z 9) U & @)

, dL é‘ L
Now, :’Z_ ~ 6 isthe decrease in right angle between two orthogonal lines RO, and B, R, in the undeformed
state and i is ;called shear along the two lmes If r( M) . be this shear along two on:thogonal lme elements xmually

onentcdmthedxrectxon (N,,N,,N,) and (M,,M,,M ) then
U y(,w, —-2-~0 andbence

L 2ENM
S“‘"(M dI 31

dL 5L . et e
If E, and E, arethe extensxons of PQ,, and I%Ro,respecuvely, thenweget ,

dod, Ay

dL dL

. _Ol-6L. Jl
wd =TT ST

Using (47) in (46) then e get |
. 2ENM,
sin 7‘”“’ (+E, )(1+E )"

Hence, for small deformation, sin ¥y, = 7( m,,andthen

orire(86)

£=

Yoy = I+;€~IEV}A:E,E ‘ =2E, NM (l+E +E +E,E,)
=2E,N,M, [Neglecting small quanunes] —C)}
Geometncal Interpretation of E,,,E,,,E,,. . '
( If we choose a pair of orthogonal line elements lmtxally parallel to X, and X -axes, respectively, then we
get

N, =0,N,=L,N;=0; M, =0, M, = O, M; =17, =2E,
_ l }

- Ey= 57 szs)'

Directorate of Distance Education 17
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Thus Ez, represent half of the shear between two line elements whxch are: mmaﬂy paralle o X and X y

- axes. Similar i mterpretanon can be made inregard to E,; and E,,. Here E,;, E,,, E} , arecalled shearmg strains.

E, denotei mcrease in length ofaline element per unit original leng&h or decrease in right angle between two lmes

- elements. Thus forrigid deformatxon E; =0, | ' '
1.21 Volumetric Strain or Cubical Dilatation :

Letusconsider and elementaxy rectangular -
parallelopiped B,Q,R,S, at B (X,,X,, X,) of

volume element d¥, at time ¢ =0 i.e., in the

| uhdeformed, state, having edges of lengths
dax (= H)Qo')»dXz (= }%Ro):dxs ("' Riso)r parallel

. toco-ordinate axés. So, in undeformed state,

Due to small deformatxon, matenal pomts
2,0, R,, S  mibves to the pomts P, 0, RS . )
' whose posmon vectors are %, 3 + c&‘” P+ di""’ % +d¥™® so that rectangular paralleloplped P QORoSo deforms -
intoa skewed parallelopiped PQRS of volume dV'i in deformed state at time ¢,

ndV = [a’f"’ D df"’] =i, HEDxHED ...... .(51) |
Ifx,,x, ax,x, +ax®, x, +dx"’ betheco-ordmates of PO, R, Srespectxvely, then -
dV—e,,,dx*%‘%‘” .......... (52)

where e,,,, is aJtematmg symbol defined as L

_ :fanytwoofl J,kareequal _ :
‘ e =1 Lifi,j,kareeven permutationof 1,2, 3 ........... (53)
=Lif i, j,k areodd permutationof 1,2, 3
- Inmaterial i.e., Lagrangian description of déformation
.x‘=x,(X,,X2,X)
o .

"*'-53(‘“

18 Directorate of Distance Education
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R P R e
So, & = 2L dX,,dx!) = —LdX;,dx® = = dX 54
i aX,‘ 1 ( axz 2 l. aX; ( )

. Using (54)in (52), we get -

o, ox, o
v Lax, dx, dX;
"X, ax, X,

| -=Jd%

where J =g, 25 551 O l.exaL:zx_L oy o
. ox, ax, oX, |aX,| |oX, o&X, oX,
E o o o
_O(xixem) o (s5)
AKX
.:NOWJ Iaxl Ia(X ) P 5+..<‘2."_.~
ok, ox, 1P
=1+axl,forsmallst_mn,~.

=1+E, +Ey "‘En

av _i AV -dVs . ..(56)
v, av, |
Thus, for small strain E,, +E,, + E,, geomdpcallyrep:m;tsthechangemvolmne per unit original volume -

v and is called dilatation or volumetric strain. Hence volumetric sﬁam or cubical dilatation is equal to the sum of -

B+ E +E33 J-1=

Ktiueehnearstmms :
'1.22  Uniform Dilatation : When the strain quadnc isa sphere the. prmcxparm(es of strains are mdetennmate .

~ and the extension (or contraction) of all linear elements 1ssumg froma point_ is the same or we have

' 1{ dv -dV, :
E,=E,=E; =§-( T 0):_Ezs=E3|=Exz=o'
0

Directorate of Distance Education 19
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123 Unit Summary Here we have discussed sxmplc and straxght—forwm'd method regamlmg the topxc Stram

124 Worked Out Examples | | |
- Ex.-1  Given the dzsplacement field : x, =X, +2X 3,,x2 =X, 2X 3,x3 :=X, 2X +2X 30 determine the

) Lagrangian and Eulerian finite strain tensor.
Ans, 'Ihe displacements in the Lagrangian (matenal) method ane
, ' '-x -X =2X;,u, =x, =X, =-2X,
and Uy =x, — X, =-2X, +2X,.

-y

o ) . Lo 11 0u, au'/ Ou, auk :
T e | e e + '
Since Lagrangnan strain tensor is 7; "3 [ ax, ax,” ax, aX J‘

- = . =i 2:040 0 -2 32:
i = [Zax Tox, X, 2[ e +( )~ |

Ao ow aw ] 1p o ]
= zaX +6X2 e }2[2:0*'02*0*'( 2)] 2

af au au ou l |
=222 é 2:0+27+(-2) +0|=4,
-';,z_ax,*ax BX} 2[ +2 +( )+] ‘
1[ ou, Lou ou au, R, S
=h, == =—[0+0+0 -2)2)]=-2, "
=T | ax, Y, aXl "ax, _z[ +0+0+0+(=2 ) 2

[ 38

A[ou ou ow ow] 1. . .
=y se| S O O O 24 040+(-2)-0]=0,
mEL T, Tax ax, ox, -2-[ , 2-0]

[

o [, ou, 0w, 0w,
=p, =~ 3 ----2+2+0+0+0 O
Mg, Fax, T, aXJ [ ]
, (2 -2 0
Hence, ('y)— -2 2 o
o 0 4

‘For. Eulenan (spatnal) method at ﬁrst we express X, 1 X, 39 X in terms of X, ,x,,xJ Now ﬁ'om fi rst two

' given equations we get

20 Directorate of Distance Education
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Mechanics of Continuous Media

and from second and third given equations we get
X, +2x, =-4X, +5X, '
,  4x, +5x,+2x
o X = —-—-I———.——-—z-—-—h—-}-
.2 9

. Sx+4x -2x,
X ._.L......Z_......
and. 9

2=+
9 sl
" Hence, the displacements in Eulerxan descnptxon, we have

=x, - X, =(4x —4x,+2x,)/9,
Uy =%, ~ X, = (4%, - 4x,+2%,)/9, .
y = x; - X, = (8x, - 2x, +2x,)/9.

Also, X, = %, 42X, - 2X,

; NowEulenanstramtensons n = [ax +-é-x— 6x 6x]

=3 B

et 2 SR
," =T = 2|3 ax, o, on |2l 9)U9) 9179 U e U8
o Mo ow ow ow] 1] 2 ( 2.)'_(;5)(2_]_1(_;3)_3’._& o
s ==Y e Yoy, an, x| 2L 900 9) U 9N9) 99 99T

oo o ou ow] L z(z)iz(a)(z)(z)go
T=hs=7 | aw ax o) 29 L9/ 99 L9JU9)9)of "

21

Directorate of Distance Education



MechanicsofContmuousMedza...................' ....... siveoesetaOtOROse LR E SRRSO RO R4 RO AIPRS RO RR RRPHASIITSESIIN)

Hcme, Bulenan ﬁmtestramtensons |
| NE 20
(m)=5|-2 2 o}
- Lo o 4

Ex-2. 0’ the equations characterizing the deﬁ)rmatian are given by .

- xl =X,+€ )(,,x2 =X,~e X, + € X,, X, = )L’3 € X, determine the Lagrangian and Eulerlanﬂnlm slraln
'-: | tensors. Also ﬁnd infinite simal strain tensor when € is a small parameter ' '

. Ans, 'I‘he dxspiaoements in Lagranglan methods are

oh -1[266; +:; Z‘(] [20+0+(-e)’+0]—
ol o 6u,,6u_~l ' |
r#.._.z_ 26X +6X 6X] 2[20-0-(6) +0+( €) ]-—e ,

Ao oy ow] A &
—|2—t 4=t —L 1= —[2.0+0+ e’+0~=-—-—,
2%, T, ax,] (20404 (@ +0]=3

o ouy ow, w1 |
=, = + "— =—le-e+0+0+0 0
=T ax, T, Tax, ax, 2[‘4 I=

'b A "'1.6112 Ouy | Oy, ’6u',, I P
Py =hy =— =—le-e+0+0+0]|=0,
e R P Tl o ]

"’“ ax, " ox, o, ox,

n[au,' du, _du, Ou,
2 +

-~'l[0ﬂ|-0‘~n-0+(—e)ce4-0]=---§-z
2 v 2

: § \ -.

e .éz

= 0 -=.

) 2 2
H.ence»,‘(ry‘)= "0 €€ 0
) e? et
= 0 =

\ 2 2 )

22 o ' ‘ Directorate of Distance Educaxlon_
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@ . . /' ! Ex *x-*éx
From given equations we have X, = ——32——2
. 1+2e¢
3 ex+ex,-€ x
mdx Sx + 1 2 3

ye 1+2¢€

mgqr&=e@&+%-e%y0+2é)

R
(R}

oooooooooooooooo

’ Xl’*"n"

Aﬁwhﬁ&m@ﬂﬁmmmmubkmw

e x+ex,—€ x
1+2¢€

U =x-X, =(-ex+2¢€ Jé,+ex,)l(l+2 e),

Uy =x,~ X, =-7-.e(ex, 4;x,;-ex,)/(l+2é’). .

ou 1 2 €

-€ - e

{

—e’/(l+2e’),

. s R 3
sg,m. 2[zan 2 1+2e? 1+2€

€

2.

e ax.] [
-aaui ou, a“k

"o, o

'.a'u
28
L. ax!

Ouy Oy
Oy axs

—6'2/2(14-2&2),

€

o)

1+42€¢ 1+2€

’T"{I’T]=20+2eﬂ

-€ e e

1 z«...+9_ug.
2| ox,

\

-€

1
. ox, o, —-2—[1+2e’

1+2€

:)-

1426’3{25"

e )

-(

1+2¢

)|

)

-€

’ ’ ou, “ou, Ou, if
My = = s 'i'

————-*-————-:
ox, 0x, aﬁ]_ 1+2€

o

3e?

I ?-!‘-L".“-
2| ox,

1+2¢

1+2¢€ 1+2€* )|
; € -€ ).
1+2€ 2).

1426,

—E

Tr2&

1+2¢
+e
2

1+2e? \1+2€

)
(e

€
2 e [ -€

e

f,‘, '_,au. ouy_0u, Ou,
T =Ths ax,ax.axax,

Sl

1+2€

l+2§2

Ly
T1+2¢€ ’)"

__EZ A ‘el_ _ ‘EZ

JEs

1+2¢

Direéctorate of Distance Education
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’)'(l+2e’,

2@+2eﬂ |
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: A : (5 3 0 L
| 'Ex.3.. The strain tensor at a point is given by (,Ea) =|3 4 -1|. Determine the extension of a line’
| ~‘ | o0 2)

A

| 221 |
eIement in the direction of ( 33 3‘) What is .'he change of angle between two perpendicular line elements

: in the d:recnons of ('5"5"3") and ( J— T)
: Ans. Welmowtlmtﬁxesmalle@ensxonalstmn, E(m“EyNN

24 Dijrectorate of Distance Education
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ij

21
. extension ofa lmc elementmthe dn'ectxon of ( ’*3'»'5) is . -
+ZEZ,N2N +2E,,N,N

Egp = E NV, +  EnN;N; + EgNy, + 2E,,N,N

2V (2Y (1}’ 2 2 1"
=5/2| 44| 2| +2| =] +2.3-2. 24 2(-1)- 2.

(3)-(3) 3 33"3
=5 i+4-i+2-i+gi«-i

9 “9° 9. 9
.38

9

The change of angle between two perpendxcular line elements inthe darectxons of (N, , N2 ,N,) and

(Mx’Mz’M )is
7<~M) ==2E NM, =2[ENM, + EplNyM, +E33N M,
EszMz “"EnNzMn “"EzsNzMs"'EszN Mz "‘EsleM +513N1M3]

‘2[?f5“a'ﬁ*3f,§'if;+a‘ﬁ]

= ...?.g—

35 |
-Ex-4 l’f the equations characterizing the deformation are gtven by

=X +teX,x=X+eX 3%y = =X st e X where € is small determine the infinitesimal strain

tensor., » ‘ ‘
+ Ans. Herethedisplacements are
) u,:x,—~X, =€ X,
Uy =x,- X, =€ X,
Uy =x,~ X, =€ X,

oy ou |
2ax aX gives

6 ou, Ou
En OEzz “"‘""""OEss" -t

=0,
ax, ey, 0B ey,

™
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Euvggnf‘__._‘_zl_(f_“;*.'.?.‘.‘.z.)gi(e.po)sog_.
a =B =3\ax, T,
ST AR

E.=E == %% 04| 1 <&
&= S 2(ax,+ax,) 2(0%) ’
o w1 c
E,=E,=2[ %, %% | 1. 0)_&
B=5 2(ax,+ax,) 2(e40)=3-

—
. Ql”
. | —

it
wia Nie O
~oip e O e
O wip e

Again fromgivenrelations weget
fiaense )],
C Xym(x € ex)/(1+¢€),

X, = (_;-x,*e,g, & +x)f(1+€).
- (x, € x,+ € x,)v
Cl+é ’

(x' ﬁ +xz'" € x)
I+¢

uz =xz’X3 FX; =

(mevelxex)

=Xy~ X, =X = e

du, !au

’l‘hercfore, €= —1{-5;- +—éx—-) gives
i

e, ==| =— e s

SMow ow) 1 _ €
2@«\‘. ax' o l+e 1+€

€y =—==1|- .
# ox, '1."*‘%; 1+e

2

.2, ’

" Directorate of Distance Education -



| tveesstersressnnssssersssbessesssnsssisssssasans rensrsseseersasasaness trsssorsrsasasasssastenens rorsssasressas Mechanics of Continuous Media
- . e N . N L . . . ‘ . . .

3!22821=%(§_u4+§?3)51[ : +[§3)]§""e(l 2,

2| 1+€' |\ 1xé

1(0u, ou ) 1[ e '] 1e@-¢)
"”’e"”"l'(’&*””’”)”;[ni x’fé]“?l’ﬁa >

o .o ¢ _ 2 . - _
':e3|=ell=l(%+%)=%[ : * ﬁ’]gleu g)'

}_1+e’ +€’ |

oy 1 e(l-¢)
: e(l-—e). .5(1~E)
2 | 2 /

~ Forsmall e, we have, €’~ 0, e’ s‘O;Therefme.thc infinitesimal strain tensor s

( \

=)
F =S S ET

(&)=(e ) =

©  d3lm dI|m

NPm i m
oim

Ex.S. ¢, aregivenas follows:

v e, =0, =0=ey =¢,; =€, =X %,. Find .
-Ans. Gwentha:
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| Ou, Ou -
{3 .
and €53 =x2x3;1~3-,**'2"+”—'=xzx3 .............. (Vl)_

aJ'C 3 axz
Integrating (ii) and (iii), then we get -~
Uy = f(x.%) and uy = g%, %, ) oo (vij)
Using (vii) in (vi), then we get

if(x!’x3)+ig(x;s-¥3)

,axa' . _ BXz =% ’9-'3.
0 f(xpx3) 6 g(xl’xl’) x ...0 :
or, 2
e ax3 ’ a.xz

~ Since the firstand second term ofth:; ,above quatiqn can not have terms of the form x,x,, so the equation.
can never be satisfied.

' du, ou,
Thus for the given ¢, the equatlon g, = -;{ -é;—’— + 3:} donot yields solution for 4

1.28  Self »Assessmgnt Questions: . |
1. If the deformation of a body is defined by dis;‘)lacement éomponents =K (3)(, +X,)

= K(Xf +X;),uy = K(4X, +X )uhereK>O Computethe extensxonofalmeelememﬁmtpassgs |
o 111
through the point (1,1,1) in the direction (fj—g»‘fﬁ ’ﬁ) :
2. If the equations characterizing the deformation are given by x, =X, +Z.X,, %=X +M{3,-\ L
| = X; +AX,, determine ( E,,) and (e”) Hence show that (Ey) (ey) for small A,
2 ,‘.;,xg = kX, ‘«’*'QXI'?XQ. Find

3. _Adxsplacementﬁddlsngenbyx, X,‘PCX2+5X3,.?§2’=,§{Y!!!’X2 -

(’3/) af‘d '(77,,«)

28 ‘ Directorate of Distance Education
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5.
Uy =
6.

- 1.26

L0 ® N h AW
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Fcrmednsplacement field u, = (X, ~ X ) ,u2 —(X2 +X ) y4y = —X,X,. Compute the changemnght

angle between ' = L%ﬂe}. and M 5&.__‘%.2_1'1‘.’2, at thepomt (, 2 ~1).

+b,x2 +(:,Jc,,u2 = a,x, -4-b2x2 +c,x3,

Consider the displacemen; components U,
a,x, +byx, +¢,x,. Find infinitesimal straif tensor and finite strain tensor.
Find ( ,,) and (rzy) for defoxmauon X =a (X, +aX,),x, =aX,,x, =a,X,, where a,,a,,a, are

constants,

Further Suggested Readings
Continuum Mechanics : T.J. Chung, Prentxce-Hall
Schaum’s Outline of theory and problem of continuum mechamcs GedrgeR. Mase, McGraw-Hill.

Continuum Mechanics: A.J.M. Spencer, Longman.
: Mathematxcal Theory of Continuum Mechanics : RN. Chattegee, Narosa Pubixshmg House. -
'Foundation of Fluid Mechamcs S.W. Yuan, Prentice-Hall. St
Fluid Dynamics : J .K. Goyal, K.P. Gupta, Pragati Prakashan.
Textbobk of Fluid Dynamics : F.Chorlton, CBS Publishers and Distributors. -+ -
- Theory of Elasticity : Yu, Amenzade, Mir Publishers, Moscow. - '
 Applied Elasticity : C.T. Wang, McGraw-Hill
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Mechanics of Continuous Media

* 2.1Introduction :
This Module is the continuation of the Module No. 49. Here we discuss the analysns part of the Strain for

conunuous medm

2.2 Objectives :
Without stxmnanalys:s,mecomept of; suamwxllmtbeﬁdﬁlled.‘msmodule will learn the analysis techmque

‘, of strain analysxs

2.3 Keywords:
. Relative displacement, strain vector, rotation vector, strain quadri‘é,'principal strains, principal directions,
strain invariants, Isochoric deformation, compatibility equations, deformation gradient tensor, Jocobian of the

deformation.

i 2.4 Relative Displacement.: : u
. Letus consider the two neighbouring -
material points (X, X, X;) and
O (X, +ax, +dX’ + X, +dX,) inthe
undeformed state expenence a dlsplacement ‘
-(u,,uz.u,)and

i = (u, +duy,uy + duy,uy + du,')‘

respectlvely, i.e., B, movesto Pand Q, moves to

Q in the deformed state. Here PP= 0,0 =

and Q°Q~Au+du v — 3
| Q Q = di, is the relative displacement of
‘material pointat 0, wirt. materxal pomt at k. Hence for material method (Lagxanglan) of descnpnon, y, thust be

functlonsofX,,Xz,X3,

Directorate of Distance Education 31
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i.e.,‘
o F(Xl’XzaX ) ......... . (57)
and hence u, + du, will be similar functions of X +dX, X, +dXy, X, +dX.

.~ So, u,+du,=I«j(X,+dX‘,X +dX2,X,+dX,)

| oF, oF 'aF
__ , ; dX
=F(X, x,x)+(aX "ax, X, + o dX,)

[by Taylor’s series expansxon]

Since the pomts R, and Qo are very close together sodX, must be small and we can neglect the terms

contammg powcrs of dX, hxgherthan ﬁrst So,wehave
Ky + e,

u,+du, = F(X,, Xy, X, )+ Fa =
_
e+ 2 ax,
ax,
au -
du, = 9 L dX e (58) |
- ou 1w ou | 1[ou _ou
“_‘°W’ aX“ 2 o, ox |2 aX aX
-E +R Y say ........ reesersereniverseersroses (59)

ou Ou, | , o
where E, =%, a;’j +5}: =E,; symmefnq‘;small stram,tensotofordervz, and‘

l—au,. au," ' S X :
=-R,, skew-symmetric tensor of order 2.

Ry=x| et ==

2|ax, X, |

Now from (58) and (59) we get

du, = EdX + RdX ...t (60)
Again we form a vector R,. by setting
R =eyRy .. SOUURRURIRRIRRENION (1 §)

Directorate of Distance Education
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| euR, = eﬂ_* € lep = (5/p§lv - 5)«15@ ) R,

Hence, R, = %—e,/, R,',' whichis the inverse relation of (61).

. ' » 1
Ao, By, =‘5"w ) Using 62)

iy

(Rde) S (63)

Nl—-

. “Lhere R (R;,RzyRs) dX POQO =(dX"¢bY2’d/Y3) |
‘ o eufow o) i ow o]
Now, ”f" o "[ax‘ a,;] [ - ax’]
AR R ‘“au” o
2 ’/" aX ikj aX 2 e(/k aX +eljl an, )

Ou,
=€y aX -(rot u)

ncxghbourhood element of P, throughan angle R = —I‘Ol u The vector R is called small rotation vector and

R is called small rotation tensor.

2.5 Strain Vector: y : |
- Suppose a line element RQ,at 1{, onented in the du'ectlon (Nl ; N2 , ,) inthe undeformed stateof the

continuum body deforms into a line element PQatPinthe deformed state, then the stxam vectorat £ is defined
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If (X, X,,X,) and (X, +dX,, X, +dx,,x +dx,) be the co-ordmates of 1:, and Q, in the
 undeformed stte of the line element A0, of lengthal, then B =
;29X
=T
~ Again, from F) we have
PO-BQ, _T0-PQ

PN _. . o ) L s S
ol S dL (' RQ,=PQ and R)QollPQ’)

e i3 the deformatxon consxsts of strain defom\atxon only mvolvmg no m,ui hods deformanon, then relative
dxsplacementxsngen by - ' :
du, = E,dX, ..o (66)
where £, isthe small strain tensor at 5.
o EdX,

.'..E,w) : -—-;I—i'—-- E N ........... i67)

whtch gives the relation bétween strain vector and strain tensorat R,
Normal components ofstram vector E inthe direction (N,, N, N, ) isgivenby
. E™N,.  =ENN,=E, »
=E, when N, =1,N,=0=N,,
--E22 when N, =LLN, =0= N,,
—EnwhenN-lN =0= N
~ ‘Thisisthe reason extensional strain f:‘,_,, E,,, E,, are also called normal strain.
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26 Strain Quadrie: - L

Thestateofdefamaﬁonmmeneighbomhood of a
poiﬁt B in undeformed state of a connnuum body can be
understood more clearly by a geometrical treatment.

Let B (X, X,, X,) beapointmtheundefonned
state ofthe continuum body. The axes OX,,OX,,OX, S ¥
areﬁxedmspacc Let E, bethesmallst_ramtensqrat B 0

Wt thlssetofaxes - .

Now we introduce a Iocal system of axes ¥
oof,, og‘,,P{, with R as ongm and axesareparallel o —-
' OX,,OXZ,OX respectively. 'I'hcn, foragiven setof sn'mntensor E wecanconstmctaquadnc surface w:th its

>

;centre at P giveby '
ELs =1 (68)

Thxs quadnc surace is knovmasStrain Quadnc. -
_'Prop -1. The extension of a Iine element through the centre of a strain quadnc m the dzreuzon of any

central radius vector is equal to the inverse of the square of the radius vector
‘ Let, L = A,Q, and (N,, N, N,) be the direction cosines of R,Q,. Let (&, ,cf,,r,‘,)be the cofquinates_of
9 and Eyy be the extension of the line element PoQo in the directionof £,Q,. Then

AN T Y — (69)
Also, N =8 (70)
. _EgE 1
+E o=t = (using (68) -

.Ptop 2. The dtsplacemem of a material pamt at any point on the strain quadric relative to that at the
centre is directed anng the normal to the surface of the quadric at that point. ,

| _ Let u, bethe d:splaccment of the matenal pointat Q,, relat:ve tothatat P, due to strain deformanon only
' 7, = E ¢, (using (66))ues (1)

‘Directoraté of Distance Education 35



‘. ) . ~ . . y . 13 . . f H o '
Mgg!hgmg:;pﬁ(?gmmyausMedm.- ............... ssiaserersntsseressastrdasbstaaRiasssheros seritss e st db s sbennieseass

| smce 5, are relatlve co-ordmates of’ Qo wrth.

We censxder the quadnc ﬁmctxon
26(5:,5:,4’;) 77 F— (72)
. So, equatxon of strain quadric reduces to
26({,,5,,5,)-l...,....’ ........ )
ZG 0 (£ 0 a
Alsofrom(7l) % 2 ) 66,( "’"r"f’) Eu[ag’;é ag: 4‘.]

"E [511.;1‘*‘5/:5&] {Eu ugl‘*'E augt]
= iI§I+EIl§E 051 f/ o '

s eind ".:,__ ‘jgj+E fl o :
aG o
'..'_6-2= Uf ; =u{ ........... (74)

a6 .
But 3% 2, are dnrectnon ratios of the normal to the quadric surface (73) at the pomt Qo , which follows that
l

nelatxve dlsplacement is dxrected along the normal to the quadnc surface at Q0

27  PrincipalStrain:

When the direction ofa line element at a ngen point ofa contmuum remains unchanged by strain
deformation then that dzrectwn is called prmc;pal direction of strain or principal axis of strain and the
extension that occurs along the principal direction is called ‘Principal Strain’,

A If(X,,X,,X)and (X +dX,, X, +dX,, X, +dX;) betheco—ordmatesoftwone:ghbounngmatenal‘
pomts F, and @, suchthat RQ, = dL and oriented in the direction (N,,Nz,N,) then

i#é£J=LL3
daL’ -

8 (75)

and; NN,=1 ] | D |
Let E, be the strain tensor at I:, and in the deformed state £ and 'Qo movestothe points P(x,x,%)
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Mechanics of Continuous Media

and Q(x +dn, %, +dx,, %, +dx,) re'speétivély' Also |
: lﬁt uland u,+du areﬂxedisplacementsof? and Q,, '
If the line element £,0, isto be the prmcxpal
directionofstmmat 1{,, themtsduectxonwxllremam' |

mchangedduetostmndefonnatmn,l e. PQmustbe N
parallel to. KO, Hence, we must have the relative

displacement du, is proportional to dX,; ie. o

. - du eodX,,i 123 X'L
oon du, = EdX,,i=1,2, 3 g (76) '
: where Exstheconstant '
| wE= :;L d.xd;(d)( = exieﬁéioﬁofﬂ\ecomponent dx, petunftlength\andis“thwextchsion- |
‘:_-oftheelement l’.,Qo mthedxrectlonof}%Qo ﬂusEnscalledpnnclpalsu'ain. B |
Nowmestramvector, o | | S
s du, -du; dX, ”
n g dUy _au aX, EN
| E,‘ T (usmg(75),(76)) (77)
'Also. the stramvector is relatedtoshmntensor,le,
E =E,N, | BT
10T ED 0/ R N——— cve(78)
or, - ESN<EN, .
o, (B, ~E8)N;=0, =123 e (79)
- (B ~E)N, ’_"ElzNz"’E.,Ns =0 Do
‘ E,,N,'+(E,-,‘ E)N,+E'”N,-- +venes (80),

EyN, +E,N, "‘(En E)Ns \
wbxch isaset of three homogeneous equatnon inthrec unknowns N, N2 » Ny which together withthe

4
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o condmonNN N, +N’ «9—NJ =1 Thetnvalsolutxon N, =0, 1\12 =0, N, = 00f (80) is not compatible with the
' condxtton(?S)andshouldbechected ' S Y Ly ey B o
, ' ’4 ’lhecondmon forexxstancc of non-zero solutxonof (80) is that the detcmtmant of the co-cﬁictcnts of N,
' m(80)lsequaltozero,1e, et
Eu E Eu Eu“ :
E, E,-E E,
En.. ' Esz . Ess"

- Thisi is a cubxc cquatxon of E, the pnnclpal stram Thxs equatton is known as characteristic equation. The
: roots of this equauon are E,, E‘2 . 15'J and called principal strain, With each of these roots one can solve (80) using
i (75)to find the conespondmg prmclpal axis of strain, i.e., dlrcctlon cosines’ (N, , N2 »N; ) forthrce prmcxpal strains,

'l‘lleorem. All princzpal strains are real.
Proof To show the three roots E, , E,, Ejof the charactanstm equatlon (8 l) are real let us supposc that

‘_ one root say, E,is complex Then of course the complex conjugatc E’of E is also a root of cquatxon (8 l),
E y ts real Then from (78), we have
E, NO = ENO, i=l X TR ) B
and  E, NOSENO, =12 3(83) -
where N(') i= 1,2,3 repnesentthe direction cosines of the correspondmg pnncxpalaxxsand N0 =123,

its complex conjugate: , L
~+ Multiplying both sides of (82) and (83) by. N“" and N‘" respectlvely, then we get

E, N(') N‘(') E, N('l N'(') EZ! N(})’
' and,' ' E' N‘(‘) N(‘) = E| N’(‘)N(l) E Zl N(‘)l

" Now, E,NONO =E,,N,""N§" (mtemhangingdummy"éqﬁixeé) o
= E,N,""N{) (- E, is symetric) ”
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Then, (84) follows that :

 ENNP=ENONY
or, o EIZ‘N(‘)l =E'Z|le
_.o'r',", (E, E;)lemg S — (85)

,  Since N‘"N"" = ZlN‘"{ =sum of squares ofreal numbers 20 unlessall N“’ i=1,23 arezero,
henee,
C - E=E .

whnch nnplxesunagmarypan of E = 0 ie E, meal / ; ,

. Theorem Principal dzrections of strain corresponding to distinct princzpal strains are orthogonal to each

: other. S ,,
' -Proof To show that three pnncxpal dtrectxons are mutually perpendxcular let E, ) E’, , E, be three dxstmct roots of
the charactensuc equauon (81). Also these are prmcxpal strams and the dxrectxon cosines of the conespondmg i

prmcxpd axes are given by N,‘",N,‘”,N‘”(x =1,2,3). Nowwehave, from (78),
. ENP=EN", i=123 |
EN® =END, =123 p e (86)
. ENP=ENP, i=123 |
Multiplying ﬁrst and second equation of (86) by N and N U respectively, we get

E NO) N(Z) = E, N(l) N(Z) .
and E N(2)N(l) = Ez (2)N‘(l)
. Since, E, N"’N“’ N"’N"’,mterchangmgdwnmysufﬁxos
= EyN}”N}",Slncje E E,,, symmetnc

LENON® <ENPNY
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or | (E-E)N"NP =0 | ‘
Since the roots are dxstmct ie, E # 15’2 ) tberefore we must have

| NON® = Y/ RO (87)
whmh shows that N"’ and N"’ are orthogonal for E, # E, Thus two pnncxpal d:rectxons of strain
| correspondmg to two distinct principal. strams are orthogonal Similar results are obtamed for other set of pairof
roots. chce the pnncxpal directions of strain correspondmg to distinct principal strams are orthogonal to each
other. ' ' '

2.8 . . Strain Invariants : . , .
* The individual components of' strain tensor E; have geometncal meamng dependent on the choice of co-
h ordmate system, there are a number ofcombmatmns of E ‘which temam unaltered by a rotation of the co-ordinate

‘, system They are called stram invariants, , ,
" Tofind thei mvanants we consxder the charactenstnc cubic equatxon (8 l), for pnnclpal stmm E:

Eu E Elz - ..Eu; |
' _Eu ~ Ezz -E  Ey |=0
' EJI Esz Esa"

or, -E%+ E&, 6 =0, SYyerese (88)
- where the coefficientsare o
6= E,, + By +Egy evnnnnns (89.a)

6, : EuEzz"'EzzEsa"'EssEu En Ez Elzl
o z', 1 ul_‘_lEzz

E,, E.nl l
6, = E; E,,+E§,E2,+E,2,E,, EnE EJJ"ZEuEz:En ‘
E, Exz E, ,
_}= E, E, E, (8'9.c)' :

oooooooo

E, E, E,
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Smce E, E, , E3 arethe roots of the equatxen (88), they by relation between rootsand cc-efﬁmems ofthe -
_ equation 0,,0,,0, are sumof the product ofmotstaken one, twoand!hmgt atime given by |
0= &+&+&~ ' o '
6, = E.E, +E,E;+E,E,
9=E,E1E3 ' gl ¥ ,
Smce the principal strains E,E, E, ata point  have a geometxieal meaning independent of the choice of
co-ordinat‘e system, it is clear that from (90) that 6,,6,,6, given by (89.a), (89.b), (89.c) are-invariant w.r.t,
orthogonal transformation of co-crdmates andare respectively galled ﬁtst, second and third strain invariants.
- Obsrvation ; The first strain invanant O=E,+Ey+Ey= u, J x%pxesents the change in volume per unit

. ongmal volume;| i.e., cubical dilatation or volumetric strain.
 Isochoric Defomaﬁon : Iscchonc deformatxon isong in which volume clement remains unaltered. So,

| inn-‘s‘b'V(QO)‘”.

for xsochonc defomanon,
E” +Ez; '*‘E;; = 0

- Note-1, The extremum values of normal strain or extensional strain gt apoint of contmuum are prmclpal
~ Note-2. The maximum shearing strain at any p@ixit of the continm;m is aqua! té the oéie—halfthe differenée _,
.- between algebraically the largest and smallest principal strains at that point and that the correspondmg direction
‘bisectsthe angle between the largest and smallest pnmipal dimtions |

29 t:om;saﬁbmty Equatibns for libéar sirain
The strain components E, are given by

1[ ou,_ ou |
Eywi[axl +8X']E'—[HIJ +yj,l] .

oy
Whemul,/ aX

o It is clear that E, is funcﬁcns ofsoegxdmateg and three unkmwn u, = 1, 2,3 tg b@ determmed from
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(91). Sime £, is symmet;’i@, 80 we havea syst@mgf six hnea,rpmml differential equaﬁgns ©on)! to determine three
unknows, Here we have three more equaﬁﬁmmgn unknowns, For this reason, these equations mayn@t. in geneml ,
have smgle«va)ued solutions u, foran arbitrary choicé of strain components and to ensure the existence of single-
valued displacement solutions there must necessarily be subjected to additional restrictions or conditions; Wwhich
' imphe,s that strain components must be compatible, These additional partial differential equationsto be satisfied by
train components. £, alone which will ensure the existence of a set gfgmglexvalusd displacements u, are called
uations of compatibnlxty"for stram components.
Egr this purpose, wetryto el;mmate U, fmm (91 )

N@Wt
, ’E, 1
E ,____!L__ Qf #K 2e9enesenyoe (gg
M‘ @X@X g[ " M!] )
NE,, = g = [u, i ,,,] S (9,3)
' From (92) and (93), we have. -

Byt Euy ""[“uuwlu;l “‘m*“l&l] e (94)
Interchangmg, Jand k in (94), we get
E,,J, + E,,” = -2-[14,‘”, FUy U *yl'j/gjszsséssé: (95)

Now, since : ‘o
Ui = ity = Y8y S Urawitpy =Wpy
therefore from (94) and (95), by substraction, we get

4( ] + Eé’ - Eu: 54 /I i = [ R (9@
* Thisiscomptibality equaion for sl compenents and s nesesgay sonditon fo the isenceofsingle-

valued dnsplacement These are Sauit Venant’s cqmpgub;lgty relations fm strain compenent,
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Equatxon (96) xsasystem of 34 =81 equations. Bquatxons of which only six are algebraically independent
_(nooneofthem can bederived alyebraically trom cmamqugkm)bemum @&gym m etry in JyJand k, [ These six

@ompaﬂbmtyequamnsm
Q=0 :
where QH”(Eazas*Eam) ZEms A
sz (Esan"'Eu.as)’”zEM.sl ‘ |

O =(Evar + Enp )= 2B
On =0 = Eyvgy = (=B + Bya + By )
qu%Qu Epy~ (zu“‘Em"'Eu.s)vz

0n =0y = £y i’ (Egsn + By - ~E)s U .
Whe.n thess conditions are sgﬁaﬁed by stmln egmp@tmtg E,, ‘then six;gle-valugd displacement sgluti

h 9f(91)exxst

L

Note 1: In two dimensions, there exists only one compaﬁblhty equation
Q=018 Byt Eyy=2E0n !
- Note2, Another set @fequati@ns which are @guavglem 10(97) but more useful, is gmn by mtmgl Icm (96)
o BBy =By =Eaa =0
Tlus set ofequaﬁgns contains only 9 gquatipns ofwhish only 6are independent because ofsymmeﬁy in iJ '

Note 3. Thrée completely independent compatibality eqmgm for strain gﬁmppnentsaxengenby : :

D=0y = 9 and Q) = @ ‘
o, Eypn= (“Em +Ey, *Em)zm

Epaip = (B, = By + Egs)om

o E;;,;m5(%&1*%9@*@3@)%
These are fourth order.
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2. 10 Detomgtian Gmdiem'l‘emn
~* * InLagrar vgxandescﬂptxonmethgdwehévgﬁﬁm (l),
| - =*@""‘l(Xn)"z"’(:i) i=1,23

-!-—L el I3 vt
90¢| = aX' df\,, ‘O‘ X, dXz + aa,’ 44‘(3 E!'J dxlyj55133§
6;;', ax,
@ éX; dX; aXz dX!g éX; dxj. @X dfgl;jgltzt

% ax,,j=1 2,3 |

X,

Cb«' = d)( +._..Ldy + -3, d}{

wlughgivegdx 234\’ ax,i= 1.2:3

ox, ox, ox,
[x ']___. ox, ox O

A lex, ax, oXx,
& &% om |

T [x, ,] isa 3x3 non-zero matnx nelated to (X,, X, 24X, ) systsm af cgsgrdmatas,md by qmtient law,
ized as tm gradient of a vetor x, the -
gradient bemg takenwurt. X, called the defqmnom gradxgm tensor in the material form,

Note: Jacobian of the deformatnon is

it follqws that X, , are componcnts ofa non-zem tensor This tensor is recogr

axl axl axl
ox, oX, ax,

&, o&x, &
.l.l|=c.iet[x,‘j]=-a-:¥-zl- &.z. é"xl,'
& & &c; |
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A imhisumtwehavedxseussedmmxﬂytheamiysispmofmeSﬁmnforoonnnwusmedmdepmdmgrelauve-
displacement, sﬁimvector, rotatxon vector, stmin anadric etc. ' :

| ’2.12' Worked Out Examples

. 3 1. -2 Determine the princlpal strains and
2276

Ei-h Ata point }he strain tensor is glven by__(E )

principal directlons of strain. Find also maxlmum value of normal strain and shearing strain
Am Pnncnpalsumnsamxe ngen system:sgwenby : A
h-E 3 2|
13 1-E =2|=0
-2 -2 6-E
o (E-8)(E+2)(E-2)=0
 LE=8-22 |
Hence principal strains are 8,-2, 2.
, LetE, 8E,=-2E =2. .
;Nowthepnncxpa! dxrectxons arengeby
(1-E)N,+3N,-2N; =0
3N, +(1=E)N, - 2N, =0
-2N,-2N, +(6-E)N; =0
Let (N,‘",N;",N;")bethepnncxpal duecnonoorrespondmgtopnncxpalsnmn E =8. Thenwehave
~IN® +3N5" -2N{" =0 ' '
3N(l) 7N(i) 2N(1) =0
~2N“’ 2N“’ 2N"’ —o

1

whnch vos.N‘"=- N“’a— )=
R T T 6
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Smlaﬂy forthe °merp"“°‘palmi“s E,=-2,E =2 Wesetﬁlepnnclpal dxrecuons, respecuvelys
N(Z)

2’ vz’

N(J_) = l N(’) - l N(” = l ) )

BT RY TR

Maxnnum normal strain= maxxmum principal strain -8

- N(2) ‘N(l) __0

Maxunwnsheanngshmn-—[maxxmmnsnam mmxmumsuam]-—[S —2)] 5.

. Ex.2 The strain tensor at a point is given by (E, )= h =a 0} Find the principal axes of strain and
. . v
- o : 0 0 o0

corresponding direction ratios of principal strains.

An‘s, The principal strains are the roots of the equation

a-fE b 0
b . -a-E 0]|=0
0 0 -E

o, E[E’ (a +b’)] 0
o E=g, j;s/a_:bT o
' Hénce the principal strains are E =0,E, = Jat b JEy = —m .
" The brincipal directions are given by ’ |
(a-E)N, +bN, =0
BN, ~(a+E)N, =0
~EN; =0.
Let (N,‘”,N,{”,N “’) be the direction ratios of the principal axis correspondmg to E 0 Then we have
aN® +bN = 0 |
BNO —aN® =0 »

46 ' o Directorate ofDistancé«Educaiion



¥y vasecnesnendihssertiorsisaiirisiiicrtorcnnves P I IAR AL R AL :unu'o ooooo tessine
and 0-N"=0 |
o o M_n NO = Doy
which gives | =0,N{" =0, N{" =1.

For £, =a™+5", le (N!(I)’N?)’N?)) bethe direction ratios of the principal axis.
( \/a +b1)N(2)+bNIZ) 0 ‘
o e o

* Whichgives N =

),
b._, N =

—Jat+b?, weget

-

Sinﬁlarly'for— E,

NO = af*/'lz+b N‘” le_

L,N® =0,

Ex.-3. The displacemem in an eIastic solid.zs given by u = a(X, +2X, +3X,) u, -a(—2X, +X,)

a(X +4X,+2X. ) where a is small quantity. Find dilatation, roation vector, shear, prmc:pal strain

and correspondmg prmczpal axes.

Ans, 'Ihcstramtenscns )

- E, E, E; | l;au au' '
' (E) EZ' En E23 where E =E[.é}!-+§)
By E32 E, y X
F | W
ow M ow Gu).lfou  Ou|
oxX, - 218X, dX, 209X, @ '
132\, T ax, ) o, 2y, X
2lax, ax,) 2 ax, ox; aX,
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ou  ou,  u
: deongEu"‘Ezz"’Ep ’aX: +'6X22 +6XZ =a+a+2q=4a_.

Q s
D A

_ 'Rotation'yectdr =R=roti= : -
v ’ aX,i aX: aXJ

| ' aX ax aX aX
i=1(4a-())+j(3a—-a)+k(—2,q—2a)
, =4af-§-20]'-—4a/é.
Shear about X, axis by anangle 2E,, = 4a,
- about X, axis by an angle 2E=4a.
Pnncxpalstmmsaremerootsofmeequauon _

|la=E 0 2a
2a 2a " 2a-E
on . (E-a)(E*-3aE-6a%)=0
#E=a2 (31:J" ).
Direction ratios of the pnncxpal axes are gnven by
(a-E)N, +2aN, 0
(a—E)N, +2aN, -0'
© 2aN, +2aN, +(2a-E)N,
Hence the direction ratios of the pnncnpal axes correspondmg to the prmclpal strains E, aa,,“

"'(3+~f— ) E,--(3 -5 )are(t.-l o). (nT,._J[”_




 Mechanics of Continuous Media

Ek,74 : Eor the defofmation’deﬁned by équatiom xf =X, +X; X = X, -2 X‘” %=X, + X, "'X.r‘ Fiud '.
 the deformation gradients and Jacobian. PR S L. B
Ans. Deformation gxadientis'givenby

()| 2 & Bl o)

" Tofind (X, ), wesolvethe giyen set ofequatlons We get, by Crammer'smle,

1 -1 -

Xzél x, 0 '*‘J=';‘(xl':x2)’ e rernail |

L1 wodte L 4
Xy=l -2 x +J=-§(3x,,-3x,)'-’-’§t,f;¥;}

.'.defonnaﬁongxadientihthespaﬁalfonnis
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| & ox,  ox 13 3
= . == -
(%)= % o on | |3 73
aX;; aX; a".’s | 1 0 -IJ B
\ O ax,ax,J\

. Ex-5 For the dejbrmation defined by the equation X = %(x, +x,) X, =tan” ( )

( X, ,,) (x, ,) Show that the defarmanon is an isochoric dqformation.

Ans. The deformation gradient tensor, in the spatial form, is ( X, ,) and given by

(ax, ax, ax,) ,

| % ox ox ) 0
lax, ax, ax, | »
) o = | °f
ax, ax, ax, 1)

. ,\a"l.,' ox, IaxJJ v

Also from given et of equations we have -

x =2X, cos X, x, =,/2X sm)(,,x3 X,
defonnatxon gradient tensor in material form is ‘

fax. ox_ &l\

ox, ox, ax,

' '(-": )= o, o ox
Yrax, ax, ax,

o, o OO

\oX, aX, oax,)

50

cos X.

( -,/ZX sz

;721\’; S
=| sink 2X, cosX 0 .' 
1 V2%,

X -eO'x,-x, Find
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Jcos X, - F~2X,'sin,;X,_ 0

N L e
NOW;J?lx,,)]- -s\—l/-né\,é \/ZX, cosX2 0=cosf/g{3+3in?/:\’,=l. o

o

Smce, J=1,s0the deformatxon is 1sochonc defonnauon.
Ex-6 Show that the foIlowmg are not possible strains components ;
E =e, =k(x} +13), By = ey = k(%] +x3), En —e,2 =k xlx,x,, =
R Ey=e,=0,Ey=e;,=0,Ey=6,=0, where kand ¥ are constants.
Ans The gwen numbers E = ¢, ‘are possible strain components only if each of six compaubxhty condmonsm
sausﬁed. Subsntutmgthe gwen ¢, intothe condmon o
| Eue+ En = 260, _ bt s s B
we have R
|  2%k=2kx ; ‘
Smce kand K are constants, so the above condmon can not be satlsﬁed for x, # 0. Forx;=0, above
equanon gives =0 and thenall E, =0. Henoe, the glven E are not possxble strain oomponenm N
Ex.-7. Ife, =k (x, xz) ep=k (x,x,) ey =k x,x,,e,, =ey =€y =0, where k. k’ are consiants. Find th

correspondmg d:splacemem given that uy =0.

‘Ans. Fromgivensetof relations we have |

enn = -2k ezzn =0, "k

and emz +enn “2312 12 lssatlsﬁedlﬁ'

k= -k’
=> that e, are possible stram components only when k = ..k’ o

Toﬁnd u,u, wehnve »
€=Uy, = k(x, - ()|
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:

al’ld _'ezz = uz.) = kx,x, ....-; ...... . (i'i)
€, = 2 (“: ¥, n) = k2,2 = kX X, ivon (iif)
| | ‘
s ="2"(“l 3y, ) = (eveorens @iv)
e =-1-(u23 +Uty 7)) =0 (V)
” ey =l = 0......... (vi) :
. But ngen that u, =0, Thenefore from(’v)and(v)weget
Ou, Ou au I "
- B I 0 i €., =O
A e

‘and g *_a;;_;o ie. gu_l_,ok

, . : s
- which implies that ¥ and u, are independent of x,.

From (i), B =k(x-5)
lmeglatmg, Uy .k[j -x,x,]-f-f(x,) ........ (Vli)‘ E

Fom@), 2=k,

itogrng, o £ +8(R) (vii
Using (vil)and (v in i), weget

| 8'(x)=gkd =1 (%)
This oondition is possible only if

g/ (n)=cighd -1 (5)=c.
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| ‘Then we get o |
o g(w)=ente
wd f(m)ekneenen
s, w=k(2d-6xdes)-ene
! a%kx,.i,"-&-cx,é»c,."

thch are the displacement components assocxated thh the given e, ‘when the companbxhty conditions
areobeyed : ‘
Ex.-8. .
i)l. Fx'nd the compaﬂbility condmon Jor the strain tensor ( e) {f e,,.e,,,e, , are mdepedem of x, and
. e,,=¢3,ae,,-0 » | ' o
i) . Find the strain tensor, rotation tensor for the small deformation i = ax, % (6 +é )+ 2a(x, + ) x,e,
,- | ';wherealsaconstam \ EE i T
,Ans. i) ince €1180,6 ATE mdcpdent of x, and ¢, = e,, =gy = 0 we can findon verxﬁcation of six
compaubxhty oonditionsthattheon!y one oondmontobesatxsﬁedxs ‘
L Gty =2e5. ‘ S
: "_ﬁ) ~ From given displaoement vectorwehave its components ’

Y, = XXy, Uy =axx, and u, = 2a(x, +X,)%,

¢ g N
&l ! 2 &z &. 2 &’ .&' ) ,J«anz - -i-(ax‘-‘-axz) ‘ axs
vt 10w, du ou,  1{ou, ou 1, .
(e”)gi('éx‘&*ﬁ) '3,":' ‘5('&?""&") = 5(“":*“":) | ax, ax,
| ' ' ax. ax C2a(x +x.
1 0w O 1o o oy \ 3 3 at(x, +%,)
AT 2\ ox, Oxy ) o, ) y

'Di‘igefcitbfdte afDlstance_Educdtibn ' T g3
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e : 1 | )
10 v-i-,(ax,-ax,)-»-ax;

o R )=|-=(ax -ax 0 - Xy | Bor| el el |,
. ‘and ( u) 2( |~ ax;) ‘ o s _‘whergkqaz(\axj ax’)
@xy caxy 0

=a 1—2-‘(x,-x;) 0 -x

\ ‘ » /

VFEX'9 vaen E“ -—5+X2+X2 +X' +X2, 522=6+3(X2+X3)+X; “"Xg, E,-O

‘ dxstnbutxon is possxble, determxne the dxsplacement components in terms of assummg that the dxsplacament and '
k mtaue;:attheongmarezero B R

~ For E,,-O sowehave g‘%—-—ozt'u, F(X,.X,).; ..... 351 I
3 o

2 )

ax, ax, ax,

a
=-x, %
Y ox,
4

B onom (O, 00 . au" ow . oK
s é-owi(a\%fgf\%)zog3.);:{%6;?: ax (usms(t))

F(X'.x,). i)

- OF;
=-x, aX’+F(X,.X,).. ...... (iu)

. Ouy . Ouy o
Fa ® 2[6«‘('2 ,axtv)f5+_2x.x,(x3+x;+‘2), :
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OB O, PR OB) s o)
XXX + X, +2
2( X’ aX;aX aX: X3 aX,aX; +_a¢¥ 5+ ‘ 2( l+ 2+ )

S 2 » ‘
- 2K o, ‘+(3FL+6F=) 1o+4xx,(x, +x,+z)

axox, "\ax, ox,
_ Bquatmg both sides with coefficient of X, then we get

""az'—('pj—"iﬂo LYYTLLYL T (lV)

000000000000

y 2" 1
B, ,g.u.s;x,u'x:;xmx;*
| .

&F, , oF, |
."X’"a'i"'**'*?ix'l,' 5+(x. +X3)+ (x‘+x‘)(usmg(u))

. Equating both sides with coeﬁicxent of X 3» then we get

and %"'*Si'(&f;*Xz‘)i»()(;‘%x:);..\...}.. (vif)
ng%;&ﬂ(z\’.’ +X3)%(X + x}) '1

or, ”X’&“f'+% 5+3(x, +x,) (x, +x,)

Equatmg both sides with coeﬁ‘iclent of X. 3 then we get®

.‘?;fl = O seesssenes (Vi)
ax;

" and -—g—-;lwéﬂ(«\’. +X7)+ (,X.‘%X,‘).....V;..(;ix)y |
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Now, from (iv), (vii) end (viii) it is clear that F; isalineas function of X, and X, ie.
F= as+sz +C3X .......... (x) - v
From (vii), by integrating, |
F=5X, *'?""Xlxz """'L""XXz +f(xz) i )
Similar lyﬁom(xx), o
F,=6X,+3X2X, + X+ X'X, +-’§1-.+ S0 s (i)
Usmg (xi) and (xii) into (v) weget -

24,)( +4X, X} + g +6XX,+4X,3X2 ;’; =10+4X, +4X,X;) +8X, X, +4X°X,
o o ' .
:)"'—"‘a'X‘Z +aXl —10."..noufo:{u;;o:cff oooooo uuuulooonctttcooio'(m!!) R

=>'6f2 =10- af'
. 0X, X,

which implies that each expression isaconstant,and

Y R T
letv_ B, Tl (xiv)
ﬂm 2 = 10"’ C ........ ersreesscoteseesseresenane doseseeverre PITSPRI
ax, - (V)
From (xiv), (xv)on integrating, weget -
- fi=aq+CX, . S o
and ./; =a, +(10”Q)X‘ ‘ ....’ ........... (XVI') Gy
, Using(x_vi) in (xi) and (xii),we get
\X3 2 Xl"‘ 4 ' B
! co » y o ,
F=6X,+3X2X, +X; + XX, +-5-’-+(10—C.)X. +a, f ....... (xvii)
apd - F=a,+bX,+CX, | J
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Using wvi) into (i_),cii)_and (iﬁ),we'get:

=-bX, +6X,+3X’X +X, +X,‘X +

-CX +b,X +ay-

PTEEIOEE0INIOIREINININOEVICOO0PINOODIED

Mechanics of Continuous Media

XS
-&»—s-l-+)(){'2 +CX,+a,, ‘.
-’fl-+ao -CoX;+an (il
e

| vaenthatdxsplaoementxszeroatongm.Sc mmally '

X, =0,X;= 0, X, -Ou,=0u,
Wluchnnph&sﬁom(xvm), _
. =0,a, =0,a, =
'_Also,uutxally rot =0 atongm.ie ,

a K
- joX,  oX, BX,
”n ‘ »“zv , “3

() 0000000 9sa0ece. 608060

=0,u,=0. "

(xxx)

=0 when: Xl 0.X,=0,X,=0.

':l_xe Zb,i 2c,j+[(1o c,)+6xgx +4x,’x 2)()(,-«-a4)(,xa C]k 0

_ when X,

0., = ox, =0,

e whenX, 0,X, = 0)(3 Ogthenb, OC3 010 -2C, = Oxe Cl S.

. 3 . §
Hence, u, 5X,~-)-§-+XX, X

+—-5-L+XX,+5X,,

uy = 6X, +3XX, + X2 + X,‘X,-’+—')§l+5X,, ‘

=0
2.13 * Self Assessment Questions :
B (X, 0 0 -
L Given the strain ficld (E,,)= 0 kX, O Whatslmuldbetherelatxon between k and k,

Directorate of Distance Education
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~ such that there will be no volume change.

- | L 5 5 -1 -1}
2. ’Calclilz_i_tcthc strain invariants from strain tensor (E,j)= =1 4 0 [ Determine the principal strains.
: T - {1 0 4

. Obtam strain i mvanants from them Show the equxvalence of stram invariants,
‘ Lo : o (e e e
3. Determine the principal directions and principals&ain‘sfor (Ey):' e e e ;
' : e e e
4 Fordeformatlon = AX, + BX, (X7 + X2) ',y = X, + BX, (X7 +X2)", uy =CX, where 4, 5,
_ Care constants. Fmd (E ) ( )Also find the principal values and pﬁncipal ax&ébf E,, |
5. ~The dxsplacement in an elastic solid is given by y =X, +2X +3X;, uy=-2X,+5X,,
=X, +4X,-3X,. Find dxlatation, rotation vector, shear, pnncxpal stramand correspondmgpnncxpal_
: axes. A
6.  Theswain con ponen mmgmﬂ by E, = Ep = E, _aF(X,,X,,X) E,=E,=E, =0,wherea
Y is a constant. bhow that in order tobecompauble qustbealmearﬁmctxonof (X,,XZ,X )
1. ’Underwhat condxtlons the following isa possxblesystem of strain S
E, —a+b(X, +X’)+X“+X,‘, . —a+ﬂ(X’+Xz)+X‘+X;, |
| E,,_A+BXX,(X’+X2+C) E,,-o E,, ‘
8. ‘«S'howthat E, -k(X’+X,) 15zz kX,,E,, chX,,.E,,sEz,»E3l .-Oxsapossxblestateofstram
wlule E, = kX, (X’+X ) Ex = KX} Xy, E,, =KX, X, X,,Eyy = Eyy = By =0 isnotapossxbleone
9. ~ Forthe small deformation deﬁned by the equations

=X, +aX;,x, = = X, 2 JXy = X -akX,, where isa small non zero constant Fmd dnlatauon
Find the condmon under which the deformation is isochoric,
10. Fxnd the constants aand ﬁ such that the small defozmanon defined by U = ax, + 3);2 , u2 =x- ,Bx,,

y = 3x; isisochoric.
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Mechanic&.of Continuous Media

Fmdthenatweofthefunctxonfsuchthat e,,l—af(xz,x,) ey =€y = ﬂf(xz,x,) €, =€y =6, =0,

where zand § are constants, isa possible system of strain.

If e, and e,, are the only non-zero stramcomponents and ¢, and e,, are mdependent of x,; show that

: the compatlbxhty condmons may be reduced to the followmg single conditions:

els 2™ eza =Constant

If ?eu =€3; =, =0,¢;, ==L and ey =§£ where @ is a function of x; and x.; show that ¢

| | o, ox
must satisfy the equation Vg = constant, .-

. : - (4 1 4
For a certain small deformation, the displacement gradient at a point is given by (u,' /)= -1 -4 0}

0

Find the strain components, the strain invariants, the principal strains and principel direction of strain.

Finrtbei‘Suggested Readings :
~ Continuum Mechanics : T.J. Chung, Prentice-Hall. 4
| 'Schaum s Outline of theory and problem of Continuum Mechamcs Gedrge R Mase, McGraw—Hill
~ Continuum Mechamcs A.J.M. Spencer, Longman.

Mathematical Theory of Continuum Mechanics: R.N. Chattexjee, Narosa Pubhshmg House
Foundation of Fluid Mechanics : S.W. Yuan, Prentice Hall. B o

‘Fluid Dynamics: J.K. Goyal, K.P. Gupta, Pragati Prakashan i
; Textbook of Fluid Dynamics: F. Chorlton, CBS Publishers: and sttnbutors

“Theory of Elasticity : Yu, Amenzade, Mir Publishers, Moscow. -
- Applied Elasticity ; C.T. Wang, McGraw-Hill.
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3.1 Introducﬁon'
The deformauon whxch have discussed- carlxer is generally caused by external forces that nge rise to interactions

between neighbouring portions in the intérior parts of a continuum. Such interactions are studied through the
concept of stress, This portion deals with the theory of stress. -

3.2 Objectives: |
Most important part in continuum mechanics is stress. Here we explairthow the stress acts on the material.

The students will learn the technique and method for stress.

33 Key Words - e v
Stress, body force, surface force, Cauchy s stress principle, stress vector, stress tensor, equation of continuity,

equation of motxon, stress quadnc, stress transformation, pnncxpal stress, pnncnpal dlrectlons, stress invariants.

3. 4 ‘Body Forces and Surface Forces: . ,
I contmuum mechanics, two dnstmct types of forces are considered: (i) infernal forces, and (ii) external -

forces : :
Intemal are boundmg forces of mteracnon between constituent particles belongmg to the body to ensure- the_
, exxstence ofthe strength while external are forces exerted by any agent cxtemal to the body. Intemal forces act
- even when no external forces are apphed to the body. ‘ .
- The external forccs that cause the continuum body to be deformed are ; (z) volume or: body forces and (x i)
surface Jorces. . ' 4
Surface forces are short-range forces and arise from the action of one body on another through a contact
surface when two bodies are in direct contact. Surface forces also arise from the action of one part of the body on
an adjacent part across a common boundary surface. It act only on the surface element and is thus proportional to
.the area of the surface element. Surface forces are speclﬁcd as force per unit area. ' '
Body (volumc or mass) forces are long-range forces that arise from the action of one hody on another when
they are ata distance from each other. They are capable of penetrating into the deep interior of a body and act
equally onall the matter within an element of volume and are proportiona! to the mass contained in the volume

element, They are specnfied as force per unit mass.
Examplw @ Gravntatxonal force and magnetic forces are examples of body forces, (u) hydrostatzc pressure of
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liquid, pressures of one solid.body on another due to contact,' ’
3 5 Stress Vector' ’ 15

*The concept of stress arises from the consxderatxon of the mtemal fonces which the patncles ofone part of the
- ‘deformed body exerts onthe pamcles ofthe adjacent part through the separatxng boundary surface in the form of
- restoring forces. - : Co
. Letus consnder a deformed body every part of whlch isheldin
’ equlhbnum underthe action of external forces. Consider the body of surface
~ area$ wtnch is dxvnded into two parts I and I within the body Nowpart]
willbein ethbnum under the action of remaining external forces acting on

this part of the body and the intérnal bounding forces of interaction
transmitted by the particles of the material in part I outside S on the particles -
of the material in part I inside S across the surface S. These internal forces

acting at the points of S are now converted into external surface forces |

réléti’\‘/e’to partL. Let P (x, Xy Xy ) beanypointonSand S beanelement

of arbltrary size and shape surrounding point P with outward unit normal 7
_ at P dxrected fx‘om part] to paxt IL Now the surface forces dxstrtbnted ovez the surface element 55 of S can be

: reduced intoa smgle restoring force 5 F‘"’ acting atP along a deﬁmte dn'eetxon together wtth a couple 5 G"” As

()
JS -0 then the ratno ;S -» a definite limit T( (= ,xz,x,) ,a force’fpe;/nmt area at P, called stress vector
. '*in)
while: —3,-5- —»a limit M"’) called couple stress vector ie.,
SF) =(n)
J\-{o 35S T
66" 2]
and JSL»O oS M

For most materials, this couple stress vector, M(") o and these type of continuum bodles are called

nonpolar . |
" Now we shall conﬁne ourselves to this type of material. Obvxously the sterss vector (") depends on the,

 positional co-ordmates (%, %,.%,) and onthe onentatlon of the partxcularsurface element 5§ through P whose
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exterior unit normal is . For some differently oriented surface element passing through the same point , having
dxﬁ‘erent unit normal, the stress vector at Pwill,in general be different. Thus stress vector 7 (%%, %, ) isthe
extemal surface force per urut area actmg at a pomt ( X%, %, ) onthe surface element with normal 7 representing
,the actlon of matenal outsxde the surface element on the material msxde the surface element.
 Itis unpcrtant toremember that in general T("’ is not dnected along the dxerctxon of nonnal n. Stxess vector
_ T‘"’ can be resolved into two components '

i) the normal comporient directed along the normal 7, called ‘normal stress’ and denoted by N ) -and
i)  thetangential component directed along the tangent to the surface ’element, called ‘tangential stress’

and tienoted by S(")

The tangential stress is sometirties called shearing stress. The normal stress N™ is positive if its sense
“coincides with the sense of outward normal to the surface element atagivenpoint.

CIf T represents the action of the part Il on part | transmitted through a surface element with normal 7 at

.:the ngen point (x,,xz,x,) and the stress vector 7. represents the reactxon of ‘part I on part I transmitted
B through the same surface element at (Jcl »%ps x,) then by Newton’s law of actxon and react:on '

T( " (x,,xz,x,)—.,-T (x,,x,,x,)

i.e., the stress vector actmg on the opposxte sxdes of the same surface element ata ngen pomt are equal in

. magmtude but opposxte in sxgn.

3.6 Components of Stress Vector.

Smce mﬁmte number of planes can be drawnthmugh P,wegetan infinite number of stress vector acting at P.
Therefore to completely specify the stress at a point, we have to know all the stress vectors across all the plane
elements through the point. But it is not necessary to specify each stress vector correspondmg to every plane, itis
 sufficient to kniow the three stress vectors, actmg onany three'mutually perpendicular planes through the given

point of the medium. ' A
Theorem, The stress vector ata point on any arbitrary plane surface is a linear function of three stress

‘vectors acting on any three mutually perpendicular planes through that pamt
Proof. LetP (x, +X,%;) be a point of the deformed continuum l?ody. Let us consider a small tetrahedron

P44, ,imegineti to be isolated from the medium, having one vertex at P with three orthogonal faces
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PA,A,,PA, A,,I’A,A2 ‘ parallel to the co-ordinate j)lanes and an
arbitrary oblique planc 44,4, with unit normal 7 at a small
distance 4 from P. Consider the motion of the specific portion of

~ the continuum which occupies the tetrahedron attime t Letpbe |

faces PA ,4;, PAA,, PAA,, AAA, respectxvely If

. (n,,n2 n,) be the components of 7 and 6V the volume of the |
' “tetrahedron, then we have ‘ | o |
o oS, = area of PA 4, parallel to xIJcJ plane ,
‘—pI'OjeCtlon of 5S onthe plane parallel to.x,x, plane |
=ndS
Snmlarly, JS, * 1,08,68; =ndS.
oS, = n,5S and 5V--3- ‘h: 6’S R ¢ ) |

Now, the mouon of the tetrahedron is govemed by the body forces and the stress vector across the four
: boundaxy planes dueto the matenal outside of it. Let 7" 7} , T2 ) T be the average stress vector across the faces
- A.A,A3 PAzA,,PA A,, PAA, respecnvely and the stress vectors actmg across the plane faces PAZA,. PA,A,,
‘ PA,A2 by the material outside of the tetrahedron will be -7; , --T2 , -T respectively because the exterior normals to
~ these planes are directed oppositely to the positive dierctions of the axes. If F denote the body force per unit mass
acting on insideand 7 the acceleration of the material within tetrahedron per unit mass, then Cauchy’s law of
motion for the tetrahedron of the continuum is R '
| S - T8, ~T,68, - T,0S, +F pdV = psVf
or, W8S -T58,~T,68, ~T,58, + ﬁp%h&S =p ]-;-‘ha"s
o, 7055 -TindS-TimdS-TinsS+ %hp(ﬁ” ~7)85 =0 fusing (1)
- Dividing both sides by &S and passing to the limitas s —» 0 while keegnng the direction = (n’@ ey »@3}

ennsﬁan&, then we have
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7O~ fim ~ Ty =Ty =0
oo, T aFn T L ER—— @ ;
: Thus, the stress vector at a point across the plane with normal 7 isa linear combinatin of the stress vectors
vyaotmg onthethreeorthogonal planes throughthatpoxnt. - =

3.7 Stress 'l‘ensor' ' ' ,
| Let us consider the plane PA,A, normal to x, axis of the sma!l tetmhedron PA,A,A, Thxs plane cuts the

medium into two portxons one sideof’ the plane towards which posmve direction of x, axis points is called posmve
. side; other sideis called negattve side of the plane. Let 7 be the stress vector at P exerted across the plane P4, 4,
by the material onthe pcsmve side of thts plane on the material on thé negatnve side of the plane. Now T, canbe
.~ resolvedinto two ccmponenw normal stiess and shearing stmess The nonnal stress component of T, whichis
dtrected along the posmve dierction of % axxs is denoted by T;. Sumlarly the shearing stress which actsinthe
plane )"A,A3 can furtherbe resolved intotwo components. along the positive of x, and x; axes and are denoted :
; by T;,,T;, reSpectwely 'I‘hus, the stress vector T, has three stress’ components T,,,I;,,I; 3 parallel to the co-
-_ ordmate axes. If e,,e,,e, bethe umtvectors alOng the co-ordxnate axcs, then - ' :

‘. . 7;8 I;le' +T;282+7;33327;’e‘ PRYOmS (3 l) ‘

Sixnx;larly, the stress vectors T,,T, actingat P across the planes P4,A,, PA, 4, respectively can be resolved
andtf II",,,TZ,,T23 and 7'3,,7‘,,,7;, be the componentsof T, and T, then we have v ’
T T,&, +T;,e, +T,,e, T,,g, ................. (3.2)
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Combxmng (3 1), (3 2), (3.3), we get
T Te, . .
Thus, 7, is the jth component of the stress vector f atPacnngacross aplane niormal to x, axis, If 7 be
the stress vector atPactossaplane normal to n(n, n,,ny),then
MeTneTaneg(Gn)
| ( n,) (mterchangmg dummy suﬁixes)
or, E T‘")é = e,‘(T, ;) where 7,") are components of T"”
TSI i ()

Thus stress vector at P across any arbxtrary plane normal to 7/ ( m,n,,n,) isalinear combxnatxon ofnine

stress components T, actlng across three mutually perpendicular planes at the pomt pa:allel to the co-ordinate
plane, i.e., the stressat any point of the medmm is completely characterised by specxﬁcatxon of nine scalar quantities
T . .

o v
Smce n, isan arbxtrary vector and the product T,,n, is also a vector bemg equal to T(") then from the
: quotxent law of tensor, it follows that nine quantmes T, formasecond order tensor called Stress tensor at P, Hence
stress vector is a lmear funcnon of stress tensor at that point. Again T, does not depends on time / and the
transfotmatlon of stress tensor T, =a,a a1y remams unchanged when @, isa functlon of time. Hence stress

tensor is objective.

Note 1. . The stress matrix, ( T, ) , at the point is derioted by

(7; ) 73!: Tzé .Tza (
%, T, 733

and dimension of each stress component is ﬂrcﬂﬂength)’ ,
Note 2.  The stress components 7., Ty, Ty, are called nnrmaI stresses, and thc remaining components ‘

7;,,7;3,7'2, ) 7;3,7'3, T, are called shearing stresses.
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Note 3.  Thenormal stressonfaﬁyarbi‘nm’y'pla’nenormal to 7i(m,ny,n;) isgivenby -
| N =T < Tn = TN, e i (8) b
- R .S"") be the magnitude of the shearing stress, then |
T(") T(")2 T(")z - N(")z S(")'
o 8 SO0 - =70 4 (.,y +T,~"’” -NO
=(Tn,) +(Tn, ) +(Tm,)' - (Tn,n,) .................. s (6)
Note 4. - The stress tensor 77, iscalled Cauchy sstresstensor Therelation (4) connectmg the stress vector T(")

and the stress tensor 7, is known as Chauchy s law (hypothesis).

3 8 Equatxon of Continuity in Eulerian Method.
Equation of continuity in Eulerian method the principle of conservation of mass is expressed in the form that

the rate at which the mass of the continuum within any fixed closed surfaee increases is equal to the rate at which the
net mass of the contmuum flowsi in across the boundary surface. ‘
Letus considerany fixed closed arb itrary surfaceSenclosinga volume Vlymg entn'ely inaregion through

which continuum moves. Let P(x,,x,,x,) beany pointinitand p bethe densnty of the material at Pattimet,so
that, . pP= P(xnxz’xs”)

Let dV be the element of volume at P and mass of this element is

pAV . Then total mass of the continuum which fills. the volume Vis

mp" v Now net local rate of the increase of thxs mass’ in'Vis

.m pdv = m pdv ,since Visa ﬁxed regmn of space, and the

space co-ordinates x;,x,,X; are mdependent of L
Let Q be any point on the surface S, and dS be the element atQ
with outward drawn unit normal vector n.Let v bethe velocity of the

particleat Qattime . Then 7i -V is the normal component of velocity v
alongthe dxrectxon of outward normal and  p#i - vdS is the mass of the continuum leaving volume V'by ﬂowmg out

across dS per unit time. Hence, the mass of the continuum entering into ¥ through dS per unit time is (-7 - vdS) .
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‘Ihenthemteofnetmassoftheconﬁnuumﬂowsmacmsstotalboundaxysurfhce&s
H(-pn vdS)--Hpn VdS S

Now from the prmclple of conservation of' mass, we get

R "dV—-IIpn i
"“,mv (PV)dV(byGauss s div. theorem)

m[—-w (pv)]dV 0

- since Visan arbxtrary volume, so, the mtegand must vamsh atevery pomt of contmuum, and hence

)
24 (0920 oo Q)
or, -ée+(i»‘~€’)p.+p7"ii=’0
BN CAA AL
d —
d_0 - L . PRI
whene -‘;" = -ét- +¥ -V and equation (7) or equation (8) is the required equation of continuity in spatial i.e., ‘
Note 1. . Froxh(S), wéget V.y =-«1-%£ rateatwluch densxtyxsdecreasmg
= divergence of §.

= d (log p)
V ¢
V=X

Note 2. ,,Equationof continuity in material iQ&Jmm‘anethodis
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pymp ' a(x,,x,,x,L
‘ : G(X,,XI,X,)
 where p0 * p(X,,X,,X,) p= p(X,,X,,X,,t) X, = x,(x,,x,.x,,t) o,

3.9 Prihcip’!e of balance of linear momﬁhtum: Cauc;ry’s ﬂrstf
equations of motion, ' ¢
The principle of balance of linear momentum canbe cxpmsed as
+the time rate of chiange of total linéar momentum ofa  specificportion of
~ the continuum is equal to the resultant extemal force actmg onthe

considered pomon
 Letusconsidera spccxﬁcpomonofadefonnedoonnnuumoocupy

" an arbitrary volume ¥ at time ¢ bounded by the closed surface S. Let
p(x,,.::2 ,%y,t) and v, (x,,%,, ;) be the density field and veloclty field .
ofthe continuum. Then the total hnear momenmm B (1) of the speclﬁc portxon wrthm theregion Vat time tis

P0)- mpv,dv

Now, the external forces that acts onthe consrdered portxon consxsts of body force and surface force Let

| F (x,,x,,x,,t) bethe field of body force permutmassand 7‘ (x,,xz,x,,t) be the field of surface force perumt |
area of the surfacc inthe form of stress vector actmg across the element of surface with outward unit nomxal vector
_‘ n, excrted by thc surrounding matcnal outside the: volume V Then theresultant extemal fonce R (t) actingon the

’ pomon of cormnuum in'Vattime?is given by

1= [fforar [fivas

dP L |
But 7 « )‘"R: () for the balancing of linear momentum, for any choice of region V. Hence,

£{ ) orar-fee
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m;s—‘i"—fdm mv,i"—“?”"’)é—iﬂfpzw'qufﬂmds g 0]

| p—-’*dV [[Torav-[fft,,av

Do) _dp L) gy A G
wea T a dV+pdt =a Py (dV = Jdv,)

Smce Visan arbxtrary volume, S0

p-;—‘ PE ST =0 b (02

Note 2. g If the contmuum isin statlc equlhbnum then the acceleratxon V = -(—1‘;- = 0 and hence the equatxon of

equxllﬂmmnm ,
o PE+T, ;=0 i (11
‘Note 3. Equations of équllibrium in components form are:
,w_,'..«?-;TJ”‘Jt;-;‘?-ﬂuf-ﬂ’
“oe Yoy oz
a Tzn 'o Ty f_TzS
@ & -
0 75|+_{3_7§z+_¢?_7§3
y Oz

+pX =0,

+pY =0,

2]

+ p_Z =’>O,

2|
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| end equatmns of motion along the co-ordinate axes are

d2 ‘ 37;1 ale 67;3
&Y px+ |
pdt’ P o _ay -az-. ~
- dv . aTZl aTzz aTn
&Y or+
PET T Ty T
’de__ 'aTsl 0 Ty 0T,
".dt’-.” % Yy Tm

where F=(X.Y,2), anddxsplacements 4, = (v, w)

Meehamc.e of Continuous. Media

3.10 Principle of balance of angular momentum: Cauchy’s second equetnon of motlon, Symmetry of

 Stress tensor.

The principle of balance of. angular momentum is the time rate of change of total angular momentum of
a specific portion of the continuum about an arbitrary point is equal to the resultant moment about the

same point of external force acting on the consxder portion of the continuum. - -

o Thetotal angular momentum H (1) abouttheongmofthc portxon ofthe eontmuumm Vat tnmetnsngen by
H(t) Hj(rxv)pdV ‘ "

ormeomponent form _
| H,(t) Iﬂe,j,‘xjpvde. ..... S (12)

fo, if any two ofz,j,kgre equal
={1,ifi,j,k areevenpermutatnonoleB

» where,
1,if i, j,k are odd permutatxon.of 1,2,3

~ Nowthe resultant moment M (¢) of extemal férces acting onthe continuum at time t about origin is givenby

()= [[J(7xF)odv + [[FxTas

or in component form M,(1)= .[He,,,xjp FidV + ge”,,le‘,‘ aS i 13)

From the principle of balanee of angular momentum, wehave -

.‘?_.H_._,M

-dt
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ie. 7 (Hj € jp"de] ,m. ka/PEdV’fﬁeysija )dS' . ...... (14)
o ( mey.x,mdv) (ST —
= ﬂf%x Yi = d (pdV) m s x'lv‘,)” V

= e,,‘ xv,,+x v,, pdV =0, usxng(9)
/ 4

If u, (x, g%y, t) be the dlsplacement ﬁeld andthen

& %[IﬂewxPv*d”)-*-fﬂemwwd” +Hf%"~ﬂd” ~(15) )

. Now, euv, Vs = e,,yv,v,,mtemhangmgdmnmysuiﬁxw

" Zeé,v/v, 0. |
and hence g_[ebt"f"*pdy =0 i e (16) f

Ijeilkxjn(")ds = H ey'k#jz;tnldo.s (Y.' 7;,(") =Ty,u,) N # .’ -

= gf‘,""’f(,‘.*'ﬂi"fz? ) v (usmg Gayss's div. theoremm)
= [[fes (%, )uav E—
| 4

- ng,j@(xj,,ffy;‘+x/2;m)dy
v )

© = flew O 2T )av = [feu (Ta x|y
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. USi“Sv('ls):(l‘6),(17) in(14), o
= Hje,,kxjv,,pdl’ Hj J,,x pF,,dV«%— j’ﬂ% T/* +x,Ty ',)dV

gje:aﬂ‘ﬂd;, =j;Hemxj ‘}&P”'Pﬁx =Ty )'dV

:'gjéﬂ;,x@xﬂ/’ Eusmg(i()a)] o

=0
$ince thevolum o Visanarbitrary, so at every point of the continuum we get,
O L E— '

"’Put, =1, then ¢ ﬂ,T‘§ =0
which = €,T}, +€, T3y = 0

con, Ty-Ty =O(°" Oy F '“-elsi) o

nTy=Ty o
Snmllarly, when i=2; then we get T,, T, and fori=3, T, =T},
'Thercfore,wehave T, =T, SR ¢ 1)

 which imphes thai the stress iensor is symm&tm and the s&ms et any pomi ofthe m@dxmg is @@mpﬁ@i@ﬁy sp@@m@d

by six rather than nine components of stress tensor.
, Using (19) in (1 0.b), then the Cauchy S F irst equanon of motion takes ihe ?orm

pii, = pv, = pF T severessassssenens % (20)
Equatxons (19) and (20) together called Cauchy s second equatxon of motion.

3.11, Stress Quadric of Cauchy. _
The nature of distribution of stresses m the deﬁmied

body can be understand more clearly by a geomctncal’
 Let OX,,0,,0X, be a set of rectangular axes
 through O. Let T, be the stress tensor at P(x,%,%).
: ~ Now, we introduce a local system of axes P&, P&, PG,
with origin at 2 and axes are parallel to OX,,0X,,0X,

P

T('?) ‘
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respectively. Fora given set of stress tensor Ty we ¢an construct a quadric aurfage with its eentra at P given by

. gl:j L ttesrsensesney trevseesrsearery (21)
This surface is called the stress guadrje af Qauchyg

‘Property 1, The normal stress, across any plan@ thmugh the centre of stress quadric is equal to the inverse of the
squarg of the central radius vector of the quadric normal to the plane,

 Proof. Let 7, be the stress tensor at P(%,%,%,) referred to a set afaxes OX..O 220X, fixed in space. Let
Q({, ,é,,{,) be & point on the stress quadric g =1. |
| Next we consider a plang element through P normal to EQ Let |P , Q’ =¥ and n,n,,n, being the direction
cosines of PQ where i = (;,m,,n, ). Let 7" denotes the stress veator aoross this plane, then
T =T, '
If N(") be the normal stress at P across the plane normal to n, ) thg;;
N - T(")n =T ’3553;

- ButatQ, we have
g =, l’.@,,‘ “1 ‘%
o Téh 1
L220 o
P
Hence the result.

3.12 Stress Tmnsformi&ion-
Let T, be the stress tensor at a pomt w.rt. a'system ot’ axes @X‘,QXBQX 3 L@t this system gt‘a,xes be
' 'rotated about O to obtairl a new system of axes QX ',OX ;,QX . Let TQ be the stress tensor w.rt, the new
system of axes If (4,/y, 14) be direction consines of OX; »(rmymy, m;) bo the direction consines of OX} and
(n, +1y, 1) be direction consines of OX; then we have
 R=T T =Tymm, T =T,
" Ty =Tymny T =Tynd, Ty = Tm,
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(T Ty T (b R AT Ta Ts h " o
L T T =My ml| T T Ty L m n|
I T Ta) \mom m \Ty 732 Tn homyom

i, (1)=(a)(1,)(a)’, ij= =123 s (22)

where 2}, is the matrix consxstmg of the nine components of stress in the

jprimedaxis,( )1sthematrixofstresscomponentscomspﬁndmgunpmn@d r—
axisand(a) 1sthemamxformedbythedxrechonconsm&cofOX{.OXz.OX' |

asélements (o)’ isits transpose,
3.13 Princlpal Stress:

From previous discussion it is clear that the stress vector on a surface
' element need not be collinear with the normal to the surface elerent, 8o, when
the stress vector acts entirely In g direction perpendieular to theclement of plane
on which itacts, then it is called Pringipal Stress, and the element of plane area on whxch pnncxpal stress is actmg
 iscalled principal plane, the dir@@tien of pnncxpal stmss is called Prmgmgl direction of stress or prmcxpal axis of
stress. | | .
Let P(x,,%,% ) beany point inside the continuum and 7 = (n,;n;,n;) bsthsuxﬁtn@ml vectorat P, T,

the stress vector across the element about P of area whese magpitude is T. If T be the principal stress, then it

(n)

must be along the normal #, , s0,
Ti("") =Tn,
with n,n,' =1

Z’-‘"-’ =T;n,
Qr!. (T;j ’—Tﬁu)nj ;Q goeerrensenree vesevepeesy (23)
Expanding in detail, we get .
(T~ T)”;"'T;znz + Ty, =0],
T, +(T - T)”z +Tpyn, =0
and Ty + Tpny +(Ty = T) 1y =0
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~ with nn =1, : , ,
Equatxons in(24)isasetof three homogeneous equations of n,, lfz,,n3 When n, =0, n, =0, n3 =0 thenwe -
get trivial solution, which is not compatible with nn, =1, Hence for non-tnvxal solution of (24) we must have the
determinant of the coefficients of this should be zero, '
T% -7 7;2 - 7;3 S o
Ly T,-T T [=0 (25)

i°ﬁe° -7 7 IR UL IR €
I T . ’7;3‘”3‘_' :

w Hiich gives the cubic qu Qa tion o t T'and known as characieristic equation for the determination of principel
stresses. The three roots 7),7,,7, of (25) are prmcwal stresses. Substituting the values of each of three principel
stesses 7,7, T, into (24) and using the mﬂamon n, z??, =], onecan ﬁnd the three sets of solutions of m,m,n,le.,
direction cosines for three principal stresses. '

- Property 1. The principal stresses 7;,7,7} arereal.
Property 2. The directions corresponding to the prmcxpal stresses 7,7}, 7; e mutually perpendicular
Pxoofs of the above results are same as that in the case of principal strains
"Noie 1. Iftworoofs of (25) are equal, the directions corrcspondxng to these roots lie ina plane perpendnwlar
to the direction cor“esmndxng to the simple root. i
Note 2. Ifall three roots are equal then every direction of space may be ﬁaken as pnnozpaﬁ direction of stress.
' 3.14 Stress Tnvariants: : , ‘
Principal strcsses T,T,,T, are the roots of (25) ie.

L-T T, T,
Ly =T T |=0
T T Té}'”T,,.

0r$ TJ_&TZ‘}’ezT_eJ:O

where =7, +T), + T, A
ool Bl B +|T:n g
ST Tl T Tule T, } esmssssnasens (26)
v Ty T '
b=\l Tn T |
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o Also from relati .tween the roots and coefficients are
O=T 4T+,
6, =TT +G5+Th
9, =TTT, |

Smce the principal stresses 1;,T,T; ata point do not depend on the choice of co-ordinate axes, , therefore,
T,+T, +T33 T, + T, + T, (First Invariant),

TR _’_’Tzz‘ Tzal +

’ Iy T
T I T T33'

T, T,

' =TT, +T;T; +TT; (Sedond Invarian),

T, ‘Tsz T,

t that unphes that 6 9, , 6, glven by (26) are invariant w.r.t. an orthogonal transfonnatxon of co—ordmates

) 3.15 UnitSummary:

, ~ Inthis module we have discussed about stress in simple way and methods, techmques are strai ght-fomard ’
w}nchxss\ﬂtable for the students, :

3.'14 Worked Out Examples':

Determine pdncipal stresses and, prmcipal dzrections

L S N ]
N o
O N =

“Ex.1. The siresstensor at P is given by (72/) =

Ans Let Tbe the prinbi_pal stress value, then the characteristic e,quation for detérmining the principal stress value

3-T 1 1
o 1 T 2|=0
1 2 -T
o, (3-T)(T*=4)-1(-T~2)+1(2+T)=0

ot -3 6T +8=0
or, (T- 1)(?1«-»2%3)1«‘ o
o (T-1)(T-4)(T+2)=0
Directorate of D:.stanee Edueanon ‘ - 77
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~T Iml 4,-2,

.80, 7} =1,T, =4,T, = -2 are the values of prmmpal stress. Let (m,ny,my) be the pﬁﬁeipal direction
’ correspondmg to the principal stress 7; =1 and whichare given by the set of following equauons
(3 -1) n,+n2+n3 =0 "

-n+2n, =0

n + .’Zn2 -ny =0

with 1?4} +nl =]
com==n, and n, ='-n2. |
1,

‘But n} +n} +n} =1 gives 3n? =11ie., A

1 1

1
3 ':7;,;1, = f—‘/—:;:,n3 ='“\/§ .‘ |
Similarly let (/,,4,,/, ) and (m,,m,, my) bethe prmclpal dnrectxons correspondmg to the principal stresses 7, = 4
cand 7y =-2 respectxvely Then we have the two sets of equations
G- +L+1,=0
L=al,+2l,=0
l,+2l, = 41, = 0 with l'+1’+1 =1
‘and G+2).m'+my+m, =0
m +2m, +2m; =0
m +2m, +2m; =0 thh m} +m2 +m,, =1.

Solvmg above equations for non-trxvxal solutions we get

“Thephe e Oy = g

31 4 |
Ex.2. The stress matrix at a point P in a material is given by (7:, ) =\ 2 =5, Find (i) the stress vector
' 4 -5 0

: on a plane element through P and paraIIel to the plane 2x, +x, ~x, =1, (ii) the magmtude of the stress
vector and (iii) the angle that the stress vector makes with the normal to the plane.

Ans, Since the plane element on Wthh the stress vector is requierd is parallel to the plane 2x, + X =%, =1, 50,
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dxrectxon cosmes are (:76"73' :73) and the components n, of the unit normal to the plane element are

2 ' ~1 ‘

h=Tym+Ty

o 1) 3
md 7}=73'n|+732"f+73:";=»4 T+(—5) (;7)-‘-7;-
3 (e,+3e,+e,)

-.Hence T‘”’-Ta,- -+T,a,.+re, %

: whxch is the requxred stress vector.

. . ' - - X — . . »
: 3 99 ’1’33‘
o Magmtude of teh stwss vector is IT( )' \[ ( ) +( ) = J:: = [—

- Let 8 be the angle between the stress vector T(") and the normal vector 7. Therefore, |

T .5 = |T® |7i|cos &
L T"” _J6 J6 6 6 6 \ 6
ie. cosf =
: : -2 ‘
_12\2

S ‘ : » ' ‘xx, ¥ 0)
- Ex.3. The stress matrix at.a point P(x;) in a material is (,)=| ¥ O =x,|. Findthe siress vector
: . BT - »0 =Xy 0 o

. at the point Q(l 0,-1) on the swface x,=x; +x,
Ans. Lctﬂxesurfacebe f(x,,x,,x,)-x, X2 -x} =0, ’meoutwardnonnalumtvectoratanypomtxsglvenby
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.Y 9 .0 .8 s
n=r‘;ﬁ where: e'z‘?x +ez—5x—;+e;§;a§i

T “"“Tu”t "‘Tzz"z + Ty, =1“""

7;,;1! +7;2n2 +Tu”3 =0- _\-7%"'0‘0‘# %=0

Hence the required stress vector 1s" A

‘T‘ .-Te,+Te2+Te3—-—-\-/l-_§-(e' -&)

; (. T aT T\ |
Ex.4. The state of stress at a point is given by (7;/ ) = a;r T ef where " ‘b, ‘c’, are constants and
: bT T T : :
. ’ 4 TR - 1 1 1
T is some stress value. Determine ‘a’, 'b’, ‘¢ 'so that the stress vector on a plane normal to B BB
vanishes.
- Ans, The stress vectorat a point is
f@éng+g%*g@
S 1 1
.. whete T, + o =T o w%ai"ama.gg,_m, el a4 b
3 nf’% 127 13”3 \[ZB N J“’( }
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T, = Tz,n, + Tnn2 + T,,n,' = aT:/-1=+T%+cT71= =,_§=.(a_+l +c),

T= 7;,;;1 +Tym +Tyn, = bTT+cTT+T—l-=——(b+c+l)

A'T(")-oxmphesT 0,7, = O,T 0 Hence,forz';eo,weget‘

l+a+b 0
a+1+c 0 |
~b+c+1—0

: 1
hlh +b+ - q= b B2 e
w C glvesa c /and c= 2

‘Ex.5. Determine the Cauchy s stress quatric ata point whose state of siress is (7}, ) =| where‘a’,

@ o8
o o o
a o0

‘b' ‘c’ are all of same szgn
Ans. The stress quadnc is gwen by 7},5,5 , --1 ' -
on ufn '*‘Tzz‘fz *'7;353 "‘( 7;2 TZl =0,T Tsz 01;3 Tsl 0)
% Ya Vb Yo
Wluch is the requxred stress quadnc and mpxesents an elhpsoxd.

g—-—aN~
”-

: n _
Ex:6. The stress ténsor at a point is (T ) 2 . Determine the principal stresses and corresponding
_ e | »

prina]pal"ic_!irectipns. Also check on the ihi:ariance of 6, 0,6,
Ans, The principal stresses are given by the characteristic equation

-7 2 1
2 1-T 1 (=0
1 1.1_-T

or, T3 3T2 3T+1=0
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or, (T+'1)(T’-4T+1)=o
T=-1,2+3,2-43
 Hencethe principal stresses are 7, = -1,1; =2+V3,5,=2-45.
'Iherefore, 0=T+T, +7;_-1+2+J§+2 J'.
=11, T, +TL =-1. (2+f) (2+43)(2-¥3)+ (2 «/")(-1)=-3
6, =TT, = =(=1)(2+3)(2- J')--l
 Also, from given stress tensor (7; ), we have

B 9‘=‘Z},+7;2+T,,=1+1+1=3,'

T TTTT 2y i

g, =] 2 nf fln by + =-3,
Tin, T, H ARl 2 A
R T T po2 |

O=Ty Tn Tyl=2 1 U=1(1-1)- 2(2 1)+1(2 1)==-1
L, T, T 11

; wluchnmphese 6,6, are invariants. S

Let (), vholy ),(my,my, m,) (n, Ty hy). be thé dimction cosines of the three pﬁnéfpal axes corresponding to
the three principal stresses T, = -1, T2 2+\/~ T 2- f 3 respectively. Then we get these sets of homogeneous
equat:ms '

2], +2/ +1, -0

2], +21:. +1,=0

h+l,+2l,=0

a (-l-—ﬁ)m, +2my +my =0
2m,+ (=13 )m, +my =0
'~m,+r;1,+(—l-\/§)m3 =.0 ‘
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2n,+( l+s/—)n,+n,==0
n,+n2+( 1~n~\/")n3 =0/

Solving above sets ‘of’equations sepamtely we get
[ ALy S R
J' T

e
AR

Ex 7 Theprmctpal stress at apomt are T = 1 T =-LT = 3. lfstress ata poim is, given by (7;)

oo
3w o

A ind the vaIues of 7}, and 7;,

" Ans, From the stress invariants we have
7;|+732+T33=9"’77;‘_“‘T2+T3

L Tzz Iy Tyl 7;3 7;: o
n T |
T, T Ty| =6, =T1T27;
731 T, T, b
So, we get T}, +1+T,..1 -1+3 ie, T,,+T,, 2.....;........f...;;...(i)__
T, O 1 2f T o
+ + ~l “1)+(-1):3+3-1
L 2 aloe

e, 7;1";733"4“’7;1733"".“‘1'

“Directorate of Distance Education 83



'MGChaniCSOfCOntinuONSMedia .......... nnu--unun;ue ----------- veeuse eeserreteereesy sesersesiny L T T T S T ) LTI

or, 7;| +7;3 +7;|7;3 =3 .............................. (ii)

e, T(T;-4)=-3 |
18 T,T3=4T, =<3 voooeeoessro, (iii)
From (i) and (i), we get 7;, T35 = 1 wcveecsemmissessens (V)
Using (iv) in (m), weget7, =land T}, =1. o
ExB Find the shearing stress and normaI slress on the octahedral plane element through a point whose

3
stress matrix is (7},)= I

Ans. We know that octahedral planeis nething but a plane whose normal makes equal angles with positive
direction of the co-ordinate axes. So, for the 6ctahe4fal plane, we have the normal. 7 hasidi,xfeetiqx:lﬂ(l,ll,l),: ie.,
1 1 1) |
(ﬁ ) 73’ ' 73-‘ ) are the direction cosines of the normal.
Now the components of stress vectors are gfven by

BN ERIRE T S
T T,n,+7]2n2+T,n, 3-34'1 3+l 7§>=7§->’

' ! . 1 1 1 3
L =Ty +7}z"z.j;7z.;n3 =l'7—5+0"7§'+2"‘;= ' 3!

’ : 1 1 1 | 3
and T, =T, n+Tn +Tun=l —mt 2o ot Qs = e,
. s =4ym +inn 3\": \/3 7='3 € 7=3 :E
Then the stress vector 7" is

F) 2 T3 +T.8, + T8, = —=(5¢, +37, + 33
. *1 i 2 et J§ i 2 3
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TR———— MeckHanics of Continuous Media
ﬁémfﬁte the magnitudc of the stress vector is
T \I 52 + 3’ + 32 J——

Alsonomalsu'essatapomtxs
N(N) aT( ) = T,nn,

7| =

~==Tn,+Tn,+7;n,
Rl

R EEEEES

Smce N 5 0,s0the noxmaj stress on the plane is tensile shear stress.

GO [0 N‘"’ _43 1218
- 8 < ' 399
- Ex9, Gi'\.lm‘,the following,streSsAd(stribut\iani (7;1)"" ’Ox’ 0 .;2 s find T such that stress distribution ]

is in equilibrium with the body force F ,='; -‘gé‘,iﬂ. |
'Ans. We know that the equation of equlibriumis

pPF+T,,=0
a7, aT oT,
. F + ' 12 + 13 . 0
bew PN T, o,
. 0T, OoT,, 0T,
YL T L DY)
ok o, ox, o,

oT, or,, oT.
F 3L+ IZ 33 . 0
Ph T, | o

Heregiven F = ~gé, = F, =g, F, =0,F, =0.
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aT T, a7, ’
So, we have 1L, 12 R=0=30=0, cevecrnrernnres (i)
o, ox, o 0T |
8T, . 0T, o, ' )
=Ry B 030=0, e, ii
o ox,  ox, A ) .
L es 0Ty 0Ty 9T, o,
and ~PE + ax’ ' &, + o, =0=> Pg 1"‘5‘: 0 i (ux) |
Obv1ously, for the ngen stress dnstnbunon the ﬁrst two. equatxons ie. (1) and (u) are ndentlcally satisfied. But
&om (m) we get ~
é£_1+ R T s
Int, Tr;éc,(l+pg)+f(x,,x2) .......................... (iv) il

where £ (x,,, ) is an arbitrary function of X5 X, .

Ex.10. In the absence of bady Jorces, do the stress components

L= a[*’z*ﬂ(*"n x:)] zz"‘a[xl "‘ﬂ xz x, ]E:”“ﬂ(xl +xz)

7;2 ==208xx,,T; =T,, = 0 sati.g)jz the equatzons of equilibrmm’
Ans Inthe absence of the body forces, the equatlons of ethbnum are

oT, oL, o,

1Ly =0
ox,  ox, Bx :
- o7, aTzz aTz:_o )
Ox, . ax ox,
oT, Oty 3Ty o
Ox, Gx ax
. Now, for given stress components,
oL, 9%,  oT,
+
&, 6x2‘ o, =2afx, - 2afx, =
aT,, L 0T, 1 3T,

PR —--Zarﬂx2 +2aﬂx,
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. oL, , OT, 'ar,;
ax, ax,

which imphes that the equatlons of equxllbnum are sansﬁed.

0+0+0‘0

3.17 (SelflAssessmsnt Questions :

| , . [t
R StresstenSogatParegiveninaj:p:oximatemﬁts(T;,)= 0 0 Fmdpmmxpalsn'esscsandshowthat'
s 20 2)

pnncxpal directxons whxch corresponds to largest and smallest prmcxpal stwsses are both perpendicutar to

xz -aXlS
= v o . o 6 —3 0
2. Eyaluate directly stresses invariants from stress tensor (2;) =[-3 6 0 |- Determine prmcnpal stresses
SO | 0 08 -

. and show that stréss invariants calculated from pnnclpa.l stresses are the same.

Whose it normalis 2 '32 T

4, Showthatbothofthe followmg havethe same pnncxpal dn'ecnons but do not have same prmcxpal stresses:
0

2
,andl
1

1 1)
21
12

L = IR

1
1
0

e d

o - - .  (e 1 | |
5. . Stressfieldis givenby (7},) = ,(l - xi,)x, -(-3-—2-2 0 [. Determine (i) body force distribution if
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equilibrium equations are to be satisfied, (i) the principal stresses at the point P(a,0,2Va).

c—-Q-;u—

. 0 !-2
The stress tensor at a point is given by | 1 1 whem bisa constant Detenmne b so that the stress

. vector onsome plaxie_ atthe point will be zero; Determine also-the.d.e; ’s of the normal to the piahe.

. : : 1 T 15 ~10 0)
’ The state of stress at a pomtwrt cartesxon axes Ox xzx, is glven by (T ) = -10 5 0 Detexmme
0 0 2
the stress L for related axes Ox'x,x, for whlch the transfonnatxon matnx is (ay) 101
02
5

i The'sfate of stress at a point is given by 7{,-- 4,T,=2T, =--2,7;,= 8,7y, =-2,T,, =3. Compute the

(22 1 1 2 3 o
. :,«stress vectors onthe planes with umtnormals [ 3 »3 s 3) and (717 \::,, J;,quputesthe normal -

and sheanng stress on thes.e-planes.

Isthe following stress distribution possible for  body in équilibrium in absence ofbody forces? T, = - Ax,x,,

Ty = (B’- x} ),;i-?(;'x,,l;, ==Cx, T = Ty = T3 = 0 where 4, B, C. are constants,

10,

11,

Y |
Show that the following state of stress is in equxllbnum in absence of body forces: Ty = 3x7+ 3xz x,, |

. 5 :
By =x, -6x,x, - 34,7}2-3):2, =X+ - /Z’ 33"3"'1‘*"‘2""3"'4 Tzs 0.

' . x+x L, 0} ,
For the following stress distribution (I; ) =l i % -':_Zx'2 0 |,find 7;2 (%, x,) inorder that stress

distribution is in equnhbnum with zero body foree and that the stress vector on x, =1 is gwen by

T“ =(1+x,)8 +(2-x,)8,.
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3.18 Further Suggested Readings

Conunumn Mechanics: T.J, Chung. Prentiee«Hall

Schaum’s Outline of’!heory and l?mblem of Continuum Mechanies. Gedrge R. Mase, McGraw-Hill,
' ContmumnMechames A.JM. Spencs ,LQ ‘
, Mathemancal Theory of Cormnunm Meeha.mes R.n, Cbattedge, Narosa Pubhshing House. -
Foundation of Fluid Mechanics, 8. W. Yuan, Pmnﬁee-ﬁau

Fluid Dynamics: J.K, Goyal, K., Gupta, Pl’agaﬁ Prakashan,

Textbook of Fluid Dynamics: F. Chorlton, CBS Publishm and sttﬁbutorsg

Theory ofElastxcnty Yu. Amenzade, Mir Publxshers, Moscow. ;

Applied Elastxcxty CT. Wang, Mcﬁmwel—lill " o

-
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4.1 Introduction : :

Elastic Solid : In our universe there are different forms fm d;ﬁexent matenals, and depending on those

forms there are different theories of elastic, plastic, viscoelastic bodies, viscous, non-viscousi.e., inviscid fluids ete.

- Acontinuous medium is called elastic if stress tensar is a continuous function f strain tensor such

that stress tensor automatically vanishes when strain tensor becomes zero. Asalid body that consists of this

material thus recovers its original shape and size completely whenever all stresses causing the deformation are

removed. In this case strain is fully re(ﬁoveréble. The property by which a continuous body recovers from strain
is:called elasticity. | ' ‘

Next we definea linearly elastic solid to bed continuous material (such as metals, concrete, wood) which
undergoes very small change of shape when subjected to forcés of reasonable magnitude such that every stress
component isa linear function of all strain components. It has a natural shape to which it will return whenever all
forces causing the deformation are removed provided the forc@g are not too lgrge Alsoitis resmctcd to the case
mwhxch defarmatiqn and gradxemsargsmall e '

To understand the mechanical behaviour of solid, we ~ ___
consider a thin steel rod subjectedtoa variable tensile stress T. 7 T
" will produce an extension e. If T'is plotted asa function of e, then LRI
adjacent figure will be obtained. If T'is increased to D so that | D Ags” "y )
extension lies within O4, and Tis removed then same line O4 is A I
retraced, so that there is no pcrmanent deformation orextension | /1% 't
and the rod returns to its original length. 'Ihenrodgxhxbxts elastxcnty 2
g;"eatest stress OD is called elastic limit of the matenal IfTis

increased beyond D such that extension goes frém 4 toBandT
Jis removed, the lme BCis retraced, not the curve BAQ, so thgt thereisa permanent extension or plastxc strain OC

afier the removal of T In this case rod does not fuliy recover its original length completely. The rod exhibits

plasticity.
Thus the behaviour of Smear elastic matenal is subjected to the stress within proportional range OA.

4.2 ijeﬁiv;g ;
In this module, the s*uggntg will leam about elastic solid and the general concept of stress-stram relatxon,

—¥ €<

wave equationete, -
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4.3 Key'Wordg : Elastic solid, Isotrpic media, Hooke’s !aw,Strain energy, Strain energy funection, Constitutive
equation, Elastic constants, Lame's congtant, Eulk medul@s, Clapeyson's formula, Wave equatien,

Hooke slaw; . -
Fora linear elastie solid, the strain deformation ofa body whxczh giveg rise to stresses and the Stresges are

linear funeugn of mﬁmtesimal stralns So, we can wxite

Since T, =0, when all g, = O and th@n B =0.

T =Cpey (i ikl =1, 2 13) e (1)

© This relauon between stress and strain is knownas generahzed Hooke's law for linear glastic materlal

The coefficients Cw are called elastic constants or elastlc maoduli of the bgdy since they gbaragterise the ,
clastic properties of the body, The elastic solid is said to be clastically n@nsh@mogm@us oF mh@mggeaeoug if
these elastic constants vary from point to point of the medium, and if the elastic constants are the same for all po;ms |
‘of the medium then it will be called elastically homogeneous Foran example mild stegl is hamgggneous whereas
remforaedcancrete is non-homogeneous. g
Note : We observe that Cgu form fourth order tensor, known as elastimty tensor’ and it has 34 =81 wmponenta. o

: Npqw

(Cin G- Gy G, Cmy Csu;’-lcl'u; Cins ﬁuzn\
Con Con Gy Cpyy Gy Conn. Cppy ﬁggu @gy '

(C'Jld)= :oeee T e L ees oy R ere "y vee
. vee YY)

{
rey

tos

\Cani 'Cznzz Cun Cun sz Cmg sz Sgu;'g,zww
Agam smce T, =T, sofrom(1) we get C ,,e,,, Couey ie., Cpy = Cpy.

1, . i
Also C/m 2 (C:ju +Cy ) ) (Cy/,:i - gqu ) = Cyu + ng: say

2

where C,j,,, =C/ " and C,j,, = -m;‘,*,
iﬁh gives Cpy = é‘l'é‘ =Gy =Cy forsymetryof T, and ég,p
Hence Cyu has 36 components instead of 81, The matrix of the eggfﬁclems C takes thg farm
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Chir Ciz Cin Cin Cun Cin
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vei (X3} e by e bes

»\szn quz Clm Clzzs Ciz:n sz)

Equation (1)is generatlxwd Hooke’s lawor stress~su'am relatxon or constitutive equatxon of linearly elastic
solid.
45 StrainEnergy:
| Physxcally when an elastic body is under the action of extemal surface forces, the body deform and extemnal -
surface forces that act on the body do a certain amount of work. The work done in straining such an elastic body
from the configuration of unstrained state to the present state by surface force is transformed completely into the
potential energy stored in the body. This potential energy is due to deformation or strain only. Itis called strain
eneigyof theelasticbody. ES B
4.6 Existence of Strain Energy Function :
| The prmcxple of conservatxon ofenergyi.e., first law of thennodynamxcs gives

where ‘e=intén1al,energy perumt mass,

d-—— avt+.av/
2{0x, ox

=the ﬂux heat by conductxon per unit area per unittime,
. h = rate per unit mass at which heat energy by radiationis produced from internal sources.

" For linear elastic solid it is assumed that heat conduction i$ neglected and that heat energy is produced

entirely by internal sources only. So, g, = 0. Then from (2) we get:

" Now, _for small strain_s_ we have
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a9
h = - l
ar’
Hence (3) reduces to,
: 7,'jea=P(é"Qa) .......... (4)
Now weintroduce '
U= pye and Q= poQ, ....... .. (5)

- Here,Uis the internal energy per unit volume of the unstrained state of the body and Qis the quantity of |
heat produced from mtcrnal sources per umt volume of the unstramed state. So, (5) takes the fonn ;

o B p dVo a(xpxz’xfi) ’ax l
po av a(X,,Xz;X) laX i

Pu+l¥wﬁtd&mmm&m&MMQ'”

Forsmall‘dxsplacement gradients we_\have f‘:: Lie., p=poThen(6)reducesmto o
et S AP ot Rt Pl s et n

. Té,=U- QMMMU)

Hence first law of thermodynamics gives the above result.

Again, from the second law of thermodynamics, we have-

' . O as
| g= *‘;’Q‘ =T T
. where Sis the entropy and Tis the temperature per umt volume,

I the change of state from one configuration to another takes place adxabatxcally, then the change takes
place so rapxdly that there is no time for the heat, gcnérated tothe dissipated. This isreferred as adiabatic process

and consequently Q = 0. Hence (7) gives

T.e i = =U ;
o, T,de,=dU ... o
which shows that L.H.S. of (9) is an exact dxfferentxal as R H.S. is. So, there exista ﬁmctxon W such that

_ ‘_ T,de; = =dW ... (1 0)
where Wis the mternal energy of the body. |
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if the change of state takes place isbt’heﬂnally in which the change is so sléw that heat generated has time
enoughto be dlssipated so that temperamre ofthe body remams constants. and the body is in continued equxhbrmm
oftemperamre thh sm-roundmg bodies, and oonsequently

oT
et =
I | .o o
Then (8) becomes
07' 0 :
| 0= T——- 737" (IS) ........... (11)A
Eliminating 0 from (7) and (11), we get
é =«-—-[U TS] E o F, say, i (12). 1

~where F=U- TS is the Helmholtzs'free energy. ;
' I;Ide,, =dF (usmg (12)) (13)

: ‘whlch shows that L H.S.isanexact dxﬁ'erentxal Therefore, there exista funcnon W suchthat -
R i s Tde,,-dW e (14) '
Here, W represents the Helmholtz’s free energy per unit volume of the elastxc medium. -

| Now we introduce the following notations to avoid double sum:

' T =N =0T= Ts '
T, =7§z‘.=73» T
T, =T =T,
and éu =€,y =€),6y =0y
 2e,=2e, =¢,, '_
© 26y =25 =¢y -

2e, =2¢, =¢.
Then, we have,
T,de, =Tde, (I=1,2,..,6)

Hence, from (10) and (14), whether change of state is wothermal or adxabatxc, there exxst a funcnon W
suchthat ' :
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. Tde=dW(i=12,..,6)........(15)
 Now Tde, = T,de, re presents the work done per usiit volume at a point by all surface foiféeé{ and
therefore dW¥ represents the work done per unit vbvlume. If Wis a function of independent variables €1€3300000r €y,
aw =Y ge ... (16)
e,
Tde, = Lid de,
ei
=T =2"(i=1, 2 ) e (17)
= )
Thus, for the both processes (1sothexmal and adxabatxc) thexe exxst a ﬁmcnon w thh the property T = ZW
el

This function W =W (AR ) is called the stress potential or strain energy funcnon for anunit volume of the
elastic body, as it is the potential energy perumt volume stored up in the body by strain. Equation (1 6) gives stress
components interms of partial derivatives of stram energy w.nt. correspondmg strain components,
4.7 Istropic Elastic Solid : il : e e arnd 5T

A lmearly elastic solid is known asto bé isotropi‘c ifit has the same elastic symmetry m all divections.
_ ' It menas the strain energy W must be invariant under all orthogonal transformations of co-ordmate axes. Thatis, in
other words, Wis mdependent of the onentatxon of co-ordinate axes and hence W must be expressed in terms of )
invariants of strain tensor. '
Con;ﬁtutive Equation :

“The generalized Hooke’s law for linearly elastic material is

Ty =aye,(i=1,2,3)=123)

=.;.(';.W+a¢,,,,)f%(a,,,,-a,',,,)

where b, = 2( » +a,j,,) = byt
;L o
and ¢, = 'z‘(auk_l =y ) = ~Cyi
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7}, =byyey +Cpuey
Also caueu = Cynln (mterchangmg dummy sufﬁxu)
: ---c,,,‘,e,, st v
= céueu =0, |
Hence T, =b,ey
where by = by,k . o .
Since T, and e, form second order tensor, and hence b i form atensot of order four Foran isotropic
' elastw medium the elastic constants by remams the same under all oxthogonal transformation of eo-ordmates
axes. Thus fori isotropic body by, must be an isotropic tensor of order four. Therefore, wecanwnte
. by =A8,6, + ,ud,,&,, * r&,,&,, wenvoirens (18)
_where), i, yareconstants. -
. Qr, A8,0y + pd,d, 75,,5 = /16‘ 5,, +;¢6’,,5 . +75 é‘ .
o | (f- b = b,,,)
' 'or;'(#??)(5 =80 =0 | .
whxch is true for all values of i, /, k, /. ,.
Settmg i ==1 k=1,j= 2 I=2 then above relatlon becomes

 (u-r )(5n522 512521) 0
or, - (#-r)=0
ie, M=y
. Therefore, (18) takes the form \
by = A6y + l‘(&naﬂ +6,0, ) ''''''''''' (19)
Now the generalized Hooke’s law reduces to-
I,= [M’y&,, + p(&,,o’ y +6,,61’,,)]eu e
=16 Meu +ﬂ(e,[5 +eu51k) R

Casenrulere)
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2;, =205, +2ue............. (20)
where 0 =e,, is the first invariant, j . ‘
Equations (20) are the consmunve equations or stress-strain relation for an isotropic linearly elastic body.
The number of elastic constants in (20), are only two, namely A and p. Now the strain energy Wis given

e |
- welr -'dW'-". |
gl e <)
2 (,wa + 2,ue,, )e,, o
. '. 2
: ‘ -—2-20 + ﬂ ey
= '-2-102 + ,u(-e,, +ep ey +2e) + 2e,’,‘+ 2¢},)
Thus stram energy Wis a positive deﬁmte formin the strain e,, taking posmve values only
Theorem : Principal directions of strain at each pomt ofa lmearly elastici xsotmpnc body are comcxdent with the
prmcxpal directions of stress. .
Proof. : Let us consider the principal directions of stram at apoint of the medium as co-ordmates axes: So, if e,]
: and y bethe stram and stress tensors at that pomt, then we have ' \ '
. ' 2 -O-,ez,—O,e,,,-O.”

Also from the stress-strain relation for the linearly elastic isotropic body we have the constitutive equation

T, = ,wé",/ +2ue,
ST, =266, +2ue, =2ue, =0
ATy =488, + Qe = 2ue,, =0
and T, =A605, +2ue, =2ue, =0
which implies that the co-ordinate axes must be along the principal directions of strain are comcxdes with.
the principal directions of stress foran isotropic body, that means for an isotropic body there is no distinction made

between pnnmpal direction of strain and those of stress. Both are refexred as prmcxpal directions,
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Note 1. Steel, aluminium, glass are examples of isotropic material.
Note 2. A material elastically symmetry w.rt. aplane with 13 elastic ooeﬁicmms as C', i 15C127€139 €16 C225C139C261 Ca3

C38+Ca4s €314 is called monotropic material. SR S »
Note 3. Amaterial having three mutually perpendicular planw of elastic symmetry is saxd tobe ortholmpic Wood~
wanexmnple of an orthotropic elastic matcnal and mthxscase W is ngen by .

W= -2- [c, o+ r:,,e2 + c,,e, + c“e. + c,,e, 3 c“e, + 2c,,e,ez ‘

. ’, : +Zc,3e,e, + 2c23e2e,] . .
_ whxch contams only9 non-zero elasnc oonstants mstead of 13 incase of monon-opnc matenal o
,_Note 4. A matenal wnth 21 elastic constants c“,c,,,c,,,c,,,c,,,c,,,c,,,c,,,cwc,,, czs,c”,c,‘,c,,, c”,?“,ﬁ4,, _
Cu55Cs55Cs61Css 18 called anistropic linerly elastic material. For an example of anisotropic body is provided by
4.8 Basic Elastic Constants : for lsotropic Solid :
For the isotropic hnear elastic matenal the consntutxve equanon, is
I,= /wo',, +2ue; o
where Aand pare two elastxc constants, known as, Lame 5 constants - o
oI, =A05,+2ue, '
=320+2u0 (0= &)
- =(34+2u4)0
o, ©= (34+24)6 where T, = @ .
/] = 3/1 y vevesesneness (21)

A@
3A+2u

5 195,
O 2u 2u(3/1+2,u)

whxch is the strain-stress relation and known as the mversfon of. Hooke fw Iaw

Hence, 7= é’ L t2ue

or, -
Now, in partlcular, fori=1,j=1,wehave -
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T A0

e,,v“ 2u 2u(3A+2u) _
;EL[].. A .]_ A(T +T ) |

2ul 3A+2u) ;-;2/;(‘3,_1,+2y);
. "’—-————m T T I ———creteael cx—— . N
, ,u(3/1 + 2/4) 2;:(3,% +24) (T,,_v o ) @3

Let us consider the sxtuatxon T =Constant = T, 7;, 7;, Ty=T,=T,=0. This state of stress is
possible in an elastic right circular cylinder the axis of which s parallel to x, axisand subjected to an uniform
.longlmdma! axzal tensxle Ioadxng to both ofiits ends Also, the above state of stress satisfies the equilibrium equations
inabsence of body forCes atevery point in the interior of the dylmdrical elastic medium and also saﬁsﬁes the stress-
free boundary condition on its laterial surface, ' - x

Usmg (23)in(22), then we get,

A+ A
e ‘mﬂ%—-}ﬁ n =6 = m

ey = 0,e, = O,e,, =0.

‘Now, the raﬁb of the tensile stress T, to the longitudinal extension ¢, i.e.,

(34+2
e, eu A+u

This ratio is called Young s modules or modulus of elasticity, and is denoted by E. Hence, by definition

we have

g H0A42) o
A+u

Also, we consider another ratio of lateral contraction to the longitudinal extension, i.e.,

x = Constant.

e 2(ivn)
- Thisratio is called Poisson Sratio, and is denoted by .
Hence ’
A
B e an— 26
EIETY
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Now,l from (25) and (26) we get

1= Eo ,
1+0)(1-20) - :
(+o)(-20) - @7
and H= (1+a) |

Next we consider the state of stress
Ly=Tp=T,= 7;, T, =0, T,, = S = Constant p—v2 ) B

: Thrs state of stress is possxble ina defomed long rectangular paralleloprped of scmare cross-sectlon
OABC Muchxsshearedmthe plane contanung OA andOC bya ' ’
sheanng stress of rnagmtude S acting per unit area on the sxde‘
CB. Now the stress § would tend to slide the planes of the material
.~ originally perpendrcular to OC, the x,-axis,ina drrectxon parallel
to OA, the x,-axis so that the right angle between OAand oc- B
will dl_mimshed by an angle ¢ This state of stress satisfies the
equations of equilibrium in the absenice of :l?bd)gv‘forcg atevery
poini m the interior and the b’dundary condmon 'oxi the Surfacé. |
: "Now from (22), using (28), we get - |

= % = —;;,e,, = ezz = 333 =6, =€, =0 cerennnnnns (29),
Also, fram the definition o
o 2e,, = ¢ ='Chm_éeinmgie
..%=%=,p; .......... a0’
Thxs ratio is known as shear modulus or modulus of rigidity, tmd it k — p
is idenucal with Lame’s constant 4. ‘ :

Finally consider an elastic body of arbitrary shape subjected toa |-
V, ’hydrostatrc stress P drstnbuted overits surface Also the hydrostatrc stress
dtminishcs the volume of the body Thrs state of stress possible in such a
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deformed body is given by
1, =T, = 7;3 = —p =constant.
Ty=T,=T,=0

- Thestate of stress satisfies eqmlxbnum equauon in the interior of body If T () be stress vector acting on the
surfaoew:thnonnal n;, then _ ' e
| ,7;"" =-pn, (i = 1,2,3) o

andb’ence S andery | i
S . T W, --—pn, ....;:.;...’(32) -

, at each and every pointon the surface. It is obvnous that state of stress i m (3 I) also sat:sﬁes the boundary
condmon on the surface. ’ ' ‘ “

| Usmg (3 l) mto (22), we get |

: en 922_ 933 2/.1 2/‘(3/“.2#) 3 s 2” constant

e | ':e,,,-en -en' __.o .
 Nowif g bethe cubical dilatation, then medecreasein volume per unitvolume s (8).
0= =..(e"+e2,+333)

3p
T34 +2;4

A' Thus the ratio of the hydrostatic stressto the decrease in volume per unit volume, ie,
p 34 + 2;: =14 2,u

63 A%y =constant
"ﬂns constant is known as bulk modulus or modulus of compression, and is denoted by K. So,
K=a+2H 2 .. (34)
s 3
Also K can be express in terms of Ean‘d‘ oa
K R N (35)
(l Zo')
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IfX>0, I'>O,"then we must have from (35)
O<o<—
<753

, AQain.sin’ce 0<o <-;- andE>0,thcnwehav¢ .1>0,}4>Q.

For most general materials o does not deviate from -;- and if the material is incompressible

For some solids and rocks 4 =  andiin this case

o M 5!‘ 1
:(- E= 3 =7

Now, from (25) and (26), we have

Ito 1
E 2u
g ..___}____.
and E 2,u(3z1.+2,u)
' Hence the stress-strmn relatlon becomes

l+o o004, | k
seesescrsessene onu'(‘37) N

R ahy
and cubical dilatation @ is
l+o‘ 3o
9 =g, = 7 E

l+o 30'

= — @--—-- @

E E
1-20

=0

E
o, 0= (usmg 35) .
9 = KB veererenr (38)
3
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whxch shows that dllatatnon depends onaverage normal stress.
Corollary : Express strain energy function Wintermsof stresses only
Ans.  From Clapeyron’s formula fqr strain energy function

we have
.
'En%
Hence, ﬁ'om (37),weget ”
PR | 1+a' b RF
_l+o c®
2E ’JT’f 2E

_(ixo) Ti+Tp+ Tl

(73 + 73 + T3 +213 # 213 4 23]~
4.9 Beltrami-Michell Compatibility Equations ;
- Th.e compatibility equations for the strain components are
e teuy=esy—€a=0 , TR
Combining above equat:on linearly by settmg I=kand summmg over k then we get o
eyu"'eu.y"euﬂ"'e;m "0 - - |

Now, the strain-stress law for isotropic elastic body s -

=l+0'7;/_g_®6y 1;0‘(7._ o @50), (

“TTF VE l+o 7
T+ Ty =T =T = f;‘;(sy@m +0u0,, '5u®ajk "ajke’&)
N » o 3¢ . o ,o"'" N
) or" VZT;I +®,,-j "'"1";";5,/V2® "m“@’f/ + 1+o e’ji + 1 +.0' 9 | ik JJk + Tk Jk
o, VI+— o Z-0,- v Z_5VO=T, , +T, J— (39)
Again the equations of equilibrium are

Tyt PF =0
Thy=-PF,
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Using above results in (39), ws’get‘ ,
2 1 2
VT, + =0y -Haéﬂ Ow—p(ﬁ,,+£?,,,), o (40)

; S’e’tﬁpg'jaiandmnﬁngovermmonindexi thenwehave

, V2®+ : vie- LA ——V'@= Zpdivf
1+o l+a

or, V’@a-Z(—l-i—‘?-)p av ... (41)

Usmg (41)into (40) then we get

vy, +m@,¢, - se%-nay p div.F p(F,, N FN) o (42)
; These are six independent equations whieh are known as Beltxmvmch@u Compgtxblhty equation for
Note L Beltmma-Mieh@l! sompatlbllity aquauons for stresses givgn by (42) are suitable cmly for isotropic elastic

body wheteas SaintaVenmt s compatibility equations for strain are suitable for any body. -

Note2. BelmeMieheu compatibility equation sometime kmwn as First andamem& Boundary Value Problem.

4, 10 Wave equation : Navier's equations of motinn :
The strain components are given by

wi{ 20,20

and strainstxess relanon is

T, =408, +24ie, where 06 + oy +ey = %’i—:-
=AGy K, T ) B+ ()

o T”,! = &é’ygu ’*’y(ulgy + ulv(’)
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. '

=40, +p(uy +u,,)

t

=48, +4V, ’;Héu
C=(A+p)6, 4V,
Submmtmg theseintotheequationof motion
o T+ PF, = pil,
Thenwe get o -
o (/Hﬂ)@,, +UV, + pF = il e (43)
which isknown as Navier's equation gfm@txon.
Wh@a boc!y forces mgbsgmi ¢, when & =0 then Nvier' sgqgatign afmotxgn reduces to

(&4’#)%%&”‘}!7&“, gﬁla EITTITIeny (44)

When the motionis irrotational then

g!! ¢’I
~=u, = ¢w =Vig

wd 6= (szé)as' =Vi(¢y)= ?*!!43 :

8@, the equation of motion reduces to
(A+4)Vu, + 4V, = pil

o (4 2U)V'u, = pi,
v U

a‘ =6 Vzu, reeeser 45)

or,
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 When the motion i isochoric, then,
‘ | | : O=e,+eyteéy =0 .
' and hence equation (44) reducesto - '
”Vz-“) = pil,

S, _ . |
oS3 =GV e (46)

where %—{- =c;V3u,

This equanon represents 8 wave equation for displacement called. eqmvolmnnal waves, propagaﬁng with

_ | the velocnty c, = \/E
. P .

411 - Unit Summary
In this module we have discussed abcmt Hooke's law, strain energy funs:t;gn, relations @mong Elastig

constants, wave equation etc. which has covered all pmtiggg @fsmsSastmin

a3 Worked out Examples
Ex-l If the principal directions of stress are coincident w:tlz the prmaipal directions of strain and if the

relations between principal stresses T, and principal ,strams ¢ are T,= A0 +2ue,, then P’OV@ that stress- -
strain relations for any system of axes are ‘ |
T, =A00,+2u6;

Ans. Let Ox,, Oy, Ox; bea sef of rectangula axes slong
the principal directions of stress and strain. Then
Ty =N Ty =TTy =Ty oy =Ty =0

) = €00y = €3, = 3,6y = €y =y = 6.
Let Ox/, Ox;, Ox! be another set of axes with direstion
cosines l,?lz,lg;m,;mz,m;;n,,nz,ug; respectively.
By the law of transformation of stress components
we have | o .
T w T = T+ Tld # Tof} =T + T B
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Ty = Tdim, =T \m, + T, nlzmz + Tl
=Tm +TLm, + T\ym, '
Slmilnrly ﬁrom law of transformation of gtmin comppnents weget
Coe =e,l, +e,f +e)i, | '
&, = ehm, + €lymy + e;l;m;
Jé -2ue, .
...Tl, +T1 + T2 - 16(e, te +e)-2u(el +e,1z +e3l;)
=(f~- 2!‘31)11 "‘(Tz "3!‘32)13 *(Zi 3/‘9;)13
. =201+ AGLE + 4617 - A€ (using given condition)
sa0(i e eg)-20

| Henee, 7;"= A0 +'2yg,’, 1
Silnﬂmy, 7;’2 = ,19 + 2#9;2 ‘ tresreveeery (i)
- Ta=A0+2ue, )

© Ty~2pey = T;!,n?; + Dl + Tlmy = 24 (elm, + Qzlamz + .3;1;’”;) |
o =(T; —2;49,)1 (T = 2 ey Yy, + (T, =24e,)lym,
= A8l m, + AGlm, + AGlym, (ugmggxms@x@aem
= Aﬂ(l,m, +hm, +lm,)

~ Hence, T, =2pd, -
Sifni!aﬂy, 7;/3 = 2[1 353 FETTITRIITITS (ii)

2;‘ = 2/£ g},
Hence, combining (i) and (n)! we g@; |
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Ex-2. If the stress invariant @ -and strain invariant @ are connected by the relations © =3 Kg and
| T =2, (i # J) for all pairs ofnectangular axes ox, and ox,; then prove that
Ty= A6+ 2ye,,,T,, = A0+ 2pey, T,y = A0+ 2/‘333

for any system of axes. :
Ans, Letusassume that the ca-ordmate axes Ox, along the principal directions of sttain. Then wemusthave

: e = e,, =e, =0.
Also, giiren that, - ‘
o | | 'n=2uea(f#'f)
Ty =2pe, =0, . |
Ty =2ue, =0,
and T, =2pue, =0. :
- Hence the axes Ox, must be along the directions of pnncxpal stress also. If ox], oxj, ox;, be the another
system of co-ordinate axes with direction cosines l, A ,I, sy 1, m, 1,0y rcspectxvely Now from the law of -
transformation of stress and strain componentswehave o ~
Ty =T dm, =T, Jym + Thym, + Tyhym,
and ey =e,dm, = e lm, +ephm, +eylm,
Now fiom the givenrelation 7}/ =2ue[i(i# j)we get
- Ty~ 2ely =0
Hence
Tudmy + Tplymy + Toglym; =24 (ex my + exlymy +eylymy) =0
(Tn ~2pe,,)lym, +(Ty '2#923)12"5 +(Ty — 2413 )ymy = 0
Again, since lym, +1,m, +l;m; =0, therefore '_ | -
(7 —2]18,,) =(Ty "2;“322)"" (T3 —2pey,)

5y —2ue, _ Tzz"zl‘ez; 733“2#93: Tn"'Tzz"'Tss -2p(e ventey)
1 1 1 T 3
L _©-2u0 3KO-2u0 .
3 3

or,
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- Hence, R T
- T,, Qe =48 e, 2;, 404206,
) T22 —2ue, = A6 ie., T, = 10 +2ue,
- T3 -2ue; =46 i ie, Ty = /19+2ye3,
Above relations hold good for speclal choice of co-ordmate axesalong the common pnncnpa.l dnrectxons of
stress and strain. So, for any system of co-ordinate axes we have the transformation of stresses and strains |
2;, T;,I,IJ-,TI’-rT BaT 2. '
, el -e,,l +e221 +e3312 ,
K 2;4e” 7;,12 + T l2 + T 02 - 2,u(e, VA +e221 +e,,1 )
=(T, - 2,ue” Y +(Ty ~2pe ) + (T3 - 2!‘333)12-
= /16’(12 +12 +I’) (usmg(l))
=46, (R +5+8 =1)
Therefore, ' ’
T, = A6 + Auej,
Similarly,
I =A0+ 2pe;,
Tyy = A0 +2pel,
Hence the result.

Ex-3 . When a body is subjected to uniform pressure suchthat T, =T, = 7}, =- P, =T, = L= 0. Prove

U Wb _"P

that P ;'2' =% 3K’ assummg that dzsplacemem and rotation at - x, = 0,x, = 0,x, = 0 are zero.
1 2

Ans. The stra1n~stress relation in terms of q', Eand @ is

l+o.,. 0@,
“TF BTEY
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where

0= 7;1"’7'22"‘7'33"'.“‘!’ -p- 17""‘”3.”
.. l+a 3 o
Now |

Byintegraﬁbnweget
L) -"'é'ixz +fz(xnx3) ........ (ii)-
and u;=—§-;(-x,+f,(x,,x,) ....... @)

‘As Ty=Ty=T;=0.

e =y = ey =0,
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du,  du
s .___*_,,_._2_:0
1.C. ‘ ax2 ax2 .
Ou, Ou
- ax: a"z
p —t4+—Lt=0
and - Oy Oy

oY, e O, O |
o, h, % g%, % 0—-1 b 2 v (i
ot Vo e e Tae SO ™)

Since #, =0,u, = 0,u, =0 when x, =0,, = 0,1, =0, therefore from (i), (ii),Gii) and (iv) we must have,
o Se05=04=0 o
Hence |

Uy = Xty =

3K 31< Faolly = 31<

o WM P

Ex -4, Show. that the stress potenlzal or strain-energy, ﬁmctton isa hamogenea usfunctwn of. second degree
Ans The stress potentxal or stram«energy function Wis given by
7=

o 0 o

where T, =T,,,T, =T),,T; =T33’ T, =TT =11 =7;2‘ ;

and ¢ =¢, , 1€) = €3),€5 = €3y, €, = 205,85 = 20,6, = 2e,2

Since W represents potentxal energy per unit volume stored up inthe body by stram deformation alone, W
must be a function of components of strain so that -

B 45 4 TN J— (ii)

Expandmg W in a power series about (0 0,... 0) Then we get

W= W +Ce + ; Cee +.. .. wee (i)
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: | ! 68, "4;5'” aeae/ '.-9""\

Since we are: mterested inthe denvatxves of W, so we can set W, =0, and hence

W=Ce +~;-Cue,e, ........ (i)
Using (iv) in (i), menweget
Z,=C, AT (Cuese,) o

=G4 3o ves )

POu
: ¥C,+1<eC 4= e,,C +
27 2
- ,.7‘=c,+%(c,,+c”)e,+ .............. ")
. But fo?the cbntinq;un body, we ‘ '
oW W
Be,(?e 6e/6e ( |
' Hence V) becomes
: T= C+C,,ej+
Also for elastic body, T, =0 whenever ¢ ,"-,- 0
C =0 '

- Thusforlinear elastxc solid, stresses are lmear functions of strain, we neglect all terms of order two and
. hiéhermstxmn. , ' B '
80, T,=Cyeummrn (Vi)

Directorate of Distance Education 13



aﬁd then from (iv) we get
| 4 =1 LI (vii)
where C, = C,.
Combxmng (vi)and (Vll)c
' i‘ =--Te (i=1; 2 6) .......... (Vlii).
.—.-;- %—”—(z,]=1 2 3)

| de
57,2, (11 =1,2,3) where ﬂﬁ;;l
I

| whxch is known as Clapeyron s formula.
Agam from (viii), we get

ow o
. 2W =Tg, = e & (using (i)

'~aW' ow  ow

ie —tey— .t — =2 .
_ae, 26e2 t‘ae‘ :

‘which shows that Wisa homogeneous function of second degree

chanics of Contimious Media.......... hesarersstrsons sesiunensssinesssiesoises
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Ex.5  Show that Navier 5 equation of motion in absence of body forces (A + ,u) 8, y +ﬂV u, = pil, is satl.gﬂed

by ii= V¢ +Vx y/ provided ¢ and @ satisfes three-dimension wave equation

Ans. . According to the given condition-
- ' ii=':€7¢+V’x‘y7
we have - ' | i

=4, +em% J
~wheree, = | 0, xfanytwo ofi,j,kareequal _ '
' 1,ifi,j, kare even permutation of 1, 2, 3
-1,if4,j, kare odd permutation of 1, 2, 3,

114
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fl'-_heﬁ Navier’s equation of motion inabsence of body forces redgcés»fo e
,U(("a/ +eyle: ;)w (’1"‘!‘)(”7,/)’:‘[’“:
or, p (?’w +el/l:w kol ) (’1 tH )(¢’I *eu¥s, ) u

But  eu¥iu =euViy

Hence, e,y = 0.

(é’»}z +e(/‘¢k,/ )

= f"eat%.m =~eu¥s '

: ‘Therefore above equation becomnes
[(A+ )0 =P ]+ e 1410~ P ]+ 490 =0
. [(A+28)p.-p], +e, [#m pm] +l‘¢:m"0
which is possible only when '
(4+24)p,-pp =0
-~ and KW= P =0
ie., '(}t+2y)V2¢) = p@
and 4V, = py,
Do _

- OI', _a';-z- =¢ V2¢
anlk 2

and —St=ciVy,

<where(:. 1’ +2u and ¢, = \/‘

Ex.-6. Show-that, in case of equzhbrium of elastic body under no body forces, the strain invariant 6 =e, -

and stress invariant © =T, and rotation tensor R, = E(u" sl u) are harmonic function whereas €, I,

and u, are biharmonic functions. .

Ans * Thestrain componénts are given by

é” é--%(uu +uj;,’,) SR

Directorate of Distance Education
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and stress—stram relatxon is

106 s +2ue, where 0 = e,,+e,, +¢n"¢n’“n
"’1“&36 +/‘(“1/+ul.l)
n/"z(“kt)'/&/"’”(“'ﬂ"'u/ﬂ) |

| 'g'z(u‘“)"'mv ?‘“"“_‘(“1./)"7

=26, +yV’~u, +u0,
= (A4 p)0,
The equations of equilibrium of stressesare |
| | T,,+PF, =0 |
- So, we have i S
’ | (1+I,u)0,‘, +uVu, + pF, =0

. Hence equanons of equilibrium in absence of body forces are
Veu, +(A+pu)6,=0 .o O8 '

or, p(V u,),,.+(ﬂ.+y)0,”=o ~.

o o ' y ) azu a! au .
o ) rarono [ 2(2)-2(2)

on. uV0+(A+p)VE=0
or, (/1+2y) V9 =0
V30 =0, (= uz,u;eo)...........,(ii);'

: Agam from stress~stram relatxons we have
T /105 +2pue,

oT, =340+ 2ue, =(34+2u)0
ie, ©= (3,1 +244)8

. Againtaking V2 operation on (x),thenweget ,
Viu +(A+u)V?(6,i)=0

’1:16 ~ Directorate of Distance Education



. .
S seseuvbetensbebestisbervasnersesaseR e as seasBOSb SR OSSO RERIS IR SRS ERS S SRR S e R RSO0 R0 00 S Alechanicsof ContinuousMedia

o v-[éi—’-‘-]v @)= 2E)e).
= 0 [using(ii)] ....... (iv)

Now Beltmmx-chhell stress compatxbxhty equatlons in absence of body t'onces are

1

v? 7;, — T @,,=0 [usmg equation (42)]

. 1 o '
or, V T +T;——-V (@,y) 0
' 1
VT, o V@), =0
V“T 0 (using (iif)) cooererrres @iv)

Also, stress-strain relation can be wntten as

- (l+a')[TU __.____._95?1]

4=F l+o
Ve =221 (1+o) [V‘T -2 s v‘e]
: E. ¥ l+o’ a
ie, V', =0 (using(iii) and (iv)) oo (VI)

Again from (1), 1V, +(,l +4)0,,=0
. /'lvluu + ( A +/‘) a'jr____ 0 (intel'c e, iy

Subtracting above :eSults, we get

- _de _ 29
V(=)= 0[ T vy 9’/’)

ie., V2 Ry =0 (vu)
Results (ii), (m) and (vu) implies that 6,0 and R, are harmonic funcuons, and results (xv) (v) and (vi)
implies that ¢, T, and u, are bxharmomc functions.
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Ex.7 Show that the jbllowmg stress componems are not solutions ofa problem in elasticiow. even though they satisfy
the equations of equzl:brmm with zero body forces 7;, = [xz +o (x, x, ] Tz, = a[x, + a(xz »«x,z )]
733"“0(*"1 +x,) 7}2»—2aox,x2,T2, 7;1 0. B

Ans, We know that the ngen stress components are the solutxons of a problem in elastncxty 1f they satisfy the,

equauons of equilibrium

v’z;,. 1+ @,,j—f-l--z_-ﬁupdiv.ﬁrp[F +F, ]

In absence of body forces itreduces into

Now VT4 —— =( + +“)E:+ma?(ﬁzf‘?}é+?is)&v ,,

#0(ra=0, otherwxse all7,=0) -

= 7} , isnotasolution of a problem in elast:cxty

: 1 o0 (o a" & 1 &, .
Smularly,V’T +T:o'_6x2 =(6x’ dx’ ax’]T +l+ —-;(7;,v+7;2"-h7;3)’

—-[2a(1 a)+2aa]+-—-—[(l cr)2a+2aa'+2aa]

=2a (l+ )Za =4 20,

(1+0)

and we can show that

N | o
V’T Ao @,,,;#0 for 733,7;2,T,,,7;,

Hence given stress components are not solutions of the equations of equilibrium.,
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4.13 Self Assessment Questions v
1, Whena bar is stretched by a tensxon T'suchthat T,=TT;= T, =T, =T, =T;; = 0; prove that

w_ (0T w AT
x  p(3A+2u)'x, x 2,u(3l+2p)

assuming that displacement and rotation as x,=0,x, =0, x, 0 are zero. |

2 IfW= -2—[/1 el +2u e,-,e,,] then prove the following:

ow
. T—-—-——
) v e,
'a)"W=lTe',

| .ﬁi) Wlsascalarmvanant,
V) W20andW Oaﬁ’e,,-o

.o
Ve
3 In an elastxc beam placed along the x, -axis and bent by a couple aboutthe x, <axis, the stnesses are found'

=6,

tobe:r =-£x,T =T,=T,=T; T=0 whereRnsaconstantFmdthecomspondmgstrams
33 KR 7] 12 =43 T4n

4, A beam placed along the x, -axis and subjected toa longttudmal suess 7,, atevery pointis so constramed
ihat enand T,_., are zero at every pomt Show that

_Ll."i'.."r

, T, rTu-en E T 5 = -
. 5. . Inavertical elastic beam deforming under it own weight (actmgmthe X, -dlrectxon) the strain components

are found tobe

/1
€, =€ a(b x,) ess -a(b x,) €y =€) =6, "0

| 2 = 2 ( A ”)
‘where a, b are constants. Find the sttess components.
6. Show that the stress-strain relation is equivalent to the following relations taken together:

tr(?‘”) =(34+2u)tr(e,)
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and T(d) _Zﬂe(d)

w‘}'where T(")_-(ZT 5 T) T(d)__(zy;_n T) etc .

and 4® =220 0, ;) of R O R

e arc known as stress and stram devxators

414 Further Suggested Readlng : |
1. ,ContmuumMechamcs :T:J. Chung, Prentxc-Hall
2. Schaurn’s Outlme of Theoxy and Problem of Contmuum Mechamcs Gedrge R. Mase. McGraw—Hxll.
3. Continuum] Mechamcs AJM. Spencer, Longman. ‘
4 Mathematxcal Theory of Contmuum Mechanics ; R.N Cbauegee, Narosa Pubhshmg House
5. Foundanon of Fluid Mechanics : S. W Yuan, Prentice-Hall, . '
6. Textbook of Fluid Dynamxcs F. Chorlton, CBS Pubhshers and sttnbutorb
7. - Fluid Dynamxcs JK. Goyal K.P. Gupta, Pragati Prakasan, |
8. "IheoxyofElasncxty Yu, Amenzade,Merubhshexs, Moscow.
9. Applred Elastlcxw CT. Wang, MoGraw-Hill
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5.17 Boundary Surface

5.18  Constitutive Equation : Perfeet fluid

3,19 Equations of Motion

520  Conservative Field of Force

5.2t Bernoulli's Equation of Motion

5.22 Integrals of Lagrange’s Equation gf Motioq
5.23 Cauchy’s Integrals

524  UnitSummary .
525  Worked OutExamples

5.26 Self Assessment Questions
527  Further Suggested Readings

5.1  Introduction;

Perfect Fluid ;- , ,
Before going to discuss about perfect fluid at first we shall discuss abaut the concept and behavieur of the

fluid.

. When a force of certain magnitude applied to a material pg@duggs a ﬁnite, §mgu dgfgmgatxgn, thenthe
material is called a solid and if the deformation altering the shape of the material disappears as soon as force is
removed so that material returns to its original shgpe, then the material i called elastic solid,

On the other hand when a large extemal force applled to the material progggeg a pemamgnt deofimation
which does not completely vanish even after the removal of forces so that material does not fully recoverits original
shape, then the material is called Pplastic one. ;

But when the smallest external force applfed to the mgteiial will eventually géugg a continuous shear
defomzatlon of relatxve shdmg so that its constxtuent particles are frgely maobile, then the material is called | fuid
material. This continuous shear deformation oft the ﬂggd under the action of smallest force is called the flow afthe
Sfluid. So, the ﬂuzd we mean a substance which is capable of ﬂgwmg Actually fluids are diyidgd into two
categories : (i) liquids, (ii) gases. Actual ﬂu:ds have ﬁve physical properties ; density, volume, temperature, pressure
and viscosity. Unlike sollid, fluid has no stress-freg state to which it eventually retums if the external foree is
removed. Consequently, every confi guratidh can be regarded as the reference conﬁggmgggg The continuous flow
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of fluids changes the shape of the fluid. It hasno definte shape, but for given suﬁicient time it takes the shape of the

container into which it is placed.

5.2 Object;ves : .
In this module, the students will leamn baaut perfect fluid, its velocity, acgeleratxon stream lines, path lines,

type of motion, velocity potential, equation of motion, equation of continuity. Integrals of equation of motion ete,

5.3 Keywords: \

~ Fluid, Perfect fluid, Newtonian fluid, non-Newtonian fluid, Pseudo plastic, Lagrangian Method, Eulerian
method, Local rate, Individual time rate, velocity, acceleration, Stream lines, Path lines, steady motion, rotational
motion, irrotational motion, velogity poteritial, equation of continuity, boundary surface, constitutive equation, '
hydrostatic pressure, equations of motion, Conservative field, Pressure equation, integrals of Lagrange’s equation
of motion, Chauchy’,s integral, Helmhotlz Vorticity equation. o

54 Behaviour of the Fluid ; :

(i) Atrest: Let us considera material ABC resting methbnum normal s

Stress stress

on a horizontal plane AC under the action of gravity. Let DE be an _ shearing

. ., Stress
imaginary oblique plane section within the material ABC. The external . '
force acting on the portion DBE is its weight acting vertically ;;’;‘;"”g &~ X
downwards and it can be resolved into two components: normal force DX “\ap plied ext ;:,';';Z % °"e\\J
perpendiculat to the surface DE and shearing force along the surface A _C

DE, To balance these forces, portion ADEC must exert stress on ‘
portion DBE across the surface DE, Again this stress can be resolved into two c@mponents the normal stress |
pcrpﬁndxculax to the surface DE and shearing stress along DE.

' Ifthe material be solid then the solid, at rest, exerts shearing stress resting the sliding movement of one layer
over another and thereby balance the appli@d sheanng fo;ce to maintain the equnubg;um of the pomon DBE.

like a solid and mnggquently if mll sl;@g dgwn thg glgns DE becapse mgcnnolecular forces are weaker in ﬂuxd and
fluid molecules can move past one another more freely than in a solid. Thus fluid at rest cannot exert any shearmg

Directorate of Distané_e Educati_on 123



Mechanics of Continuous Media....................covevverveconsrverrron, S st st e vars et ss e eanes

stress on any-adjacent layer 0 resist its sliding movement and therefore it can not support any shearing force,
however small, so that static equilibrium between applied shearing force and shearing stress never works,

ii) InMotion : The fluid in motion exert on any adJ acent layer moving with different velocity some kind of
frictional resistance to alterations of form in the form of shearing stress in the tangential plane in addition to the
normal stiess in order to accelerate or dissip@tg ifs state of relative motion. So, when the fluid is at rest these
shegxmg stresses have no role to play but only when some portion ofitis m@ving on, they are requxred 10 oppose
or accelerate the motion, The relative motion of the fluid layers gives nse tothe shearing stresses, and these stresses
vanish whgp the rate of deformation or the rate of change of strain is zero. In case of perfectly elastic solzd when
aforceis apphed itundergoes  finite deformation which vanishes as soon as force is removed,

' This property.of the fluid in motion is able to exert shearing stress on the adjacent layex to resxst its sliding
motion under the action of smallest shearing foree is called viscosity and fluid having this propertv of viscosity is
called viscous fluid. '

| Now we define some viscous fluids as:
5.5  Viscous Fluid : A viscous fluid is a continuous material which can not develop any shearing stress whenin
ethbnum yet when in motion, it can exert appmpriatg shearing stress on any adjacent layer with which itis in
contact to resist its shdmg movement under the action of smallest shear force but in the lfmg run, this smallest shear
force causes a continuous shear deformatz@n altering the shapg of the material,’ _
5.6 Newtoman Viscous Fluid ; If the stress exerted bya vigccus fluidisa lm@ar function of the rate of strain,
 such that stress automatically vanishes when rate of strain i zero, then the fluid is called Newtonian viscous fluid or
hnearly viscous fluid. . :
5.7  Non-Newtonian Viscous Fluid : Ifthe shearing stress is non-inear function of rate of strain, such that
shearing stress is zero when rate of strain is zgr@; the ﬂuié is called non-Newtonian viscous fluid, |
5.8 Perfect Fluid : A perfect ﬂui_d is a continuous material that is incapable of exerting any shearing stress on
any adjacent Iayéz in ts contact to resist its shearing movement under the action of the smallest shearing force,
whether it is at rest or in motion so that mt,inggué shear deformation readily takes place altering the shape of the
material, The following have the same megmng perfect, frictionless, invigggusg non-viscous and ideal. From the
definition of shearing stress ;md body force it is clear that body force per unit areaat every point of surface of a
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perfect fluid acts along the nomw to the surface at that point,
* Behaviourofa perfect fluid for which shearing stress is

: . A 3 D
zeto is represented by abscissa. Non-Newtonian fluid is g L oﬁ’
S 0 e K\
: represented by curve and main class of non-Newtonian fluids_ ¥ g °$\ @%\c
aneBmghm plastic, Pseudo plastic and Dilants. Also the ordinate | § &
represents the perfectly elastic material becauseits deformatxon ol \3&@ - o
; Perfect fluid

is finite and constant so that rate of strain is zero. Butstressina’

‘ ~ k Shearing Strain (rate of
linearly elastic solid is proportional to its strain whereas stress is strain)

lmearly viscous fluid is propomonal to the time rate of strain.
59  Classification of Fluids : " ’
| Flmds may be classxﬁed as: Compressxble and mcornpressxble w.rt. the change of volume.
Ifachangein the stress appliedtoa quantxty of fluid produce achange in volume so that ﬂmd can easxly be
compressed then the fluidis smd tobe compressxblc (Asthe molecules of such fluid are far apart having considerably
Aempty space bctwen them). Gasi iscompressible ﬂuxd ‘
A Ifa change inthe stress produce no change in the volume ofa ﬂuxd, SO that it can not be compressed by any

' amount of stress, then the fluid is said to be mcomnressxblc (As the molecules of such ﬂuxd are close together w1th

little space between them). Liquid is mcompressxble
" According to the behaviour of the fluid it can be classified as:

Flud
‘ | _ :
| T l
. Newtonian L “Non-Newtonian
| | 1. T - |
Viscous Non-Viscous  Bingim  Pseudoplastic  pyjanys
: _ - plastic | v

§.10 Methods of Descriptions of Motwn :
i) Lagrangian method : In this method, any-particle of the fluid is selected and its motion is studied and

hence we determine the history of every fluid pamcle.
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If(a,b,c) be the xmtlal position of afluid particle and after some time ¢ let takes the position (x,, z). Then
itis obvious that x, y, z are function of t,a,b,c. Thus . ‘
x‘-f(a,b et),y = fz(a,b &),z = j;(a,b c,t) ‘
- Ifthe mouon is everywhere contmuous, then f j; ) f3 are contmuous ﬁmctxons so that we can assume that

. firstand second order parnal derxvatwes w.rt a, b, ¢, texist. Then veloexty and acceleranon eomponents are

f f _%. 52fy 32fz' a.,’f,,
BrTadd a: Fat o’ a:” or?

ER Eulenan method : In this method, any point fixed i in the space occupxed bya ﬂuxd is selected and we

observe the change in the state of the fluid as the fluid passes through this point, Since. the pomt is fixed and so
| x, y, z, tare mdependent vanables Hence the symbols g%, Wz have no meanmg |
-Note : Difference between Eulerian and Lagrangran methods are: .
‘In Eulenan method we study the motion of every ﬂmd partxcle ata fixed point; whereas in Lagrangian
method we study the motxon of every fluid parncle at every point, Hence Euler’s method corresponds tolocal time
rate of change and Lagrangran method corresponds to mvxdual tnne rate of change ”

5, ll Local and Particle Rate (Indlvidual time rate) of

Change. . : , o . I . O(nednx +dx,,
Supposea'p'articleof fluid moves from ‘P(x,,rz,x,) at | Plnx,x) %y +d,)
time ¢ to Q(x, +dx,,x2 +dx,,x3 +dx) at time ¢+ 5r, Let - i
» A(x,,xz,x,,t) beascalar function associated with some property
| of the fluid (e. g the densxty) Then in the motionof the particle _'
_fromPto Q, the total change ofA isgiven by | |
04 o4 04 o4 .

dA=—Fx +—F8x +—--é‘ +—0t
o e O

Thus the total rate of change of 4 at the point P at time ¢ in the motxon of the particle is.

d4 _ lim (JAJ OAddy 04dx, 04 dx, o4

@ St—olor ‘5?717 Bx, r 55',717 £}
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_aﬁw o4, 04 04
3, %, O

where ¥ = (v;v,,, ) is the velocity of the fiuid particle at P with

& ‘
v, gj(i=l’2'3)' Hence

dA - = O0A
L o794+
2=V ARG s (D)
and Lalif T @
t o
Also (1)is valid fora vector function 7 (x, s X35 %351) assocxated w1th some property of' the fluid (e.g.,
velocnty) Then ‘ . ‘
dF _OF 5 o\ =
—=—+(V.V)F ...
dt. ot ( ‘ ) 3)
Here o 7; are tota.l tlme dxﬁ’erentxanons followmg the fluid pa:txcle and are called the pamcle rates of

F
change or mdxvndual time rate. Also the partxal tlme derlvates %;' % are only the time rates of change at

P(x,\,_x,g..x,‘.), considered fixed in space : they are the localir}qtespt«\.cmf:- Now 7.4 or (7 Y),F., represents.
the rate of change due solely to the motion of the particle alongits path.

512 Agceler#tion : Let the fluid particle be travelling along a curve
C. Attime its position P is sbeciﬁed by OP =F and its velocity. j/

along the tangent at Pto C is in the direction of the particle’s motion.

Then the instantaneous acceleration 7 at P(x,x,,%,} is

AV W (5 e\g 4)
P +{(P-9NP @

IfV= (vl ,¥;,¥; ) then we have the components of acceleration are -
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dt o o, ™ ax,
v, ov, [ o K 0
—j -5;3-+(v, ™ +V, o, +v,ax )v,

d, v (8 8 o)
' o =-5'A+[V --~ -——.‘.‘VJ“—)V&

ek M | so00e0 6
A @ P (-?
5.13 - Stream lines and Path lines ;:

A stream Ime or line of ﬂow Is a curve such

that the tangent at any poim of it at any instant of

time coincides with the direction of the motion of the N Y e

ﬂutdattha:pomz If V= (v,,v,,v,) be the velocxty of | sy
| O(x +dx,x, +dv,,

the ﬂmd partncle (matenal pomt) 8t any pom{ i
‘ X, +dx;)

.P(xl,;c_,,x,) onthe stream line at time fand’ OP=r N
then PQ, where O(x, %dx,, x, +dr,x,+de) ais’
neighﬁoﬁf-ing‘péintofPonﬂmeMIme, willbethe

tangentto the stream line when Q - P ie., ;direction of the tangent and direction of velocuyare parallel ie., V"
is parallel to cﬁ’ and hence

VxdF = O : ,, 5 Co
If follows that the stream lines are the solutxons ofthe dxﬂ'erentxal equanns V = kdF, kbemg constant o
ie, % _ _‘i’f; R )

Ww Yoo 4
These equations yield a double infinity of solutions, at txme L.

A path line is a curve which a particular fluid particle describes durmg its motion. The dxﬁ'ercntml ,
equanons of path lines are
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e ody o de
thchunphw‘zl"'vn*;}%ﬁvu?""' V, n

e -2;-*\’, virnenns (8)

These equations have tnply‘mﬂmte setof solutxons.
Stream lines show how each fluid partlcle ismovingata ngen mstant whereas the path lmes showhowa

given fluid particle is movmg at eaéh instant. -

Py

For steady ﬂow i.e., when %E; =0 then ;7 =V (x, + X2 xs) whxch unphes that stream lmes ao not vary

with time ¢ and coincide with path lines.
s. 14 Types of Motion : :
- Steady Motion : A fluid motion is saud to be steady ifthe condmon at any pomt in the ﬂmd at any nme '

remains the samefor all txme, ie,a ﬂu;q,@gnpni issaid to besteady if

) where p,p,V denotes respectwely densxty. pressme velocxty
Rotational Motion A fluid motnon is saxd tobe rotat:onal xf W v x y # o at every txme and at evexy

point.'

‘Irrotational Motion : A ﬂund motion is saxd to be xrrotatxonal if W : v V ya.t e\?ery pomt andat

evexy time.
5.15 Veloclty Potential When the fluid velocity at time tis V &(v,v,,v,)in Caxtesxans, the equations of the
stream lines at that instant are ' '
oy _dy _dx
v v W
These curves cut the surfaces
 vdn vy tvdy =0
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orthogonally Now suppose thatat the consxdered instant t, wecanfinda scalar function @ (x,,x,, %,,¢),
umform thmughout the entire field of flow and such that
Yty 4ty + vty = -l ()
Then the expxcssxon on the L H.S.of (9) isan exact dlfferenual and

=.s‘z,zs ag- N

Tlus scalar. functxon ¢ is termed as the veIocity patemzal

Here note that, @ (%5 %5, %, t) = constant, rcpxcsents the surfaces of' cqﬁipotcnﬁal;- :

516 Equatlon of Contmulty Let us considera fixed closed surface S, o
enclosmg a volume Vinthe regxon occupxcd by amoving fluid, Tlus region

of ﬂuldcontams nexther sources nor smks ie.,, thetearenomlets oroutlets _»
through which ﬂmdcancnter ofleave the regxon,theamount of ﬂmd within :
the xfegxonxs conserved in accordance with mcpnncxpleofconservatxonof -
o Let beamntoutwardnonnalvectordrawnonthesmﬁoeelement,
é’S whcre ﬂuld velocxty is V and ﬂuxd densxty p

Then the mward normal vclocxty xs (—n 4 ) Mass of the ﬂuxd o
| .mtemgmmssmesu:faceSmmutnmc is .

jp(-n V)dS-- jn (pV)dS jV (pV)dV e (11)
(by Gauss 'sdiv. thcorem)
Themassof the fluid within the volume Vis '
M= J'pdV
4
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0 a dp A
—M=— |pdV = |—dV .
at at J 5t ........... vies (12)

[ p—gt-(dV) = pd(%z] = p:0 = 0.as volumé is constant wirt. ﬁrhe] 7

Now from the concept of conservation of mass which yields the equiation of continuity, we have

J[__w 7)|ev =0

since Vis an arbitrary, therdfore dv # 0 and hence above mtegrand vamshes, ie.,

aap+v (pV) 1 JEPOROOK (13)

. whxch is known as Eulerian equanon of contmuxty
Agam from (1 3)

. a ‘- - - e
—+V .V |p+pV V=0
,.or. (a, )P P
o, P4 7.7 =0 (14)
dt , '
10p = 5
: —D+V. V=0
or, o ot
e _d(log )+v.,y._o .............. «(15).
g \oep

Lagrange’s Method :
T Let (X, X, 2 X3 ) be the mmal posmon of & fluid parncle atfime ¢ = =t w:th volume dV, and densxty Po

Let (x,,x,,%,) bethe posmon of the fluid partlcle afteratime s with wolume av and densxty p. Smce the massof

the fluid element remams unchanged dunng the motion, therefore, -
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podV pav
con,  pydX, dX. 28X, = pdx,dx,dx,

dix,dix, d,
P ibsadd bt hasie B
or, A dedX,dX,

Y VLY N—l)
o J axpxz’xg . . L  . e
Where 6( X: Xz' X) (16) is the required equation of continuty.

Note 1. For incompressiblé fluid, we have%;— =0 Then, from (14), we have

pV ? =0
ie, V.V=0
‘Whichi is the equatxon ofcontmuty incase of i mcompressxble ﬁuxd
Note 217 be the solenoidal vector, then V.V=0 |
~ So, when the fluid is incompressible then the velocity vector is solenoidal vector.
Note 3. If the fluid motion be irrotational and fluid is mcompressxble, then we have N

=0 (for incompressible ﬂmd)
| and 7 = - ¢ (for irrotational motion)
. So, equation of conti.nuity (14), becomes
0+ pﬁ'-(—fw)z
o, V=0 |
. Much is the equation of continuity in tlus case, i.e. theequauon of continuity reduces to Laplace sequation
when the fluid is incompressible and irrotational,

Note 4.1f the motion be symmetrical, then the veloc:ty has only one component, say, v,. Then the equatioxi of
connnmtytakwthefollowmg form: o

| -g-+v 2 p+p-a—v'-==0-
o o, -
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Note . Bquivalence between Eulenan and Lagrangian form ;

sa7

pJ = p, where ,J =

From Lagragian equatxon of continuity, we have ,

d(x,,%,,%,)
a(x,,x,,x)

o, (p )=~—po

o I9LipH o

of, J-‘!-’-’-w.n?-x? =0 ( -”5’-;‘-'./,\“747)

o 221 p7=0

whichis Eulerian equaﬁon of continuity.

Again from Eulerian equation of continuity, ’

A W _)
. . — . - '."—-=JV‘V
or, }dt*PVV 0( a=’V
dp _dJ ‘
J——tp—=
o ’.’dt
d
o dt(p ) ,

= pJ ='Consian;= Pos say

- which is Lagrangian equation of continuity.

Boundary Surface :

Mechanics of Continuous Media

Let P be any arbitrary point on the boundaxy surface F(r,t) =0; let 7 and i the ﬂmd velocity and
veloclty of the surace at P. Now the eontact between the fluid and the surface will be maintained lf the fluid and
surface haVe the same velocity along the nomlal to the surface So, the normal component of ve!ocxty of fluid is

equal to normal component of the velocity of surface,

FUNE 2 T3 p— an
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‘Again, VF isnormal to the surface F(¥,t)=0. chce 7i and VF both are parallel to each other. As
' e VF
iVF l

: therefore from (1 7), we get

% VF
W W
le, VVF i1+ VF s (1‘8)

Let the point P(r f) moves to a pomt Q(r +6F t+5t) in time 5y, Since Q hes on the surface
F(F, t)==0 therefore, '
F(F+6F,1+ Jt) 0

or, F(r.t)+(5i" . VF‘+ ot %E) =0 (byTaylor’s theovem)'

[ S (x+h y+k) f (x,y)+( af+k9.f.)+]

o Oy
. 6r = OF ‘
o 5 VF——E-'—O (- F(r,t)=0)
' -Takmg 51...)0 thenweget
) where i 1$the velocxty of the surface
Agamfrom(m)weget
VF =i “F_---(usmg(w)) ........ 20)
e ,ta'. Y ;
o | =—+V.VIiF=0
Lo, 9F_, (21)

which is the required condition for the surface to be apossible form @f boundarysurface h
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Ifthe surface is rigid surface, then the condition becomes -

V.VF=0 .
Now the normal component of veloclty for the boundary s

Pi=V VF ﬁ (using (20)

5,18 Constitutive Equation : Perfect fluid :
Itis clear that a perfect fluid is characterized by the fact that it is

incapable of exerting arly shearing stress on the adjacent layers in its contact
inresisting the shearmg movement undera very small shearing force Thus,
the stress vector exerted by a perfect fluid must be normal to the surface,
Thls normal stress which is always compressive is knownas pressure
CETM(i=1,23) are the components of the stress vectoractmg o

across a plane whose normal unit vector s 7, and pis the pressure that.
plane, then we have ‘
™ =-pn(i=123)

Also the stress tensor T are glven by

T”—Tnj e e e
T, =T =-pn, —-p5 nj B

o, Ty =P8 23)

These equations are the consutunve equatxpns of perfect fluid.
Tehorem.: The pressure ata pointina perfect ﬂutd has the'same. magnitude in every dtreciton.
Proof Let P be any point in the perfect fluid. Let dSand dS’ be any two arbltrary surface elements passmg

' vthroughl’ withnormals », and n/. Let T\ and 7" be two stresses vectors actmg atP across dS‘ and ds' . Let
T, be stress tensor at P. Let p and p/ be the pressures representing compressive n normal stresses at P across dS’
and ds'. Therefore '
T(n) =-pn, and T"”-- -p', '
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ie., 7;Jn, = —pn, and Tnj = p W (§4)“ :
’ Multxplymg first and second equation of (24) by n and n respectively. then we get
' I;jnjn, = pnn, and Tynin, =~p'n'm, ’ '
But Y;n o =T, n, , (interchanging dummy indices)
| =Tmn, (T, =T, ) |
| -pnn! = ~p'n'n,
o, ( -p' Jnn =0
Since 7, and #/ are arbitrary, therefore
"'p-p’ =0 :
whxch shows that pressure at apoint ofa perfect fluid has the same magmtude inevery « drrectxon s
Note 1. A viscous fluid at rest is also incapable of exerting shear stress. If. Po be the pressure at a point, same in
every direction, then stress tensor , will be grven by
Ty ==pd; _
* when fluid as at rest. This 2y is called hydrostatic préssure v 5 :
Note 2. It should be noted that since the viscous fluid can exert shearmg stress whenitis m motxon, the above
theorem does not remain valid, In fact, the notron of fluid pressure as the compressxve normal stress, i.e., inthe
sense of hydrostatxc pressure may not hold good. Still one can define the pressure pata pointina viscous fluid in

motion as the average normal compressive stress at thé point, i.e.,
P ="’"(7;| + Tzz +Ty) = ""57;:

whxch is also known as mechanical deﬁnitzon of pressure. .
519 Equations ofMotion: S

e Euler’s equation of Motion : From the prmcxple of conservation of linear momentum, we have
already deduced the Cauchy’s first equation of motion of the continuum as |

dv
Yb'j+pF;=p—J;L
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~ where T, is the stress tensor, F, the body force per unit mass, v, the velocity of continuum, and

Also the constitutive equation for perfect ﬂmd is
7;/ = —p5 ,
wherep is the pressure ata point same in all dxrectign. Herice from above two equations weget

(~pé,),, +oF, = o2

dz
on =P, 4, +pF, = dt’ -.
or, ~putpF = i;;
ey f; E“;p«
In vector notation,
~%~F—é%
or %*(;—7%???'%?17 ...... 25)

~ whichis k;mm as Euler’s equation of metion for perfect fluid.
Alternately : Let aclosed surface § enclosing a volume V. ofaperfectfluid |
be moving with the fluid so that S contains the same number of fluid particle
atany time ¢, Considera point P inside S. Let pbe the fluid densxty, y the

fluid velocxty and dV, the eiementary volume enclosing P. Since the

‘mass pdV, remains unchanged throu_ghoutth,emotion sothat ;,;(pdl’.) =0
* Henoe the total momentum M, ofthe volume ¥ is |

M, = [V(pa¥))
no
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M _d e fdP d o]
Ta g ‘?‘i‘.’? J{dt f?d“?*d,(‘”‘f”’s)”]

J ng

Let nbe the unit outward normal veetor on the gwface glement d. Suppose F is the gxtema! fcme per unit mass
-acting on the fluid and p the pressure at any point onthe element S, Then total gwfaga foree is ; p "m'S Ham;e
Athe total forces acting onthe fluidis -

ﬁ' pdV,‘)+Ip(~—n)dS
A
= ;;,[ Fpdy, + ! (~¥p)aw (by Gauss's div.theorem)

= JleP-Tpkr

Now, by Newton’s 2nd law of motion, we have, -
rate of change of momentum = total applied force,

J pdV I pF Vp)

" or ![pil—/--—pF+Vp}dV 0 .
IR { N | _
Since §isan arbitrary and so V] is gs; a!sa@!xd henge dl’. #0ie,

v
p o pf’ P

a7 a1
o0 =Y

Note : Singe V(7 -7) = ‘[“ (9x7)+(7

yﬂ‘

Qz

\id
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S0, equation (25) can be expressed as

where W = ¥/x 7 and this equétion of motion isknownas Lamb Y hydrodynamical eqzéatian'; the chief
,adv,antage bf this eqz)atton is that it is ,invariam under a change gfcavwzdinm system.
i) Lagrange’s equation af motion Let (X,, X3 ) be theinmal go-érdinatcs of g ﬂuid parﬁcle at

’ timer"—o and let this pamcle occupies the posxﬁon (x,.x;,x;) ot timat 'ﬂ;@mhe mlmgncomponcnts ofthis

ﬂuxd mrtxcle attime  are a:? , 66;?, éa:f,“ Conggquéxiﬂy equations Qfmgti@n(zﬁ) reduesto
‘; F:-»=-—~»£(m123) ----- @D

In Lagrangian method (X . ¢ ;.X;,t) axefaur indﬁpﬁl}dﬁm variables s0, we convert the partial derivatives

WLt 'x, (i=),2, 3) into ﬂms@ variables wrt X, (i =1,2,3) as follows;

P ax, ‘“’a,{,; p&x, aX,{

Ox
(mulup ymg 7 by oX, - and sum overi)

L B o o
- 12,3 s
or, (F; alg J ‘ 5X, (k =2 2 ) (28)

More explicitly,

(F. azx,) 1 op
oo é?X‘ péX,
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F..azx!) % _) %
toark )ex, 'pBX, ,
( AL RN
’. ot Jax,;  paX,
| whjchmequationsofm@ﬁﬂnefpg;ﬁetﬂuidin agrangian method. |
8. 26 Q@nvservatwc field of force : lnae@nservanvc field effmce, the work donc byafama F intakinga
unitm. asaimm ‘apointdto apomtB lSlQMﬁﬂthﬂi&p&ﬂM&" : '
JF = [ F-dF=-Q, (say) |

AC’,Z ’ ADB
| H@P@ Qs 8 sealar ﬁmctiog and is known gapmndalﬁmctmn, And
ngeﬁsswgndx ufficient cand ,Vveifﬂmexia&sa
f umfenn dlﬂiﬂmtiabl@ sealar ﬁmﬁ@a Q suchthat f Ng;
521 Bernoulli 's Equation of Motion (Pressure equation):
Whga velocity pgsﬁnﬁa! existsand f@m are conservative and derlvable ﬁcm apetent.ial Q, the equation

of motion can always be mtegrated and the salutlon ig I‘E‘ fég + 5 V4 ﬂ F (t)

The Euler S aquatxon of motionjs '

AV . 1
Ay R v/
a p,p

and equation of continuity is

dp
L pV V=0
a P

We have to make the assumption that pressure pisa fuﬂctlon of density p alone so that I — exists. Let
usmtroduce pressure potennal |
i ,
P= L‘f e 29)

dP 1

—— S ey

dp p

140 , Directorate of Distance Edueation



+oennee. Mechanics of Continuous Media

OP dx,  OP dx, gﬁdx'apd: 1

6 Fdp ‘5;;71; ax, dp '5733"‘5
P oP aP aP

e X+ X, + =X, +-——dt=—-—d
o G i ta, T a; o

::[ax P +§:4: +-é;3—dt, zpdt]
whefe P = P(x,,xz,x3,t),p =p.(x,,x2,x,,t)
Equatmg the coefficients of differntial dx, , we get’

P 1op oP 1op P _13p 13

— e i | s 32 i i e T2 s s —g—_._..

o, p.ox, "ox, pox, & pox, 0t pot

s 1= .
DVP=—=Vp i (30
| p ¢ e O0)
Again when external body forces are conservative, then
F=-VQ

and existence of velocity potential implies the motion -is"‘i‘xrotational and hence

V==V
Henge Euler’s equation becomes

%lt’.,»(y V)7 =-VQ-VP . s B

Taking dot product by dF (=,,fdx, + jdx, + idx,) and noting that df‘ .V = d »then above equation becomes

d(Q+P+1V’ a¢’) 0
2.

141
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whxch is known as Bernoulli's equatton jbr unsteady irrotananal monon Thxs is also known as pressure

equation PO .
Note.l If the ﬂmd is mcompressxble, then p is constant and hence (32) becomes "
Q+p+l N -

2.

y1.92. F(t)
P ot

Note.2. If the fluid motion is steady, then '5? =0 and hence (32) becomes

N d I . . ’
Q+ I_ﬁf-—Vz = F(l) =C= absolute constant,

-
e, Q+fp+ VP <Crin (33)

Thisis known as Bernoulli’s e_quanon for steady motion. ' T
If p =constant, then we have from above '
o+2: e
p 2

Note.3. Equanons (32) and (33) are known as the integral of Euler’s equatxon of motion for unsteady motion
' (urotatlonal) and for steady rotational flow.

5.22 Integrals of Lagrange’s Equations of Motion:
The Lagrange’s equations of motion are, from (28), -

2 .

o aX
and equation of continuity is

851, %,,%,)
P XX X,) .

to determine five unknown quantities. x,,x,,x,, p, o each depending on X, .6 N .Nowweassume
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“thatp isafuneticn of o aloneie., p= f (p) knownas barotropwﬂuid, so that J‘g‘ exnsts We introduce

pressure. pdtentxal Pas

op P o ., &
~ e (X, 4 dt =~ dX, +——dt
o, 3 (ax o )
Whlc__h aXl p X, , 4 ,
When the external body forces are conservative then
F=-VQ |
o F=——=
1.C., ax’

where Q= =Q(x,%,,% ) is scalar potennal function.

~ Henoe, thh the help of above relatxons, the Lagrange s equatxons of motnon takes the form

x, o 6x,' 1dp
7 =K
o 0X, ox, an

BT — 0 —————

Directorate of Distance Education

143



. a_fcontlnmeediaﬁnnou; oooooooooooooo Sreieboeeiiriouesseeirerievrereoeroesesurersesnsl Terensiiine PEPNII I b e i aviibiae

) - |
 where Q=n+P==n+L &£ i (36).

whxch is Iagmnge s equations of thotion for barotropxc fluid in the conservative fluid cf forees.
To obtam the integrel of these equatlons of motion, we eliminate Q from (35)with the heiﬁ oftheidea

o (o). 2
E')F,'kax,)fax(ax,](j’k 123””‘)

o (2, &r) a-(a’x,'ax,)'

e, By, \a:? ax, ) ax,\ o’ ‘ax,
% oo o &, o
Otf an aX a‘x ax where x, ‘é;L,‘x,‘ '-a"t—z-l-
- of & & -a"‘r.a"';o'
o alox, ax, ax, ax,|
‘..ipav,"ax,_.av,.av,-zo -
o F|ax, ax, ax, ax,| = WhereV ==

» ", "&Vi axl__avl ax o
Integrating, ax, aX X, o, = constant=C,

* Initially,ie.,att =0,x = X, x, = X,,x, = X,,v, Vv, =V, =V,

o . & 0 |
. an =1, forz-jand ax, = fornej

oV, 0X, oV, oX,

Co= ox, ox,” ax, aX,
Henwé,wehéve '
O v o OV o OV, g
ax, ax, ox, ax, ox, ' ax, *
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| ”i“ o (f°ff»" =1, 2 3 f # k) st (37)
ax, " ax, e

These are mtegmls of Lagrange ] equation ofmotxon

. 5.23 Cauchy’s Integrals' s ' L  aag,
To obtain Cauchy ] mtegrals we consxder the Lagrange s hydrodynarmcal equatnons ofmotnon B o

o o v o OV, o,

,kal,23 #k
W w, W, w, &, )

. Takingk=2,j=3thenwehave

NN AN X », o, av, ax, N AR
(3, ax, "ax, ‘o, )"\ay, ax, ", ax, )"\, o,
e
aX aX ....k.b..'...k....._..m....' (38)

‘Now,
o oy o ax, ov, o, o av, o, o
- ox, X, X, oX, ox aX2 ™, o, X, oX,

o _om(en By ox o) owfon on 3y ax)
o ax \ox, ax, ax, ax, 0%, (ax, X, ax, ax,

 9(x,%, ) o é!x,,x,

ax, a(xz,x,) ax a(x,,x)

o, o av ax _a__v_ a(x,,x,) av 8(x, %)
‘Similady, - axX, ax, ox, o, &y 3(X,,X,) %, a(xz,x)

dv, ox, Ow ax av 3(x,,x,) _a_v_ a(x,,x,)
ad  3x, &, ox, X, ox, a(x,,x) %, B(X,X,)
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Using above resultsin (38), We get - -

(@.-%JM+( ,

LS’
ply
Y '
|3
EI
=
N

ox, o(X, Xy) (v, a(x,,x,) L 0 )0(X,, X,)
KA D -
ax ax, vsserissessrenrasrenes 69

IfW, W W, be the components of the vomcnty vector W =Vx V and Wo, ,W‘m ) %, betheir mmal values,
then equauon (39) canbe wntten as

a(x,,x,) +W, a(x,-,x.) +W. 6(x,,x,) =W,

1 a(Xz,X3) g 2 a(Xz’XJ) 3 a(Xz,X ) '''''''''''''' I-.-‘n;u (40)
. Similaﬂy frdm other two equations (37), we get
| atxi;x,) o a(x,,x,)v - o(x,,x,) |
W, W, + W, —= =W,
] a(X;,X") + 2 a_(X:,X,) 3 a(X:,Xl) 02 -oo-.c.ttt'.'oomOootfo (41)
Co(rx) o 0(xn) . (xi) - |
W W. W, =W,
and a(X"X )+ za(X‘,Xz) sa(X.,Xz) O3 ecersecreecrtsracennsssone (42)

ox, v, ox,
. Multxplymg (40), 41), (42) by == 53'(" respecuvelyandaddmgwe get »

: ;'a(x,‘,x,,jrg,)' " "a(x,,x,,:‘c,)- Y a("v"nxs) ax, o g %
- - -W, A +W, =W, +W +W,
X X)X X)X k) T e, e,

o a o O (. O(xxx)
% Tl Thax, T%ax, e T T a(X, Xy, X))
W W, ox ozaxl‘ 03.@.‘.!.
Bl ianirevads fsieryads fusrast B 43
% p . P OX, py OX; py OX, “3)

146 » _ Directorate of Distance Education



= . . - M - )
N . . . L] k) f
vveesrenresrnsnens P OSSP PP PO Mechanics of Continuous Media

Simxlarly multiplying (40, (41), (42)b %‘L %" respectxvely‘and ’gﬁ' %L g" respectively -
theﬂ addmg in each case we get
Wy Wobn Wby Wodu
ey o aX, oy B, (44)
and E’; %Lg;( pZ:’ aa)z ‘ /,:"éa;,’l (45)

The equatlons (43), (44) and (45) are called Cauchy (] mtegrals of Lagrange s equanon of motion expressed .

-entirely in terms of vomcnty The vector fonn of these equations s -

W _(Wy 0 o 0 Wy O ]? 7=.x.i+'x,j-+;;
P\ P 5X Po aXz po aX; R J
, i]w v)
1.e.., p \P )

* Note.1. Permanence of irrotational motion: : - ; o ,
Ifthemotion of the fluid is mmally irrotational, then W,,I Wy =Wy, =0, It»follbws from (43), (44), (45)that

W =W,= W Oatanytlmet .
Hence the motion of the fluid, once motatxonal is always irrotational, provxdes the extemal forces are

conservanve and pressurepis a funcnon of densuy P alone

" Note.2. Helmholtz 5 _voriicity equation from Cauchy's Integfdl 8
Diff. (43) w.rt. time ¢ '

d(W) Wudfom| Wyd _6_15,_ Wo df
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r _fi(f';")=%1 av, +Woz dv Wo: d"l S—cl))

T T A py dXz Py Ay
W o W, v W,
-‘-.-L.-J-.g.....l.._.L.‘.__l___L
e [ A B AR 0 m.._@s;.)
.j_po ox, oX, ' Ox, ax,  ox, oX, | p°; w‘ax' .axz aX o ax,
ol 2,0 )
po ax' ’aXJ &2 aX, &3 ax,
Won W v Wow Wy on Woydv Wy | »'.(47)
P &| P axz P &‘1 . Po aX’ Po aYZ P ax, seeesesesene

' Ftom (46)and (47), we'g gt
d __ni Wowm Woom W . .
dt pax pox pox| SR,
W) Wow Won Wov| g e
NP P PO P i @)
a,‘,d‘i!’; .'_’12!;. mom, Wsavs e
dr\ p ar p ox, ,ax J'

- wlﬁchare equivalent to single vector equatxon -
| i(.'.’".)-:(.’K.va .
da\p) \p )
o d(w o
' B w.v V
% pd’( ) ( ) L
" Tlusxslmbwnas Helmholtz voi'ticity equation for perfect fluid.
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' 5,24 Unitsmmary. DR ~ L
ln this module we have discussed dsfferent methods to understand the behavxout ofthe perfect ﬂuld :ts

- motion, its xmegal of equation of motion etc

525 Worked Out Examplea
Ex.1, Find the stmzm lines and paths of the pamcle jbr the

) Velocity feld ==,—.~L;,_vz v;w;,ﬁ;:{;? s

A

I’ .

) Vélacipaﬁeld W= e Yy = x,,v, = 0 |
An& To determine the strcam lines, wehave the dxﬁ‘erenual equatxon ata given mstant of txme tas .
dy _de dx o Sen

v ;"3 ‘

Sy _dg dy
iﬁ,:, x[ vxa' ‘0
B TR

From Id ratxo, dx, = 0 = abc, = consant =a
* and from 1stand 2nd ratias we get

(et
= (1+1)log, x, =log, , +log,b b bemgconstant
= x.('*”. =bx, o -
5 Henﬁe x(' =bxy, %, =a represenuhe eqpaﬁon of the streamlmes
- To detemxlne path lines we have the solutions ot‘the differential equatzons

dx dx. dx. '
--J. BV,
dt iy ‘v,, at D

‘Ihis:.:athat dr l+t l+t |

e log,x = log, (l+t)+log, ¢ cbemgoonstant
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= x =c(l+¢)
, .f‘_‘ﬁ;xz=>-4-x-3-¥dt=vazlog,x‘,a’t+ldg,d :
dt - X ,, _
S x,,‘=de'

o |
~ and -5;1=O=>x,aconstam-p,say:
- (.L-l), |
o Hencex =de\’ 'xy=p representﬁxeequatiomofpaxhlixw
C#) - 'lhestream lmesareglven bythedxﬁ'emual equation

X, ox 0
146

~ From 3rd ratio we get x, = constant = ¢ , say
and from lst, 2nd ratios we get

dx dx.
(I.H)x, -;2;’-

A 1 1
or, (1‘” )—“—'-"z» ¢; being constant,
X, X.

: Hencetliestremniinesarcgivenby (l+t’)—l---l-==c, Xy =0,

, X, X%
' Ihe;’aéthline‘saye given by
.. &' xz l ‘.‘l '
el § ----——=> —x, = t
P
a T ox

dx.

where ¢,,¢,; ¢, are constants. Elimkmﬁ@gifrom above three relations we get
~ R DR
o tan| ¢y —— [=Cy =, X, =C
( 3 x‘]. 4 xz 3 H
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which is the equation of the path line.

- Ex.2. [/' the velocity of an incompressible _ﬂwd at the point (x, 2 z) is given by (3xz , 3):2 , 32" :r ) prove
r r

. that the quuzd motion is passible and the velocity potential is cosa . Also determine the stream lines.
r ,

| Ans. If (u, v, w) be the vclocxty components then

3xz 3 322 -r? ~
U=y =—g,v=h *—;};—z-,w V= where 7 = x? + y*+ 2%,

au +-a—v-+?—w—-0 for

Now the liquid motion is to be possible if it satisfies the equation of continuity; i.e. — % oy

incompressible fluid,

=0 .
which implies that the liquid motion is possnble
" Let ¢ bethe velocity potential. Then

dwa—gdx+;¢”@+a¢dz= —udkt = vdy - wdz
) —--3—[3xzcb:+3yzay+(32 -r')dz)
= —-—[3z(xdx +ydy+ zdz)-— ]

- H{%ar)-ra)

r
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3: dz

| merdr+—
ot

.J(-f,-).,

Int. fp-— ,omxtmgoonstam }~ :

-rcosascoso .
. N G :
B Agam streamlmes are glven bythesoluuons of
'»:u'v ,w,” o

& _dy_ d e xdv+ydyvads

or, 3xz T Tz(xKyed)-r

~ Fromlstandanratxos,weget .
7-‘5"-—+-‘32’--.-:>x=‘c,'y,c, isconstant,
. Xy | o
From Istand 4th ratios, we get ,
.28 xdx+ydy+zdz d( ) _
- 27 ‘-"-»,4(’ o
:4io'g','x=3’log,r +loge,

. . . 3 L 4»
X =cpt=cy (s +y +2)

* Hence x=c,3,x* =, '(x’ +yl+ 2 )"-mpmentthe_'eﬁﬁgﬁcns’df streamlines 8

Ex.3. Show that u =~ 22 ,v-( 4 ) W= b4 = are the velocity.components of a possible

(x’-o-y’)2 (x +y ) ’.xz"')" A

tiguid motion, Is this motion irrotational?

Ans. To show that the motlon is possible, we have to show that the equatxon of C(mtmmty g:- %zw- =0is.

*%’l%’

satisfied.
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Henoe the liquid motion is possxble .
Agam fluid motion to be irrotational ifTxf = 0

u_ v o w_, ow_ou _

5 a2 % e
2 ) Bl )

i.e., 1f

oz (F+)) (¥ #57)
w ou_ 2y 2y
& o (F4y) (+r)

whxch shows that the motion is irrotational.

‘ 1_,2 .
'Ex.4. For the veloc:ty field v, = 3= = L, = :i:clxz r, ‘

—

. where

| ov, 3x (37 -5r'x 3x (r*=$ |
A@.Nowafz_;%(r rx)%‘i‘ ;%(r x ),‘
9_&,_33;:(" -5x3r)
ox, r" ’

Directorate of Distance Education
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ﬂ+%+%=%[5r "5" (x: +x; +x, ] _:‘EL[S" *”5"]
2 3 . » .

1 r

[

==3-0=0,

~
-

* Since gx‘i %_; + {Z—} = 0, 50 the equation of continuity s satisfied and hence liquid motion is possible.
. | 1 2 3. ‘ .

i 'Iheﬂhidmpﬁqnissaidto.béi:fotaﬁonalif VxV =0,

O v v v v ow
le 1f-.._.3_......l. O’n-.-l. -.-le,--L--—J—-__-;_O.
axz ax’ &3 &l &l 2

Ox.
e v v, SV (L 5)% O
| Now,s—x?-—a—*-ﬂx.{;( —;—J - 3‘»*‘:("‘?)"‘ 'Whmf—g,r étc

N \NrJr s N oy
= 13a%% 15 x5%x, |
r o ‘
=0

Y v, By, .,
S.itmlad. o 0 and o » 0

| Hence VxV =0, ’Iheteforetheﬂmdmotionis imtatxgnal
i) 'Ihestmamlmesmthe m!uuons of the differential equaﬁon

& dx dx

v ooy V:
o, - dx, - dx, 4&’3 = xndﬁl*lzd?z + Xyl
R BT P Sx,x, N X, (Srga—'r’)’
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From 2nd and 3rd ratios we get -

dn
X X

= X, = ¢,X;, ¢, beingconstant,
Again from 4th and 5th ratios, we get
x,dzq + x,abc, +xydy, x,dx; + xydx; .
2P 3(x3 +x3)

o d(+xirx) d(+xd)
‘. o1, 2(x,2+x22+x;) 3(x2 &xs)

ot %log.(xf +'x§¥x,’)=‘%wg.(x§‘+x§)+%logc,, ¢, being constant,

o (s +ai+sl) =a(d+d)

Hence the stream lines are the intetsecmn ef thﬁ Surfaces. (x, + xg +x; ) = c, (x2 ) by the plane

¥ =% whichpassing trough O%.
Let ¢ bethe velocity potential, Then we have
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=9 =§§' =,‘(‘"‘2.—"";x‘l"""’?f, omiting constant,

. which is the required velocity potcntm!

- Ex.5. Given v, = WV = WK, Yy = 0; show that the smy&ms lntersegtlng the stream llmg orthogonally
' “ exist and are the planes through z-axis, althaugh the velocity polsmlal does not exist,
- Ans. I‘:k)wg:l | ;‘;Oand%:«no | |

S o issatisfied md‘heneéﬂwﬂuiﬁmﬁ@n I8 possible,
Con A an
* “Toshow that the surfaces orthcsgonal t0 sa'eam lines ate plams thxgugh F-axis,

" The requu'ed surfaces are solutions of

) _‘v,aﬁr +v,dx;+v,dx,==s0
: or, .wwxzcﬁq»«!—wx:,d;; +0dx, =0 |

| ‘Or, % ”%’“0
) '_Ini;; X mcxz, ¢ being constant,

- which is a plane through z-axis,

To show that veloci typmentia! ;o does not gxist. ;

‘Now, dg)a-gdx, i 2 ax, +*-£;ix;
| '*".("sd’-‘;’*"’zdxz*“’;‘i‘;)

= wxydx, = wx,d,

: 1:56" , : B Directorate of Dlstance,\Eduégﬂqn :
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$sesesdades sibiddise ey sdbeddibsicacer Oii‘ 5‘& vissrinsisetebaddesibbedvcieoiiig

" aM a
Hem &, w. ax“’ w

.M aN
r 6x. | |
whxch implies that the above dnﬁ‘erential equaﬁon xs notexactandhence d¢ wxza!x wx,dx, cannotbe
’ mtegratedsothawdoesnotexxst Sl e ,:
Ex.6. Show that ln the motion of a ﬂuid in two dimensians {/ the current co-ordinates (x,, x,) are expressible
in terms of lnitial co-ordinates (X 10X, ) and the rime. then the motion is lrrotal:onal if
_ a(x,,x,) . a(x,,x,) | |
‘ 6(X,,X,) a(x,,x,) ‘ v
An& Let v,,v2 bethe velocnty components parallel to theaxes of X and Jnr2 reSpectxvely Then we have RONS
g x‘—V,, xz""vZ . ) . ‘ ’ e v
md' ov 1o By +2ﬁ.?_ﬁ.,
ax, ax aX ax, ox,
‘9"1 a"f o on By
| aVz av, &, év_; ..%. "
"a_Xx_. a"l aXI "a‘z ox, _
oy o oy om By
;ax o ax, Yo, X, o .
. a(x,,x,) . a(x,.x,)' 6(v,',xk,b)" 6(9,’,‘::,) S
°“”a(x,.x,) a(X,,X,) a(x,,x,) a(x,,x,)

v, o | o] eE R
_|ex,  ax, +6X, ) (a" o _ v o )...(a"z o o .‘a“z) o

o On| 0% Ox| \OX GX, Tax, ax,) \ax, X, oX, &) .

oX, ax, aXI aX! : Co e :
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- ie. ;ﬁ’ motxon is irrotational.

Ex. 7 Give examples of trrotational and rotananal ﬂows
Ans, Consider the fluid motion given by '

v =k, v, =0,v; =0,(k=0)

'Ihml?::kx,? A
_ 7 k| |7 7 k ‘
= = |0 9 @ 0 0 0| 2, %n. mn =
So, VxV=|— — —l=|— — =7.0-7.0+k0=0
o ox, om| |ow ax, on| o JOrkO
17 N kx, ¢ 0

= Fluxdmotxon is m'otatxonal 4 .
| Agmnconsxderanothertypeof fluid motxon whxch isgiven by v =ax,,v, =0,v, =0, (a an)

VXV = —ak #0
Hence the motion is rotational.

Ex 8 The yeIocxty components for atwo dtmenszonal ﬂuidwem can be gven in the Eulerian system by
=2x, +2x2 +3t Vs =x, +x, +£~,

"Findthe dnsplaoement ofa ﬂmd partxcle inthe Lagmngxan system,
Ans, Let (X .,X ) be the initial co-ordinates of the fluid particle which takes the position (x,,x,) after
time 1. .
'158 ‘ Directorate of Distance Education
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Now v, =-f‘9§!-=2xl +2x, +3¢

d N
K
which can be written as
(;;{- - 2) %225 =3 ie, (D=2)%-25 23 .
. md (‘;‘-.’ l)xz - x] = % l'e°’ (D- l)xz —x‘ =}§ u{"ou‘"ﬁnu
where D= _d_
S at

Operating'(ii) by D-2, then we get
(D-2)(D~1)x,~(D-2)x, = %(D-;- ) TS

. . ) : l .
or, - (D*~3D+2)x,-2x, -3 =5 -1 [using ()]

or, (D’,-—BD)J:z =-21-.+'2t

«(ii)

which isa 2nd order linear differential equation whose auxiliary equationis |

m -3m=0
sm=3,0.

Now PI
i1[. b D g
= | 14 b e -2
3D_1+3+ 5 + ](2+ )
171 2 '
= e =
3D[2 3 2’]

Directarate of Distance Education
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=—-—!—-[Z+2[
- 3DL6
=--l-[-7-t+t’}
6 .
Hence general solution of (ii) is
=¢ + ==l =l viereerenrovions .
‘ c’e‘- 3(6 ) e @)
L T ~1(7 ) E
2 =3ce —=| =2
S gnd 7 €€ 3,6 .......... s ..‘.(v)‘
‘. 'Usmg(xv)and(v)m(n)weget o '
&, ¢ 7 7.8 .
X = __‘};L_xz__.z_..,_c‘*.zcze ~i.§--9-t -5-‘#..’...7....,,..-0-...(‘41)

. Initially, t“==0,x, x,,x, X, menﬁom(xv)and(v:)weget“ b

X, = +2cz 1-;

and X, =c +c2
Solvmg above two equatxons, we get |

’andcz ( 2+/4).

(X m )+_ -'(X'+X? +27]e 2793

1 -,
’ X, =§(2X2~X‘)+-ﬁm+s4 e '
which are the requiired displacement of the f fluid particle in the ugxangxansystm -
o -k(xletz) .
Ex.9. Test whether the motion specified by ¥ = At (k constam) is a possible motion for a&z
160 ' Direetorwe:ofDiSranceﬁEducaﬁbw
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inc‘ompressible ﬂuid If so, a'etermme the equanons of stream Imes Also Iet whether the motion is of the

potential kmd and if determine the velocuy potentzal

Ans. Since 7 =k Lx‘-;:f%l therefore
. . ‘ v x’, +.x‘;

o, v, oV, 2k %%, 2k’xx o
AP L W 1% %2 1.0=0
o & O (! +xz) (xf-f-x})z

".

So, equatxon ofcontmmty for incompressible fluid is satisfied and hence the ngen velocxty isthe possxble fluid

motion. .
Stream lines are given by
S L2 2 ;
x,,+x,dx x; ‘“‘zdx dyy
of, 7 2
’ kaz’ 4 kxl O

doy _dy 2l a_.

=> from first two ratios, -y "z =% +x, = c,
. : [

" and from 3rd ratio, ‘dx, 0= x, = Constant =0,
Hence the stream lines are circle whose centres lie on x, -axis.
Let ¢ bethie velocity potential. Then

. 0@ op op
- de=—tdx, + ——dx, + — dx
_agp 0x,g' o, 2 6x3_ 3,

= “Vnd"vv" vydx; - Vad-"Q

_I?
=_{ k' dx,+l‘—’fi~ }(nv,—o)

2 2
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e osde ] o
=k 2 B (M + Nae,
'[x,’+x§ 'x,’+x§]‘ (b ,‘,)',s.ay’ :

-X,
where M = —--—3—-andN~ 3
xt +x? x X

aM = . 1 xz ("'2xz) “xz
ox, xlz'”‘z (x -Hc,)2 (x, -l-xz)2 ’

Now

oN_ | 1 N %(-2x) [ x-x?
o, X! +x; (x +xz) (x,2 -0'-~xzz)2
i.e.,. g—w—[-zé-{-v—
R ™

i.e., Mdx, + Ndx, isan e’xab’t. So, the solution of itis givenby

'+c,
x, -r-x2

=k*tan™ (ﬁ-)+ ¢
Ax )

Hence the velocity potential is @ = k? tan™ ( -3-‘-) , Omiting constant.
2 : )

=

, x? y’ 2 ‘ ' '
Ex.10. Show that the variable ellipsoid ;3’;;7:*’“ ? 'b—z"'";i' =ljsa possible form for the boundary

surface of a liquid at any time t.

Ans. Let F(x,y,z,t)- kzt +kt? [b; +§;]~ =0 e, (i) |
- Now, the surface F = 0 to be a possible form of boundary surface, if
E _por+2 g
(S ot
i, y XL OE L AE OF (o (i)

dx oy dz Ot
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---------- AR T Ry Ry N e Y Ry Y N I )

, " 2x 2xY 2k , yY 2k z :
ie, lf.i;k—t—(u“ )+ B t y(v+7)+-;§~r’z(w+7)=ﬂoﬁ
Hence (u) is satisfied 1fwetake S

u--——=0 v+2ﬁ0 w+--0
¢ 4 ¢

> )/
1 M f -~ J— o= - =_.Z
ie,ifu Y "W /

It will be ajustified step if the equation ofcontxnmty PHe R

A Hence (1) is a possible form of boundary surféce. .

Ex.11. Show that - tan t+2 cot t-1=0isa possxble jbrm of boundar:y swﬁzce and find an expression

Jor normal_veloczty.

X 2
Ans. I,et F-———-tan H'%-COt (- 1 O ............ ' ....(i)

~ Now, the surface F=0to be a possxble form of boundary surface 1f v

aF o e,%+V VF =0 |

at

ie,if ymmgv—tw—t—=
) dy dz 6
2x, , xsectt) 2y 7 ycoscc’t B
e if—tan’t| u+—— |+ == cot?t| y = |=0 - s
ie.,if pe ( tant bz Cotr ) e weeene (11)
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Thus (u) will be satxsﬁed nf we take

u+xsec t O‘and v;_ycosec t -0
' -7 cott . :

e x :
ie., 1f!l=".' - V= 0
- sintcost. smtcost

* This wxll bea Jusuﬁable stepifthe equat:on ofconunmtynamely %+%+ %‘:—- =0 issau ﬁed
ou ov ow | S

K ———= +0=0
N°"”ax o oz sinfcos? sintcost

Hence the given surfaceisa possible form of boundary gqrfab:.'

A
ot

T

2 2 . . ‘ 2 . \
(-axT tanfsec’t - 2y cot#Co sec? t)

The normal velocnty

bz

) G

b tanssect —a’y? cot#Cosec’ t

"

(IJ‘Jc2 tan*r+a'y® cot' ¢
Ex. 12 Show that all necessary and sufficient conditibn can be 3ari§f ed by a F{'elbc"it‘y ﬁbfehtial of the form
@ =ax’ + By +yz* and the bounding surface of the form F =ax' +by* ¥cz* = X (t) 0, where X (¢) is

a given ﬁmctzon of time and a, B,y,a,b,c. smtable funcaons of the time

Ans. Let F=ax'+by' +cz* =X (1)=0 s (i)
, and  @=ax? + Byt + 7z riveernnensins (i)
To prove that ¢ satisfiesall the necessary condmon ie., equatxon of continuity
“ie, Vip=0 |
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, az¢ al¢ aZ¢
or, +6y’ =
o, 2a+28+2y=0 |
R 2 R J— reeenns (i)
The velocity potential @ has to satisfy thiscondition. .

To prove F = ( satisfies the condxtxon of bounda:y Surface-.i R

0;‘

~ Therefore, u = -2ax,v= -2ﬁy,w = —27: ;
For the condition of boundary surface we have %E- =0,

. i.e-.,' éf‘--)- ?-F-'- : -a£-+§£ 0

:-_ax oy 6z ot . , : , L
i.e.,' -2ax- 4ax Zﬂy 4by =27 4cz +x a'+ y‘b'+z X"'(t:)-‘-=0 |
ik, (a'-8aa)+ ('~ 85B) + 24 (¢ -8er) - X () =0 o BV)
Smce (i)and (w) both have to hold forall points (x, y,2)on the surface and hence they should be identical,
Compairing; we get froovm e
a'-8aa _b'-868 ¢ '8¢y _ X'(t)

. a b. - c X(I)
Fromls_tand dthratios . - . '
'g.g..saa -—_a..g-
da X a
' d dX
or, —5=8¢zdt_-l--‘—1;

Int, log,a=log, X +8fadr
Similarly, log, b=log, X +8 [par
and log,c=log, X +8 Iydt |
~suchthata+f+y =0
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The surface F=0 will have to satisfy these éonditions for the pos.éible form of boundaxy surface,

 Ex.13. Determlne the restriction on f, ,fz.f, »f = f (I )+ X f; (1)+ o j; (1) ==1 ls a pomble Jormi of
'boundary swﬁce ofa liquid . | '
Ans, Let F--—-—f ()+% . (t)+ > fS(t) 1=o e S
For boundary surface qust satxsﬁes the equatxon
OF OF ©oF oF

—t Yt Ve f W = )

o avaay waz

e, = Z e 2f2 zf,+u 2f+v f,+w 2f,=o

f( i f=(v+y£J f=(w+’f{)*=?

Ifwetake u+7fl =0, v+J’f "o w+ff -0 thenaboveequauomssausﬁed Nowtluswllbe;ustiﬁable

! ) ; 2 : 3
stepﬁ&be values uvw satxsfy the equation of contmmty, ie.

p
.So, we have [ f fz j;]

. df df2 df, _

i.e., I fz +j;

Int,, log, A (t) f,(l) j;(t) log, ¢, ¢ beingconstant.
| e £i(0) /30 A(')-

S.26 Self Assessment Questions:
1. Show that the following motions are possnble for an mcompressxble fluid:

) v=cox,v, =cox,w=-2cx;;
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i) w=—v=—Fw=cz

.where r* = x +x] + x; and c s constant.

Find the stream lines when v, = ax,, v, =~ax;,w = ¢, aand care constants.
The velocity fieldata pomt is gwen by V= ( 2 X3, 0) Fmd the path lines and stream lines.

Foratwo dimensional flow the velocities ata pomt ina ﬂuxd  may be expressed in the Eulenan co-ordmates

by v; =x, +x,+2t and v, =2x, +1. Detzrrmne the Lagrange co-ordinates as functions of initial positions

X, and X2 and the time £, :
If Vis the resultant velocity at any pomt of' a fluid whichis movmg irrotationally in two dimensions; prove that

oV ov.
— |+ VV2
(&) (-
Piove thata surface of the form ax' + bx, +ox - X (£)=0isa possxble form of boundary surface ofa

homogeneous liquid at time t, the veloc:ty potentlal of the lxquxd motxon bemg

p=(B-7)xl+(r-a)x] +(a ,6')x3 where X,&, B,y axegnven functlonsoftxmetandr b, c are

| su;table ﬁmcuons oftime.

N o 2 o2) . : '
Show that the ellipsoid '—z‘,;!z';i‘? + (7:}’- + ‘;,Az' k" =1 js a possible form of boundary surface.

In the steady motion of homogeneous liquidifthe surfaces f =a,, j; =a, definethe stream lines, p rove that

the most general valuesof the velocity components v, vy, V; are

wzzf:f:; runifelh el

Show that 2L z (p (t) ey ( y =1isa possnble form of boundary surface of a liquid.

Show thatp = (x, —)(x, - t) represents the possible velocity potential of an incompressible fluid. Find the
stream lines and path lines.
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11, Detcxminethe’oonstahts 1, H,y inorder that liquid moﬁonispossiblewhenvelo,city componentsat (%)%, xs)

are

v = n+dr o x+ur X, +yr

, r(x + ,\)g)’z = r(x +,.) ) r(xl r)

wherer --xl + x, +x,

5.27 Further Suggested Readings' o
1. Continuum Mechanics: T.J; Chung, Prentxce-Hall
2. Schaum’s Outlineof Theory and Problemi of Continuum Mechanics: GedrgeR Mase, McGraw-HiH
3. Continuum Mechamcs AJM. Spencer, Longman, ST orh ~ :
4. Mathematical Theory of Continuum Mechanics: R.N. Chatterjee, Narosa Pubhshing House.
5. Foundation of Fluid Mechanics: S. W, Yuan, Prentice-Hall.
6.  Fluid Dynamics: J.K. Goyal, K.P. Gupta, Pragati Prakashan,” v R
7 Textbook of Fluid Dynamxcs F. Chorlton, CBS Publishers and Dnstnbutors o :
8 Theoxy of Elasncxty Yu Amenzade, Mir Publxshers, Moscow ‘ S
9 Applxcd E astxcxty c T Wang, McGraw-Hxll o
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6.21 Complcx potential fcradoublet
622 lmage - SN
6.23  Imageofasource w.rt, astraightline
6.24  Imageofadoublet w.rt. a plane :
6.25 . Imageofasourceina circle
6. 2§ Image of a doublet to a circle
6.27 Milne-Thomson'’s Circle théorem
628  Application of a circle theorem-
629  UnitSummary - -
6.30 - Worked Out Ex@ples |
631 Self Assessment Questions
632 Further Suggested Readings

| 6.1 . Introduction:
This the continuation of the Madule No. 53 Here we discuss remaining p@mcn g&h@ perfect ﬂuxd To
understand about the motion et’perfect ﬂmd gxis pg;t is essential, : : .

6.2  Objectives:

In this module, the students will leam the techmqug and methods for vgrﬁgity veetor, impulsive motion,
flow, cncul@n@n, energy theory, t\w-dunensxongl motion, stream function, cemplex potential, sources, sinks, doublet,
image, circle-theorem etc. - C

63  KeyWords:

Vorticity vector, vortex hne, vortex tube, Beltranic vggggg Impulsive motion, gqggggng for impujgivg g@ﬁgﬂ,
flow, circulation, Kelvin’s circulation theorem, energy equggnon, ;mmmum energy theorem, uniqueness theorem,
motion in 2D, stream function, complex potent;@lg Qauchy—&;gmam equation, sources, sinks, Mngth, d@ublet,
strength of doublet, circle theorem.

6.4  The Vorticity Vector
~ Now we consider thg flows for which curl 7 is neg—gggg 8, V ” p # G Then the vector
W=VxV
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is called the vorticity vector.
Th@maﬂxemaucian Lamb, Mxlne-’rhompson, Rutharford, Goldsteinew followthc definition ¥
1= . _
, whee as Birkhoff, Robertsen etc, follow the deﬁntion W= 2 Vx7,

LetW (4,17.9’) §i sn]+¢E then

Itis clearthat non-zero verticity vector exist for rotational fluid motion and for mtatxonal fluid moti -
must have Vx 175:6 ie W=0. Hgme one can gl@ﬁnsé a ﬂuigi motion is irrotational if W=G
=0, '780, ¢=0 othsrwiseroteti@nal | o S

6.5 Vortcx line:
‘Vortex line isacurve such that tangent at each point gf itat ar;y nstay
| vector at that point, It means that /¥ is parallel to df,ng |

1t Qfmg isin the direction of wu: ii-.,:t.. J

which are the differential équations of 8 vortex lines. In general vortex lines do not coincide with the stream five-
6.6  Vortex tube: : _

The vortex lines drawn through g@shp@mtofas!gsed curve eagloseatubular
voxtex tube ' : -

e inthe fluid it:..
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A vortex tube innﬁnitesimal eross 5@@&9:1 iscalleda vgrmxﬁlamgnt or vortex simply.
The value of ]k‘ﬁ’f ds isgalled the strsngtk of the Vortex tube, A vortex tube whose m:xgtb isunity i is

-called a unit vortex tube Since :
;ﬁ WdS = IV-W’dV uQ

so, the total s&rength of vortex tubes emerging from §is eggal to that entering 8, This meam mat vortex lmes and
tubescan not grigmgt@ or t@munate at internal points ina fluid, They can @nly form sl@;@d curves or terminate on

boundaﬁ@s! Lo
‘In case of smoke rings, the vortex lmeg form closed gurvgs @n th@ gthgx hand, the vcrtex linesina

whirlpool Jgrminate on the boundary of theﬂyid
Ifthe fluid motion I7 is parallel to /7 then the fluid m@tlgn is said t@ be ﬁeltmnmﬂew, In this case

Vxi =0 @nd V iscalled Bgltranic Vég;gr, N

Exl. The velaczty veetor in theﬂawmlg’ Is glvelft by V=1 (dz- Ey) + ] (5x -Cs)+ I? (Qy Ax) wkm |
4, B, C gre nan-zero constans, &gtermine the @quaﬁans aof the vartex lines. :
Ans. Let W =£7 +nj +¢ be the vortieity vestor = §x 7,

. F ] 9 oE

W= = _— = -C+2A
3 % 21 j+£
|[Az-By Bx-Cz Cy- Ax|

=¢=2C,n=24,{=28
- Hence yortex lines are givenby

- ke, 56’52—'2'5

& A _d
€ 4 a
From Istand 2nd ratios, wehave -
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Adyx = Cdy =» A‘xe-(_;’y,é C‘, W@y
* From2nd and 3rd ratios, we have |
 Bdys= Adz=> BymAmC, e (ii)
Hence the vortex lines are gwen by the equations (i) and (i) tagether

Ex.Z. If veIocity distrlbun’an is V=i (Ax’yr)+ J (By zt)+ k (Czt’) where A B, C are canstants, 'henf

find accelemlian and vorticity componems. o
Ans, LetVaui+vj+wk Then u = Ax? ", vaBy 2t, w=Czt2
, If a, dy, a; be the components of the acceleraﬁon i Then ,

du’ ,a‘u ) )
a a:-jt-{ 52 e 3 +(u--+v-—5+w§]

= Ax’y +(Ax’yt)(2Axyt)+(By zt)(Ax’ ) (Czr’.).o .
= Ax’ y[1+ 2 Axpt* + Byat a0 |

& v (8. 08 3)
a,:;;— =‘é-t-+(u5x~+vafwéz)v - o
-~ =By z+"(Ax yt)(O)-!—(_By zt)(2By2t)+(‘Czt?)(By’t) ‘
= By'z[1+2Byat* +CF'] -

. .~.éw_+(u.e+v.@_+wﬁ)w.

dt ot & o Oz
C 22ca+ (4w pr)(0)+(Byx)(0)+ (o) (cr),
- =ca[2+cr] |
Let &, n, ;‘ be the components of the vorticity vector W. Then
& |
-gz- = —Byzt;" -AxMk

S

L}

<}

X

<

il
L R~
Q’ o <

Ayt By'at Czt2

nE==Bylt,n=0,¢ =~Ax’t.
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6.7  Impulsive Motion. :
Suppose sudden velocity changes are produced at the boundanes ofan incompressible ﬂu;d orthat impulsive

 forces are applied to its interior. Then the dxsturbances produced in both cases are propagated mstantaneously
thmughout the fluid.

- 6.8 Equations for lmpulsive Action' - N
Let us con31der an arbltrary closed surface S movmg wnth a -

non-viscous fluid such thatitenclose a volum ¢ ° V. Let y and p bethe
fluid velocity at P within S just before the xmpulse and j Just aﬁer the
impulse. Let o be the fluid density at P, Suppose is the external |
Axmpuse perunitmassand ) the lmpulsxve pressure onasurface element
dS. Also let 7 be the unit outward normal vector, Now, impulse on the
volumeelement dVis pdV and that on dS is -iiwdS Hence total 1
impulse applied to the fluid parhcle is -

[T pav+ f( (~AiwdS ) = [T pav - ]’WdV = I(p}iv—, W)JV
v S : 14

(by Gauss theorem)

The total change of momentum is I P (V V) dV

Hence from, change of momentum = total 1mpulsxve force, weget
jp(V' V)dv = (oI -Vw)dv
v
J'[p(ﬁ'-ﬁ)-piﬁm]sto .
Since Visan arbitrarily small volume, ourusual assumptxon of ﬂmd contmulty ylelds the result

p(V'-V - p1+Vw) 0

or, V'-V=T-—Vw w (D

1
_ P
at each point P of the ﬂmd Thisisthe requxred equatxon for 1mpulswe action.
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If7 = (IIJ,,Iy,Iz ), V'=(u,v, w),.l7 = (uo,vo‘,wo)» then the cartesian equivalent of (1) is

Deduction (I) Vorticity in a non-viscous incompressible fluid is never generated by impulses if the external

 forces are conservative. R
Proof.: External impulsgs are consetva}iy}jeﬁ impliesthat . .
_ _ I=-VQ ‘
and for incompressible we have o = constant. So, from (1), we get

'17'-I7=-€7(Q+33) |

-

or, Vx(7'-7)=0 (. curl(grad)=0)
o, UxV'=VxV
oo, W'=W
. Hence the result.
. Provethat vy =0 under suitable conditions.

Proof.  Let the external impulse be absent so that J = §.

Also, let p be constant. Then from (1), we get

« - ()]
V'+V.

o, V

ie. V=0

Directorate of Distance Education
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When §.7" = 0= V.7 Le. whenthe fluid isincompressible.
Note: Ifthemotionis irrotafional, then '
P=Vp, 7=V’
So, from (1) we get
—?¢+§§=~§{g}ﬁwiéﬁt
i P
o, V[o(¢'-p)-#]=
or, p(¢‘ - ¢) =‘ﬁ’» ‘neg’leé’tingléonsmntdf'intégraﬁoxi: o
. Prove that W= pyp under suitable conditions. .
Proof.Letusassume that 7 - and p ==constant Thenfrom(l):' RIS s g e
Weget' 7 -0=0-L%w
e p
if the motion starts from rest,

Since the motion starts from rest by the application of i nnpulsxvepwssm'e and hence itmust be irrotational.

Then 7/ _—V¢ say.
—6{0 = -——1-6121
P

w o2
or, ( P |

P .
= ¢’-“; =constant

or, p@ =, neglecting constant.
Note: If 7 =0 and /" =6 then from (1),
¥ =-L9w
P
andif ¥ = (u,0,0) then we have
dw

raie
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6.6 Flow:
- Letus consxder any two pomts A and Bina ﬂuxd
’I‘hevalueofthemtega.l onti v

taken anng any path in the ﬂmd is called ﬂow fromA to B anng that path
If the motion is nrotatxona} then the flow is

[ = [(90)- (.7 =95 rinomonstmotion)

A

I( do)=Pu=0y .

where ¢; and ¢, denote veloclty potentxals at B andArespectwely

6. 10 Circulation : : :
Flow along a closed path C is def ned as czrculanon and it denoted by 1. So,

T= cj(udx+vdy+wdz) chd‘

Ifthe motion is 1rrotanonal then V= -V¢ and hence
r= <§(-—V¢) Cf( dco) w,, cv,, =0

(sxnce the pomts AandBare comcxde for a closed path)

6.11 Kelvin’s Circulation Theorem: v

For an inviscid fluid the circulation arow;d'any closed circuit of fluid particles, moving along with
 the fluid, remains constant provided that the body forces are conservative and the pressure is a single-
valued function of density only. " | o D
Proof. Euler’s equation of motion, for inviscid fluid, is

dV = 1
=F-=
dt p

.

P
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=-VQ- -!— \7p ()
P _ .
- where F = =¥, 2 is the potential of the conservanve body forces
- Let C bea closed path (circuit) of fluid particles movmg along thh the ﬂuid and suppose that F,F+dF
are the position vecter of neighbouring particles 2, P’ of Creferredtoa fixed origin O. Then the cmculgtxon round

.r='c§€7-d7~

c :

dr_d _efdv - d(dF)
Now, 5 =73V "fj{_f'dﬁy dar }

(smcc R.HS. mvolved by smgle-valued and on passing once round the circuit),

- drL.

2220
So, T |
=s " =constant, in the moving circuit.

ie, circulation is constant along C forall times.

178 o | ’ Directorate of Distance Educ&tion



.................................................................... revrmiesssrsneseseeesesnnnenenss Mechanics of Continous Media

Corollary - 1. In a closed circuit C of fluid partieles moving under the same cohditions as before,

J.ﬁ'(VXV)dS‘: J.’“"st is constant whereSrsanopen surface wrth C‘as nm

Proof. The crrculatron along the closed peth C;forall time'r,is’ F ch dr = j'n (‘7 ﬁ)dS\,v(bvatoke!'s%
theorem) which 1mphes that fn ( I7)dS jn WdS eonstantas r is constant (under the condmons of |

Kelvin’s theorem) : . t
- Corollary - 2. Under the above condrtrons, ifany portxon ofther movmg ﬂuxd once becomes 1rrotanorul thenit

remains so forall subsequent times.

Proof. Let. us suppose. that at some instant the ﬂUId ons§ becomes 1rrotatronal Then V= -V¢ and henee the

~ —

» vorticity vector # = VxV = -V(Vgo) =0 atall pomtsofSandthe lastre-sultshowsthat

=c§ dF = j’n Wds = OforW o
C

at the given instant and hence at all subsequent times.

Thus at any later stage, ‘ , .
jﬁ-st;o

Ifwenow take Stobea non-zero infinitesimal element, say ds, then to the ﬁrst order n WdS 0 showmg

that in general ¥ =0 atany point of dS, i.e., that the motion: stays n'rOtatronaI
Corollary - 3. With the above condmons the vortex lmes moves along with the fluid.

Proof. For a surface S moving with the ﬂurd we have seen that In WdS constant Thrs mtegral represents total

strength of vortex tubes passing through S. Which shows that the vortex tubes move thh the ﬂurd By takmg S
_vanishingly small, we infer that the vortex lines move with the ﬂurd

6.2 Energy Equatron : . , , . _
The time rate of change of total energy. (r e.sum of kmetrc, potenual mtnnsxc energies) of any pomon of the.
fluid is equal to the rate of work done by external pressure across its boundary provxded the external forces are

conservatlve, ie.
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d e e
E(I+?+ I)= Hp(n-v)dS,
where T, W, I are Kinetic energy, Potential energy, Intrinsic energy respectively.
Proof. Let us consider an axﬁitrary closed surface S moving with a non-viscous fluid such that it encloses a volume

VLet /i be the unit inward drawn normal vector onan element as. Let the force be conservatwe so that F =-VQ,
where Q is txme-mdependent scalar potenual functxon

So, 99- =0 andhence
ot

aQ_a PR

7{——3;-+(V V)Q:(V-V)Q XON

Let T, Wand I denotes the kinetic energy, potcntlal energy andi mtrmsxc energy respectxvcly Since Q is
force potential per unit mass and hence '

W= [Qdm= j’gpdV
‘I
r= (2ol av= )7 pav
4 v

Since elementary mass remains invariant through the motion and so 7 (pav)=0,

Ldr 1 zd“"”’
CLENL Y 4 L 1)7

N°“" a 20ar ﬂl
Ll Z(pdv o)
_.2.; .‘7. dV+O( |V[ 7.7 and (p ) |

aw Q. . o d®) a0
= [ oav+ [l =22

e +f d Sar P

Intrinsic energy E per unit mass of the fluid is defined as the work done by the unit mass of the fluid agamst external
pressure p under the supposed relation between pressure and density o from its actual state to some standard
state in whxc;h pressure and density are p; and p, re,specther. Then

- I=[Epdv |

v
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=>

I8

.
7 ="‘i"...(li) -

| ) |
dl  {dE '
ey dV+E-— av dv
&t J[d:" (p )] I pav.

_ [4E.48
’JE' ar © 'f“‘”"f"”’ [using ()]
'[ dV I £( . )dV( ‘;p"’/’v V“o equanonof contmmty) '

Al e

'~i.c’;,' dt !p(v V)dV T
: Hm.ﬁnaﬂywehave

S dT_ e dV
'}T’fV-E-pdV (iii)
aw _ ¢dQ _
PaAARRTERY Ihiduind V,
a = Ja P @)

and "='IP(V"7 )dV -

'f_’,’.=_§n_lvp
ar P
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Integrating over ¥, o
- 'LV dV—-L(V )n»pd"z/'-v-i(;;? “p)dV
o e [0 (7 95) gyt
o L (79 )thusms(w)}
"o %;z - (ﬁ.ﬁp)dvf... o

But we know that the vector ideniity' ‘
\?-(p?)=:p€"’7+(’7j‘7)1’ ,_ |

. dl
or,,L ( )dS--;,—,—»r
_[ (p¥) dS+——.=£( )pdV . (vii)
Using (vii) in (vi) we get ;
4T aw [ ol
- —27=-[—L i ’V)dS+;1-t-]
o %;%V_ _3{___[\. (pV)dS (vii)

- which is known as equation of energy of a perfect fluid.

Corollary 1: Energy equation for incompressible fltid,
Proof. In case of incompressible fluid we have
VV=0
So,"froin (v), we get
dl

e 22 ()

dt

182
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...................................................

(17 . 6) pd V (using Gauss's div. theorem and (v), ii xsmward normal)
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He_nce from (viii) we have
dr dw

=+ [A(pP)dS ... ()

which is the equation of energy for incompressible fluid. .
Coroliary 2: Energy equation for mcompressxble fluid within the fixed boundary _—
- Proof. If the fluid is bounded on all sides by fixed boundary so that tbe fluid moves only tangentmlly over thc :
surface, i.¢., there is no normal ﬂow across the boundary; then 7 V =0 ateven: pomt ‘onS. "
Now from (ix) i.e., equation of energy for mcompressxble ﬂ_uxd, we get
dlr dw o

= ﬁ.(ﬁ)’q;.‘—-o o

S A(Tw)
ie. dt S
o, T+ W - contsnt
" Hence, if mcompressxble fluid is contamed wn!un afixed boundary the sum of its kmeuc and notentxal
energies remam unchanged with the passage of time. ' '

=0

6.13 Kelvin’s Minimum Energy Theorem e soh v
~ The irrotational motion of an incompressible fluid occupymg asimply connected regxon has less kinetic
energy than any other motion of the fluid for which ﬂuxd hason thc boundaly same normal ve‘ ocity as xrrotanonal ‘
motion. : '
Proof. Let us consider an incompressible ﬂmd oecupying a sxmply—connected regxon ¥ bounded by the closed :
- surface S. Let 2 be density of the fluid, : Tthe kmetxc enetgy ofthe ﬂmd movmg 1rrotauonally in whick: 1, v, ware
components of ﬂmd velocnty Then '

V2~V¢
a¢ o op
: = VR e W = v e
ie ¥ o | Y % (ii)
at everywhere.
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Again, the equation of continuity for inco'mprevssibletﬂuid is

VV=0

ateverymterxorpomt L SO TR L :
Let T be the kinetic energy of any other possxble stage of thotion of the fluid in which veloczty componems

‘are «', ', w'. Thenwe musthave

Tf=-é-p.[/ u'? 4’ +w'2)dV ,,,,, (iv)'. |
~ where velocity components satisfy the equation of contmulty .
W o
ox oy 0oz e
at every interior point.
.- Since these two motions have the same normal velocxty on the boundary surface S theu we must have
V=iV ' '
ie. nmu+nv+nw=nu+mv+ nyw' (vi)

when, n =(n]’n,2;n]). _
St et
. ‘ ) l '

o %‘p"[,‘{(u'z‘-iJ’)‘%('v"z-'.v")%’»(w;”—w’)}dlf‘

| ::%p‘[ [(u'mu)'2 +2u(u'—u)+(v'=v)’ +2:v(v"—v)+(w’—-w)2 +‘2w(wf—-kwi)]dV
| =’%p1[(“ —u) + (V' =v) +(w = w)’ ]dV+p‘[,[u(u —u)+v(v'- v)+(w w)]dv
=L +1,, say ... (vii) ‘

where, Il-‘-":l'p_{‘[(u'-ju)z (v —v) +(w w) :I(IV...""PI,II;'__I;"-rdV
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 and _1,=pl[,[u(u'¥u)+v(v'—v)+Q(w'—-w)]dV
" Now, 7, canbe éixnpliﬁed iry the following way:
pL[u(u u)+v(v -v)+w(w —-w)]dV
-pLV (-

“ﬂ.&[ £ (w - “) a(p(" -v)- ¢(W”W)]dV [m;ng(n)]

pL[ ¢(u -u) } ay{q’(v "v)}+5{¢(w -w)}]dV '

wﬁL@I‘ (u'- u) a(v -v) ;(W" )]dv ,,,,, (viil)}

"o
= p‘{{ Ca(ll u) ay{?’(\r’ V)} az{q,(w"'w)}]dy [usmg(m)and(V)] v

ap _Lﬁ : {t;a‘( ' ?)} dS (by Gauss's div. theorem)
sz-an@'lﬁ( . V)}ds
#*ﬂL@ n;(“ u)ﬂ‘i;(v V)'f‘";( ...,w)}

~p [ p-0dS [usmg(w)}
=0 |
' | = 312 v X s
Hence, T'-T=/, =§@LIV - 7| a¥ = apositive quantity
T =T>0

or, T <T' Hence the theorem,

6.14  Uniqueness Theorem ‘
There cannot be two different forms of irrotational motlon for a given confined mass of liquid whose

boundanes have prescribed velocities,
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Proof. Ifpossible, let there be tw;) such different irrotational motions, Let ¢, and o, be two different velocity
peisntials conesponding to two different irrotational motions, Therefore ¢, @, satisfy ﬁh@ Laplace equation, i.e.,
' =0,V%p, = 0 ateveryinterior pomt provsesannsns (1)
Since the boundanes have the same pr@scribed normal vel@citiea, ineach motion, so

op, 0
"5%* ; atevery pointon bﬂundaty .......... (1i)
- Leto=g -9, ... ""-i"-ﬁ(“i;ﬁ)'

- Vo = Vg, - Vg, = 0 [using ()] oo (V) |
which shows that ¢ isa possible velocity potential of an irretational motion in which kinetic energy is

= -pLV Va’V-:—pLV@ v@dV(anv@&ﬁ?g o)

p‘”:ﬁ -((af?(a)- ¢V2§o}d}’ ( v (¢Vga) = %}_s §qp *@51@)

1 Op
=~=ploZLas
145 |
But ¢ %0 %0, _ = 0_at every point on boundary.
on ~On 0n ‘ .
~T=0

e %puﬁrdvzo

or, L(u’ +v? +w2)dV=O where vl7 =‘(u,v,w) ‘
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op 6¢7
hich = — = 0,—~ =0
wczoaxa éy 6 everywhére -

-=> @ is independent ofx, . 2

je, @ =constanteverywhere,

@y — @, =constant. S B

ie, @ and @, candiffer onlybya c:onstam 'ﬂxmtgxe the vglaﬁity &mbutign gwen by @, and g,
“identical and hence two motions are identical. PR ‘
6.15. Motion in Two Dimensions ; :

Suppose a fluid moves in such a wgy thatatany given instant the flow pmgm ina ceriain
ss that inall other parallel planes within the fluid. ’i‘heamﬂgwwsaidt@bﬂwe’dimensional .

If we take dny one of the parallel plancsto be the plane = =0, then atany pointinthe ﬂuidhavmswwswﬂ
co-rdinates (x,  2), 6ll physical quantities (velocity, pressure, density, m)miamm&ﬁw fluid areindependent -
ot z. Evidently in this case - =

w=0and u=u(x 1), v=v(x ) where 7 =(u,v,w) =(u.V. 0).

planeisthe same

6.16 - Lagraage s Stream Fuuctlon (Current function):
" Incase of wo-dimensional motion, the differential equation of the stream lines are given by
& Q .
u .
ie.  vidv- udy Y| RO ()
The equatxon of continuity for mcompressnblc ﬂmd, in two duncnglons is

au ov
: +om=0
éhc ay vevrnssvsassnseess 1)

ov 8 (-¥)

e —=—

oy Ox
Above result shows that (i) is an exact dxﬁ'erentxal and letitwill be dy ,ie.,

el — udy :dwgﬁa%@*%dy

oy
which =¥ 3%,13 g ol A " Q!!)
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Now, (i) takes the form as
dw~0
Int., ¥ =constant................ vererenens (w)
- This functlon v=y (= y) is called th@ sream ﬁmcuon or current function;
. Since the gtream lines are given by (i), so it follows that stream function is constant along the stream line.
- Note-1. Stream function exists forall types of two dimensions] mgﬁcn-totamna! orirrotational.
Note-z, The necessary conditions for the existence of y are:
) theflowmustbe contmuous. ‘ ’
i) the flow must be mcompressxble, , o : ;
Note-3, The existence of a stream functxen isa cgnsequencg of str@gm !in@; and equatxon gfgommuity for
incompressible fluid. . Wi
No:24, ¢ and v are conjugate funct;enq
Proof, Forirotational fluid motion we have
| V =~V o where @ isvelocity potential

Ox’ oy
Ifyis astream function, then

ot 32T oot Dt T . —

. dp op . Co
Again, ¥ = ===,V = "y and cquation of continuity is

g
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i V920 e () |
(iyand (if) implics that @"and v both satisfies Laplace’s equation i.e., @ and v are conjugate functions.
Note-SExistence of ¢ and v/ ,' s B
i)  Thestream function ¢ exists whether the motion is irrotational or not.
iy The velocity poteniial ¢ exists only whenthe motionis irrotational.
i) When rhotion isirrotational. p exists. R :
iv) @ and y both satisfy Lapiace’s equation and

P e - atsnesanad

Note-6 The family of curves ¢ (x; ) = constant and y/(x, ¥) = constant, cut orthogonally at their points of
Proof. ¢(x,y) =constant dp =0

. 0o Oy
2 -—-—dx —— :O
ie, 5 '*‘ayd}’ ha

dy_ o
_g;m-—-=m,,say

' which is the gradient of tangent to the curve ¢ = constant.

7

Again, ¥(x, y) = constant :o-dgi) =0

oy oy
: Sl det—tmddy =0
e ay’)’
& __ Y
S memi=m , v
&y, 2, say s

~ which is the gradient of tangent to the curve ¢ =constant. L
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¢X ‘//x u v
m, Xm, =| == = e X
NOW, } 2 ( ¢y] ( ] v (___u)

Hence the curves of constant potential and constant stream functmns cut orthogonally at thexr points of
intersex iion, L

6.17  Complex Potential:
- At this stage we introducé the notion of a function of a complex variable. Suppose(v and ¥ represent

velocity potential and stream ﬁmcﬁon ofa two dxmensxonal u'rotatmnal motxon ofaperfectfluid. Let
W= f(z) ¢(x,y)+i¢//(x,y) where 2z = x-ﬂjy,; =.-f~
, " Thenwisdefined as complex potential of the ﬂmd
Property 1. wisan analytic function. - : :
Prosi, Since w= f(z) o(x, y)+u//(x y) where z = x+iy

So, we must have
U= ..‘.22, Y= ....a..?.
Ox oy
.

where u and v are velocity components of the fluid,

a¢ oy . da¢ _oy
“ox Qy oy ox

which are Cauchy-Riemann equations, Thus Cauchy-Riemann equatxon are satisfied so that w isanalytic |

functionofz.
Conversely if w is analytic function, then itsreal and i unagmaryx e, ¢ and v givesthe velocxty potential

and stream function for a possible two dxmensnona! irrotational fluid motion.

is the magmtude of the velocity of the fluid at any pomt

v dn|.
mpertv 2 dz

Proof. Since w= f(z)=¢(x,y)+u//(x, y)z=x+iy

Lt
oo +idy
S ox—0
dz f(z) = [waéy]
oy—0
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where Sp= ¢(x4" 53;)’*,5}7) -g)(x,y)
Sy =w/(x+0x,y+6y)- w(x,y)
Atfirst wekeepyasaconstant, then P

aw_ Lt [M]=§.¢.’+£ﬁ=~.’um'

.ézﬂzéx-)() Sx ax

¢ :
where ¥ = "'"5; ="'-5;, = "3;"—'5;.
Similarly, if we keep x as a constant then

dw Lt [dp+iby| .0p Oy
e T2 ettt | T3 o] i . o 2 - K
dz 5y-+°[ iy } '6y-_6y~ ,“m'

: Hcsxce,-tzi“" ul +v? = magnitud: of the velocity,

Therefore

jd;" represents the magnitude of the velocity. .

Stagnation Poiats: The points, where the ﬂuid velocity iszzw;,arecﬂlbdmgnaﬁonspoints;» RTINS
* . Thus for stagnation points, we must have
& -0,
dz

6.18 Twe Dimensional Sources, Sinks: o o
| i)  Sources: Asomcensapomt from whlch lxqmd xsexmited radxally |
eymmemcally in all directions inxy~plane. : o
) Sink: Apomttowhxchﬂmdnsﬂowmgmsynmetmallyandmdmlly
in il directions is called sink. This sink isa negative of sourpe.
Source i isa pomt at which liquid is conunuously created andsink - .
5.1 poinit at which liquidis continuously annihilated. Really speaking, sourceand -
s "¢ purciy abstract conceptions which do flot occur in nature.
i) Strength: Strength of a source is defined as total volume of flow

perunit time rrom it,
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“Thusif 27m is the total volume of flow: across any small circle surrounding the source, then m is
called strength ofthe source. Sink is a source of strength (-m)

If we consxder for C the circle centre at 4 of radius r, the speed of ﬂow lV l is everywhere of the
same cn Cand thg mass is now erp'V ' per unit length. Thus |

(2zm) p = errpr[ forunitléngth :

= 0
IV':—?— o.r,—-—é?=-';—.

6.19 Complex Potential Due to a Source:

Let us consider a source of stiength m at the origin. Let
- wbethecomplex potential at P(r,6) due to this source. The -
velocity at P due to the source is purely radial, i.e., aldng OP

and let this velocity be IV’ . Now the flux across acircleof |

radius r surrounding the source at Q.is 27r ’ ‘7’ So

2nr IV’ =2rm

=[7|==
.
Let u, v be the velocity components along Ox and Oy,

. then - :,]VfI‘cosﬂ = -”—1:0050

lV'smH = —-smo

: Agam, we know that

dw .m : e e m
— = —u+iv=—[-cos@ +isin@]=-—e"
dz r ; r

m _m

re z
dz
rdw=-m%
z
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Integrating, w = —-mlog, z (Neglecting constzlnt of integration).
Ifthe scurce of strength #i is at a point z = z, in place of z=0, tlxen by shiﬁing the origin, we have
w=-mlog,(z-2). |
. Cov allary: Complex potential at a point due to the sources of strengths my, my, M;,... situatedat 2, 2,,2;,...
Proof. We have the complex potential w due to a source of strength msituated at z = z, is ‘
w=-~mlog,(z-2z)

. Hence the required uomplex potential due to the sources of strengths ml Yy, My, ... 51tuated at 2;,2,,2;,...18

w=—m, logg(z-z,)—m.z log, (2~2,)—m;log, (z=23) =
=~Z‘mj log, {‘z-zj)
js

which = @ =-) m, log, 7,

J=

W= *Z m,9,, where z -z, =re™ .

nwl

6.20 Doublet:
A doublet is defined as a combmatlon of the equal and opposxte sources, i.e., a  source and a sink of

strengths (+m) and (-m) respectively, sxtuated at adistance &s apart such that the product mds is finite.
Strength of doublet: If mds = u = =finite, where m—»®, 5s -0 then /u lS called strength of the doublet and?
jine 55 is called the axis of the doublet and lts dlrectlon is taken from smk to source ‘

6.1 - Complex Fotentiul for a Doublet;

Let 4 be the strength of a doublet 4B formed byasmk o 5
ot Alz = a) and s source +m at B(z=a+6a).’l’hen e B(m)
L , s
= m.AB} oonnne(B) .
andSa = ABe” [ z = re®
wdda - ABe® (2 =re?) =a L% .
whese ¢ isthe inclination of the axis of the doublet with Ox. Al ~r
I he itz complex potential due to this doublet at any point- P( z) o L
thea v |
193
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w=.+mlog(z—a)~mlog(z-—a+éa) '

' { da '
=+m ( :;) (upto first approximation)

m AB.e"”
z-a

a

_mpe
= lusing ()]

eia
Sw=p
z-a

Note-1iftheaxis ofthe doublt i along x-axis, then g = 0

M
Z a

. sothat w=
:\Note~2 If the axis of the doublet is along x-axus and the doublet is at the ortgm then a= 0° a= 0 S0 that -

welt
z

Note-31fa system consists of doublets of strengths 4, 45,... placedat z = 8),dy,..., then
, = z lun |
nul Z a

»trhere a, isthe inclination of the axis of the doublet of strength 4, with Ox.

6.22 lnte'ge.

: - Mfthere exists a curve Cinthe xy—plane inafluid such that there is no flow across it, then the systemof
emm,es, sinks and doublets on one side of Ciis said to be the image of the sources, sinks and doublets on other side
of C.
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. intwo-dimensional irrotational motion when confined to rigid boundaties is regarded to have been caused

ty the presence of sources and sigks. If we take the set of sources and sirlks to be on either side of the rigid

“boundaries, the velocity normal to these boundanwwxllbezem ‘As such these boundaries can be taken as stream

lines This is due to the property of stream lines that the velocity perpendicular to stream lines is zero. This set of

“sowcus and-sinks oneither side is called the image. Thus the motionis no longer constrained by boundanes so that
itispe.ibleto predlet the nature of the velocity and pressure at each point of the fluid, - R

6.23  lLaage of a source w.r.t. a strength line (plane):

Tc determine the image of a source +m at A(a,0) w.r.t. the

line Gy we place a source +mat B(-a, 0) Then complex potentxal w

at a.m scint P (2 ) due to this 5y s*em xs

Wmﬂmloge(z a)_m]og : ) TR | 3
o | %

- -mlog, (2-a)(z+a) | B9 (o Ao

"'”’”loge{'i"zei(&*m} : o ‘where

AP = BP =1, i~a=re% z+a=re%,
. +iy =-m{log, rry +i(6 +6,)}
wﬁich =>@=-mlog,nn
and Y = ~m(6, +6,) -

I P lies on Oyyi.e., y-axis then AR= BP sothat - o
£LPAB = £ZPBA

ie. n-6,=6,

LB +by =

Hence y=-mm= constant.
Wlmh implies that y-axis is a stream line. Hence the image of a source +m at 4 (a, 0) isasource +mat

Bv ~a,0},ie., imageofa source W.r.t.a line is a source of the same strength situated on the opposxte side of the

hnew mmumdstance
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6.24 Image of a doublet w.r.t. a plane: - B

- To find the image of the doublet we consider a pair of - tm X - T TJo T
sutases—mat A, +m at B, close together and onone si‘de:‘dfthes ‘;4 '/' ‘ '
rigid plane Oy. The image system is—mat 4, +mat g', where
-4’5 B’ arethe respective optic images of the points 4, Binthe .| . t0
piane 00’y i.e., 0’4 = 0'4' and O'B = O"B' . Hence the image - ' ' ‘
of adoublet inaninfinite rigid plane is an equal doublet syxmnemca.lly
dxsposed with respect to the plane. :

6.25 ‘Image of a sourcein a clrcle ;
LetO be the centre and a source +m at 4 (outsxde of the cxrcle) Let Bbe the inverse pomt of Aw. r.t the

cxtcle and P be any current point on the circle at which v isto be determined.

Néw we place a source +m at B and sink —m at O. Then compléx potential is

w =-mlog re® —mlogr,e™ + mlogre® (where AP =1, BP =r,,OP =r)

- -m[log(ﬁ;’i}i(e, +6, ~é9)]

DY =-m(6+6,-6) .cucernrnns )
Since, Bis the inverse pointof 4,50

0B-0A = (rad:us) =0P =r
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OB-OA4
04’04 o
- .Taking limitsas 4' — 4,sothat B’ —, B.Thenwe get

=>m-BB =m-A'A- —-=( A A)

Again fromsimilarity of triangles, wehave . . ...

4'0313' =ZLO0A'A=LOAT=a
2

Thus the image of a doublet of strength 4 atA relative to a cu'cle is a doublet of stnength # = ""'r agp )

whcn‘ OA*f the inverse point of 4, the axis of the doublet make supplememaxyanglesxe r-a thhthe radius

627 Milne-'l‘homson s Circle Theorem: | SN
- Let f ( ) bethe complex potential ofa two-dnnensxonal irrotational motion of an incompressible inviscid

itics of ﬂowmtlunthecu'cle M a "ern. on

hquxd havmg 0o ngxd boundaries and such that there ¢ are i
v introducmg the solid circular cylmder sz a mto the ﬂow, the new complex potentxal of the resulting motxon is

gwmby | N
(a2 . »

_w==f.(z)+f(-——) for |2a

v Prool. All the smgulantxes of f ( z)(at which sources, sinks, doublets or vortices mdy be present) occur in the

region H = qQ and so the singularities of / ( / ) he in [zl =a. Hence the singularities of f ( aA ) also licin

[z}<a.Thus f(2) and f(2)+ f (“7) both have the same singularities in the region [zl >a and so both
fuacuons, considered as complex velocity potentxals, may be described to the same hydrodynamlcal dxsmbutlou in

theregwnlz|>a
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and ZBOP = ZPOA
Threfore, AOPB and AOPA are similar. So,

LOPB = LOAP
ie,0,-0=n-6, .
VOO ~0=x . (ii)

Hence, = ~mn [using (i) and (ii)]
= = constant.

which shov mthatcm,lc:basnemnlmesodmtthemexxstsnoﬂtmmssthebomdary thatmem\s,unageofsomce '
+m at 4 is a soruce +m at B, the inverse pomt of 4, and sink —m at the centre. - .

6.26. | lﬁage ofa 'dbﬁblet relative to a circle:

. Let @be the inclination of the axis of the doublet 44" - [

and {/the centre of the circle. Let O = f and ythestrengthof ‘
the doublet, Let us assume that this doublet as-a combination of
sink -m and source +m so that 1 = m.A4’ where m —»a and

_AA ~» 0, The image of sink -m at 4 is a sink -m at B; the 1 f

inverse point of A and source +m at 0. The image of source +m

at A’ isa source +m at B' thei inverse pomt of A’ -and sink -
X S BN RRR

ma\U

- Combining these, we find that source +mand smk -m
?Jotn at O cancel each other and there remains a doublet of
strength 12 = m.BB' at B, the inverse of 4.
~ Inlimitsense, 4' > A= B'— B.

Now, OB-O4=a’ =0B'-0O4' ,aisthe radius of the circle |

Al) /BOB' = £A4'04
= AOBB' and AOA4' are similar
BB' OB

Hencc, 7’; = az; :
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Onthecircle |z| = a, wetake 7 = ge®.

?
a y
Then —=ae ? andso -

v= s+ 7(%)
= £ (ae®)+ F (ae™) |
- f( ae") + f( ac®) ( f('z‘) = m,:eomplex conjugate of f (z)) ,
IREOION e s
Thus on |z[ a, w is thesumofa complex quanmy and its complex conjugate and is therefore areal

-nmwhm . ,
ie.w= rea! number

=y = =0 onlz=a

This shows that the circular boundary is a stream lme across which no fluid flows. Hence |z|=a isa

4
.pomble boundsn-y for the new ﬂowand w= f (z)+ / ( ) xsthe appropnate complex. velocity potential forthe

new flow.

- 628 Applications of the Circle Theorem:
i Unifor m flow past a stationary cylinder:
The uniform stream havmg velocity U7 givesrise to acomplex potentxal Uz So

f{z)=Uz
Then  f{z)=Uz

(&) Ua*
and so f[z)- p

~ Thuson introduc.ing the cylinder of circular section ]zl = a into the stream, the complex potential forthe
region |z| 2 @ becomes |
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2
w==f(z)+f J (z+-—-—)
z
Taking z = re” and equating real and imaginary parts, we get
r

. -
' .¢=Ucos6(r+9—)

| o 2
| w=usin,a(r—3-)

) Image of a source w.rt. a circle: .
Let us consider a source of strength +mat z=f Then the complex potentlal due to this source is

T f(@)=-mlcg,(z-1).
- Letusmtroduceacxrcularcyhnder |2| = a(a <f), thenthecomplex potentlal bycu'culartheorem |

~w=f(2)+f (5‘;) =-mlog,(z-f) —m log,_(,-‘g— - ) o

" =cmlog, (z- /) mmlog(ma f’) |
b4

=—mlog,(z—f)-mlog,(z-19—f- -mlog,(-f)+mlog,z

' ER
'_=-mlog,(z-f)—mlog,v(z--?}— +mlog, z
/ A

[ignoring constant term ~ mlog, (- f )]
'Ihxs is the complex potential due to
i) source +matz=f, .
i) sink-matz=0,
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2
i) source +m at Z = A .
For this complex potential, circle is a stream line and hence the image system for a source +m outside the
circle consists of a source +m at the inverse point and sink —m at the origin, the centre of the circle, since fand

S .
"/f both are inverse points w.r.t. the circle 2| =a.

i) Image of a doublet.
The complex potential f( z) dueto the doubletof strength ¢ atz=fwithits axxs inclined at angngle

a,is given by
fgz)s f

When acircular cylinder le|=a; whem a< f,isins erted inthe flow of motion, then the complex patential is given

by : Lo :
w=f(z)+7(a:/z)

E"’
z f a. f
ﬂg:a Heia ' # y;g ﬂ -8}

T/ a@ f -] d-f
#Zel(tq , ; :
= e f T .
7 2
ia-a) ( g_ij
. 174 b R i
pe S [)

PN kAN — .
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{

B M ea)  pE
R _*,f ? T g g.
| /
&) | -
;“ef.;.f;‘i — (ignoring constant term)
=%
f
Thig is the complex pote;mal due to

)  doubletof strength i atz=f withiits axis mclmed atan angle a,

i)  doublet ofstrength %T atZ= = the inverse point efzaf itsaxisis mclmer,i atanangle 7 ~a.

- For this complex potennal urclc isastream line and h@m th@imggg system fera doublgt gfamgm H at,

" z=f (outsxde of the cnrcle) isa doublet of strgxagth U= f3 " and its axis inﬁlin@d at an angle r-a.

629  UnitSummary: ' ,

In'this module we have discussed the motxon of perfect fluid in s;mple gad gtmigm-fnrward method. This
portion have covered the remain portion of the module 53, and for gomplete Em@wledgs about perfect fluid, this
© portinis essentlal for each and every student of Mathematies, |

630 Worked Out Examples
1. A sphere of radlius a is syrrounding by infinite liguids of density p, the pressure at infinite being [J. |
The sphere is suddenly annghllated Show that pressure at' a dc,stgnge r from the centre immediately falls to

(E }
\ S ; |

v a
- Show further thiat if the liquid is brought to rest by impinging on a eoncentric sphere of radius 3

¥
the impulsive pressure sustained by the surface of this sphere is [ Z Mpa ] ,

Ans.  The equation of continuity, for spherical symmetry, is
xtv=F (1)
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Tal X
The equation of motion is
v, . 1%
a o pax -
F{t) @ v’) a(p)
F'(1) V¥
Int,, wat. %7, — x)“""'z"'m”""*'co ....... we(1)
Boundary conditions are

)  whenx—n,p=Tlv=0 ‘
i) whenx=ayv=x=0p= 0! 03
m) whent=0,x=r,v= 0,p = Py where r>a
Using (i) and (ii) in (1), then we get

0»«54-('

and »_..u+0 0+C

Again usih,g (iiiyin (1), we get
o P

| ari__p 0.
or, o F 7 P [using (2)]

- a)
Po*"n(l"r‘)

2n¢ Vart: Let v be the required impulsive pressure,
 Letubethe veloeity of the inner surface of radius r. Thenwhen x = 7,v'=F =u, p=0 when r <a.
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Since pressure vanishes on the inner surface; so from (1),

'—-—JF'(‘ +=u’ 4!

P
wp:(t) 1 L =._1'_1_[ Pu=F(r)]

-ZFF'(I)dt Y gr
r rt
...2 '
)
r .
~
1 S B P
r 3p
Using condition (ii), in above result, then we get -

| 0=-2—-I—]—-a’+Cl
3

we get

. O

«H 2rdr
p

or,

o,
or, ==3dr

32 2 n 3
Int, T 3p

R et B

Now the equation of impulsive action s

- dw = pvdx
= dw = pudr

204
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Ex2 A 'nf inite mass of ﬂuzd qcted on by a force pr ’ per unit mass directed to the ortgm [f mmally the
jI wid is at rest and there is a cavity in the form of the sphere r=c in it show that the cavity will be filled up ‘

. 2 )
after an interval of time (g;) o .

Ans.  Ifvand p be the velocity and pressure at a distance x from the oxigin; then the equation of continuity is

xv=F(t)
: F(r
ie. v= (2
and the equation of motion is
ov -% 10p
e o Y e T - 2,,.______
a e pox
F),0(¥)._ %1
Xt ox| 2 p Ox
F'(t) v 2u p
- 4= ===+ C,
Int., x 2 7; T O 1))
Boundary conditions are

~

) whenx—»>o,v=0,p=0;,

i@ whenx =r (radius of cavity), p =0, Y=F;

i) when x = ¢, v = 0 s0 that F(t)=0.

Using the conditions (i) and (ii) in (1) then we get
0+0=0-0+C, ie, C,=0

-F'(t ; 2
() 2 T”-O+C,,

ad —
r r
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—F' d +lf'2=2p 2
e — % 7;‘ ............... () 

Since v4=v-l-¥,ﬂ therefore r’ = F (7)ie., PPdr=F(t)as.

~ Hence from'(Z)},‘we get by multiplying 2F (¢)d of 2,3 on both sides,

Using boundary condition (iii) in (3), we get
0= §Sﬂ o 4 G |

g8

= -

| Hence from (3) weget

()’ _ 8% )

r

s

[negative sign is taken as velocityincwaseswhmrdeaeasu] .
Let Tbethe requu'ed time offalimgthecavnty Then mteguungabovewnh proper limits,

8py
-[ W f
r-(2) frf_‘";"?
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il

(5 )/ f/4 % schosGdO [Put,%gc%sina’] |

\ 84 5 M cosl
- ’..%.]y’ 7
\SH

Air, obeymg Boyle's law, is in motion in a uniform tube of small section, pmve that y’ p be the density
' a’p i)
;and v the velocity at a distance x from the fzxed poim at time 4, then Y &, [(V +ﬁ p] where p =kp.

| Ex-3.

 Ans. fl‘hevequatxonofoonunmtyxs»

p, 2 (pv) o
" Fre 0 ........ (i)
and equation of motion is

v v 18 '
Ly Zaa= D)

o0 ox  pox
From Boyle s law, we have
p=kp

a-a(ﬁv)

T Ta|a

Lofoe, ]
ox| a: a:

__al (ol (koe_ o
ax| Tpx &
ol a(pv), ,00,

= Yo k—+pv—

ébc[ > - ox -pvax]
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] .

_9[o(pvv), 0 (kp)
xlax |
2
' =-§-5-(py2+kp)
Fp_ o [p(v+k)]

Ex.4 An;é?dfsticﬂicid‘ the 'weight of which is neglected obeying Boyl’é % s in'motion in a uniform straight
' tube; show that on the hypothesis of parallel sections the velocity at any time t at a distance r from a fixed

v 0
it 1 5 1 e v e B A '+2 I ,""k . e - 5
point in the tube is defined by the equation a ar( o V-‘at) _ar’ R

Ans. From Boyle’s law, we have
p=kp
The equation of continuity is

op 0 (pv) i
-5;-4-5-; =0 ................ (!)

and the equation of motion is
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d (12+k”“5)
EACE

Hence, 6r

ov
2 i
vazJ

— reeseeseerersetrsaatness Mechanics of Continous Media

62
arz

Ex.-5. A sphere is at rest in an infinite mass of homogeneous Itqmd of density p, the pressure at infinity
preing 11, show that, if the radius R of the sphere varies in any manner, the pressure at the surface of the

Sl

1 | d’R* (dR
sphere at any time is n 5P "‘},—z"‘" at
Ans. Theequation of motionis |

¥ ol
o Ox p ox

Directorate of Distance Education
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;

and the equation of continuily is
xv=F (t )
) o _F (t)
ie. it

JEW, oy _afp) . |
Hence, 3 xl 2 ox\ p as p isconstant,

Boundafy conditions are :
) whenxow,p=I,v=0;
i) - Whenx=R,p=p,$*=k
Also x’v=F(f)=RR

S F'(¢)=2RR* + R*R
Using (i) and (ii) in (1) we get

0+o=_D-+Co=.Co=E.
P ot B
and (’) =-—~-—-+C "-£+_.
P P P :
E—E—lR2+—- 2RR* + R*R
p p 2 R[ ]
o =Tz p[3R42RK] ... @

?”*f[k’ +2y1'e”+2gk]f

[ . d h
=m_‘z?. Ru:{;(zkk)d

[ .2 d(dR*)]
Pl p2
=M+£| g2+ 5| £
T2l +dt( p7 )
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fR’
np=I1 + p Rz
dr

Ex.6. Liquid is contained between two parallel planes; the ﬁeefswﬁ'we is a circular cylinder of radius ‘a’
whose axis is perpendicular to the plane.s‘ All the liquid within a concentric circular c;ylmder of radzus ‘b’is
suddenly annihilated. Prove that if n be the pressure at the outer surface, the initial pressure at any point

logr~logb}

- of the liquid, distant r from the centre, is n[log a -_viogb ‘

Ans.  Theequation of continuity is

= F(t)
and equation of motion is
v & 1o
o ox Cpox
' 4 .
F0,a(2) z
x ox ox\ p o
' F(e)] +-—---—-+C
Int, wrt x ()ng 2 5 ....’.....\...(l’)

Smcc, mmally the fluid is at rest, so we have the boundary condxtxons:,
) whenx=ag,v=x=0,p=Ilt=0; ‘
i) whenx=bv=£=0,p=0,=0;

i) whenx=r,t=0,p=p,say. |

Using (i) and (i) in (1), wé get

F'(0)log,a= ---l-:I—+C0 =C, I, F'(0)log,a
| P P
and  F'(0)log,b=0+C, =C, = F'(0)log, b
which implies that
F'(O)logea+%-——-‘iF'('O)logebk'
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' b) IT. ‘
ie. F(O)log,(;J=—’; ................. )
. Hence C, = F'(0)log, b=~ 182 .. 3)
T p lOga.(‘Z')l o

 Againusing i)in(1),weget

F'(0)log, r = —-%’-4— G,

v htnnn savssnamm—————— 3] e w oo o w—on

or, P log,(%) P log.(f) [using (2),3)]
) .

- ), -1 :
opy =Tl (log, r logeb, =I_I((log,r og,b)}
. log ( g) J (log, a-log, b)

Ex.7. A velocity field is given by V= (xf - yf)/ (x2 + y’). Determine whether the flow is irrotational.

Calculate the circulation round -
i) asquare with corners at (1,0), (2,0), (2,1), (1,1);
i) omunit circle with centre at the origin.

Ans,  The flow of the fluid isto be irrotational if ¥ x 7 = (.

i ookl
. d a 9| = X -y
Now = — —_ —{ where V =
vx¥ ox oy oz 4y
x2+y2. x2 +y2 ) »
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P T R R TR L L L LR R R A

PR 2% 1 2y* -
= 7 7t -
_x +y (x +yr:);‘ x+y (x2+yz)
i 2 Z(x2 + yz)
x+y (x2+y2)2' :
2= f 0 y
= 0 ) ,
which showvs that the fluid motion is irrotational.
i) The circulation of the flow around the c!osed path Cis -
r= j V.dF | A
ndS (by Stoke’s theorem) 4 1 s >
L y » o 4 B x

| ' o) @0
Here V mustbe a continuous differentiable over . At glven problem Vi isnot continuous at the origin but

- origind does not. he inside the rectangle so that Stok’s theorem is apphcable But we have proved VxV = 0. chce

, r= 0 " : , :
i ln this case the equatlon of the path Cis 2+ y = 1 whose centre is at ongm ie. (0 0). Hence the circle

C contams ‘origin, the pomt of smgulanty So, Stoke” stheorem is not applxcable e g

Therefore r- IV dr = -((x +yy dx+x2+y d.)')

]
A
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=—tan™ (cot8), . [where x=rcosf,y =rsind]

= -[32'- - 9] [for the whole circle, @ runs 0to 2 ]
J

=2r.

Ex 8 Two sources, each of stréngth m, are placed at the points (-a,0) and ( a,0) and a sink of strength

2m is placed at the origin. Show that the stream lines are curves ( +y ) = a2 [;x -y 4 ﬂny where 2

is a parameter. Also find the fluid speed at any point. T N T
Ans. The complex potential w at any point P(z) isgivenby -
. w=-m log(z -a)-m log(z +a)+2mlog(z- 0)

) ‘=?-mlog(z -a )+mlogz

¢+w/—-—mlog(x -yt +2ixy a)

=W=-'"‘an'(‘7“7—7)+mtaﬂ'( ; )

x*-a*-y xt -3
= -1 2a’.x:y T R A E R P,
mtan ((x’-—y’)(x -at-y )+4xy }
Since stream lines are given by

¥ =constant

- 24 xy : = =i _2_ ;
or, TR (( =y )(x'-a’ -y )*4” ] " (") i
6:', y’) a’(x*-y*)+ax?y
or, Jt'2+y2)2 -a*(s -y)

or, (x +y )’ a’(x2 % +4xy) where;( 1savanableparamcter

214 Directorate of Dis{aggggtgduch{tjan



‘Mechanics of Continous Media

------------ aauubn.uunununuunnnnnn"nynwnuunnuu.u.nnvnnnonu---nu-uun-n-nanc

Now speed of the flow =

Zr;a 2ma
IZI e=dljz+d] rnn

Bx 9 Purallel line sources (perpendicular to the xy-plane) of equal strength m-are placed at the points

z=nia, wheren = ... '-2,-1,0,1, 2 . prove that the complex pote‘r?tzal is'w=-mlog smh(-;—-).

Hence find the complex potential fo." two dimensional doublets, with thei(’qxe;:pqrallel fo the x-axis, of

~ strength 4t at the same points, is given by w = ,ucoth(ff).
Ans.  Thecomplex potential w at any point = due to the system of sources of equal strengthmplacedat z = tnia
'lsgwenby ’ et T e e SR AR S SR

w=-mlog(z O) Lmlog(z ma) Zmlog(zﬂzia)

nal R L
- .

n=}

--mlogz—2mlog(z +na’ )

oy 6 g
M..___Zm]og(].(. ].nzag..zu . i
a .

n=}
22 Mz .2 2
=-~Zmlog 1+ == '~——’-Z~mlog n‘a®—
osi - n a a HO‘

) 2 n il
% -Zmlog(l =5 3 ]—" (omitting constant)

nxl

: .
=- logf| 1+—— |, tH-—-——-
; Zm og ( ”2}[pu a]

Awl .
; 8 92 Agz ( 92
=-«mlog9(l+-7;-2-)(1+§-2-;2—)L1+§3;2— ......

=-mlogsinhé
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=-mlog sinh (ﬁj
a

It w=-mlog(z-a), due to a source +m at z=a then w = ~ 7 -5 » due to the doublet +m at z=a with

its axis alciig x-axis, i.e., W= - [ mlog(z - a)] fora doublet +m at z=a with its axis along x-axis.

- So,complex potential for the'doublets of strength mat these points is given by -

- E A0 I the Sluid fills the region of space on the Ppositive side of x-axis, which is a rigid boundary, and if
v there be asource +m at the point (0, a) and an equal sink at (0 b) andif the pressure on the negative side
of the bounda::y be the same as the pressure of the fluid at mﬁnity show that the resullant Pressure on the
'boundary is mpm (a by /ab (a+b),p is the density ofthe/luzd : :

Ans. Here object system consists of source +m at 4(0, a) ie., at z=jq and sink -m at B(0,5) i.e., at

z = ib . S0, image system consists of source +m at 4'(0,-a) i, at 7'= ~ia and sink <m at B'(0,-b) i.e.,at

2z = ~ib Wt the positive line Oxwhichisa ngxd boundary.
. The complex potential due to object system withrigid boundaxy is eqmvalent tothe obJect system and 1ts

' magu system with no rigid boundary: Hence thecomplex potential is y
w=-mlog(z- 1a)+mlog(z—lb)—jgjlgg(zfxa)fmlég(rﬁib_)‘  =miB,5)
=~-~mlog(33+a’)+mlog(z’+b’) : | | +m 4 ©, a)

; : : x
dw 1 ! dmz(a’-p?) - o -
dz Mzmz{ vd 7 +b2]—(z’+a )(z +b2) , w1 4(0,-a)

| ' +m+ B'(0,-b)
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'Hence speed of the flow is

7] |dw| _ 2m(a’ -’ )
Tldz)| Iz +a2‘ (z +b"

So the speed of the flow at any point on x-axis is given by replacing z byx So,
"mx(a -5?) |

, :;(x *a )( "”b;) vevpasasevenne (i)

Bemouli’s equation for steady motion is

{

2odpf-c

| 'Letp--'po,]V,-:O when.x-—a-eo' S

'?.Cagug-
e

Let p' be the required pressure on the boundary which is given by |
 P=[(n-p)a I; l!’! pes [using ()]

4m’ar2 (a b’)

2p£(x +a ) (»’5 *bi) T

M

’a"*b’( ”)_i_gg_“
La *~b* \2b 2a) 4a 4b

(-..; ] -5
ol xad la al 28

;a
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dx 1 &
and  —r cos’ 8d0, putx atanf
f)(x'+a2.)2 a ‘[-
4a’
mpm’ (a-b)
ab(a+b)

6.31  Self Assessment Questions: _
1. W ateroscillates in a benttube (unifom ) in a verticalplane. If O be the lowest point ofthe tube, 4B the

equilibrium level of water, & and £ the inclinations of the tube to the honzemal atA B and OA=a,OB=b,

‘the period of oscillation is given by 27 [(a+b)/g (sm a+sin ﬁ)]K

2. An u;fmxte mass of homogeneous incompressible fluid is at rest subject to a umfgrm pmsm IT and
contains a spherical cavity of radius a, filled with a gas at a pressure mI1; prove that if the gas obeys
Boyle’s law, the radius of the sphere will oscillate between the values a and na, where nis given by

" 1+3mlogn-n’ =0.

4 5 ’
3. A mass of liquid, of density p and volume g’w’ ,igin the form of a spherical shell; a constant pressure []

 isexerted on the external surface of the shell; there is no pressure on the internal surface and no other
forces act on the liquid; initially the liquid is at rest and the internal radius of the shell is 2¢; prove that the

| 1425 2’%
velocity of thc. mtemal surface, when its radius is ¢,is 3 p 2 y

4, If vy is the impulsive pressure; ¢ and ¢ the veloc;ty pgtem;als immedlat@ly before and after animpulse |
acts, Vthe pqtentlal of ;mpulsgs, prove that W+ oV + p(@ ~ @ ) =constant, p is the density of the fluid.

3. Between the fixed boundaries € = fé- and 6= *“, thereisa twe éimmaigngl liquid motiondue toa

source at the point (r = ¢,6 = @) and a sink at the origin, absorbing water at the same rate as the source
produces it. Find the stream function, and show that one of the stream lines is a part of the curve

r¥sin3a =c’sin30-
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6. Provethat u = —wy, v = wx, w = 0 represents a possible motion of inviscid fluid. Find the stream function
and sketch stream lines. What is the basic difference between that motion and one represented by the
potential p = 4 log ,r,r = V‘x +y

7 if 4 beavariable parameter, and fa gt\/en funcnon, ﬁnd the condition that f (%,y,4)=0 should bea

4 pOSStble system of stream lines for'steady irrotational motion in two dimentions,
8. Usethe method ofimages to pmve that if there bea source m nt z = z, inthe fluid bounded by the lines

6=0, 6,@ 73 , the solution is (p+u// =-mxlog(z zo‘)“(z vzﬁ, ) where .z, = X, + iy, 2, = X, — iya,

32 N Further Suggested Réadihgs .

© W 3 D

6.
1 Continuum Mechanics: T.J. Chung,
2. Schaum’soutline of theory and p"oblm 10f continuum mechanics: @@drge R. Mas, McGraw-Hill.
3 Continuum Mechanics: A.J.M, Spercer, Longman,
4. Mathematical Theory of Continuum Mechanics: R.N. Chatterjee, Narosa, Puhhshing House,
5, Foundation of fluid mechanies: S.W. Yuan, Prentice-Hall.
. Fluid Dynamics; J.K. Goyal, K.P, Gupta, Pragati Prakashan,
* Textbook of Fluid Dynamigs: F. Chorlton, CBS Publishers and Distributors.
* Theotyof Elasticity : Yu. Amenzade, Mir Publishers, Moscaw:
. Agpplied Elasticity ; C.T. Wang, McGraw-Hill, |
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PART-]
Paper-V
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1.9 introduction
“The Graphical User Interfeace (GUI) is one of the most revoluhonary changes to occur in the evolution of

moder computing system. In less than 10 years, the expectation of what the interaction between human and

comp ter would be like was changed from a terse, character-oriented system to the now more gxaphicsfiﬁcnted

systemn. This revolution has increased the aceessibility and usuability of computer systems to the general public. In

 this unit, the software MS-Windows, the most popular GUI for personal computers is discussed. Also the command
based software, MS-DOS is dnscussed shortly.

2.0 Objectives
+ In this unit, all basic operations such as copy, move afile, to create a folder, to deletea folder torenamea file

and folder. to get the file information, to increase the memory size, to back up utility, to check all drives, to access
accessoreis, etc. in Windows 95 are discussed. |
3.0 Kev Words and Study guides

© Copy, create, delete, folder, rename, back up, accessories.

4.0 Main Discussion

41 MS-DOS Basics o N
The Command Prompt : When you first turnon your computer, you wdl se some information flash by.

When the information stops scrolling past, you will se the following :
C:\»> - ' ,
" This is called the command prompt. The :ﬁashjng underscore next to the comménd prompt is called the

garsor. The cursor shows where the command you type will appear.

"Typing 4 command : Aftertypinga commanci, you must press ENTER. For example, to type a command

at the command promt, do the following :
¥ Type the following command at the command prompt : ver

* Press ENTER

Viewing the contents of a Directory : To view the contents of a directory,
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* Type the following at the command prompt : dir
* . PressENTER _ ‘
Some information will be shown. this is called a directory list. Adxrectory listisalist of all files and sub

directories thata dxrectory contains.

To view the contents of a directory one screen ata time,
© *  Typethe followmg at the command prompt, dir/p
*  PressENTER
One screen of mformatxon appears Atthe bottom of the screen, you will see the followmg message : Press
any key to continue. '
*  To view the next screen of information, press any key on your keyboard.

Repeat this step until the command prompt appears. .

To view the contents of a directory in wide format,
*  Typethe folIowmg at the command prompt : dir/w
'PressENTER - ’ ‘
“The directory list appears, with the filenarmes listed in wide format, Only filenames are listed. No informatic
about the files’ size or date and time of creation appears. ‘
* Ifthe directory contains more files than wil fit on one screen, you can combme the /p and /w switches

as follows: dnr/w/p

: Chnndmg Directories : Ina directory list, all the names that have <DIR> beside them are dxrectones To change
from the root directory to the another directory (DOS, saying),

*  Typethe following atthe command prompt : ed dos

*  PressENTER

The command prompt c;hanges. It should now look like the 1oilowing :

C:\DOS>
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The command prompt shows which directory you are in. In this case, you know that you successfully
changed to the DOS directory because the command prompt displays the dxrectory s name. Now the current
dlrcctory is DOS The cd command stands for “change dlrectory” R

“Changing Back to the Root Directory ;: To change to the root dlrectory do the followmg

*  Typethe followmg atthe éommand prompt : ed\

*  PresENTER '

We note that the slash typed in this command prdmpt isa 'backSIa'sli O, nota forwafd sfésh (N.No xﬁatter
.which directory you are in, this command always retums youto the root dxrectory ofa dnve 'Ihe root dnrectory

doesnothavea name Itis simply | retcrred to by a backslash (\)

Creating a Directory : To émte ka‘ directorj s oﬁ will use the md command. The md command stnads for “make
directory™. To create and change to a directory named' VU, - - |

¥ - Type the following at the command prompt : md/VU »

¥  PressENTER R

You have now created a directory named VU.

* To change to the new VU dxrectory, type the following at the command prompt cd\VU You now
createa dmectory withinthe VU directory, named MATH as follows:

*  Typethe following at the commands .Aprompt :md MATH

© % . PressENTER : G . c
* To changc to the MATH d:rectory, type the followmgawme command prompt cd MATH
*  PressENTER '

The command prompt should now look like : C:\VU\MATH>
*  Toswitch back to the VU directory, type the following : cd...
*  PressENTER '

Deleting a Directory : To delete a directory, use the rd co;pmand. 'I’_hq rd command stands for “remove

Jirectory”. To delete a directory MATH, do the following:
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*  Make sure the command prompt looks like : C\vVuU>
*  Typethe followingat the command prompt : rAMATH
*  PressENTER

- Youn cannot delete a directory if you are in it.

Changmg Drives : To change to and view ﬁles ona dlﬂ’erent drive (F loppy dnve, saymg)

*  InsertF loppy disk.
*  Typethe followmg at the command prompt: a:
* Press ENTER

The command prompt changed to the followmg A >
* To view a list of files on the floppy disk in dnve A, type at the command prompt dir
*  Tochangebackto dnve C, type the followmg at the command prompt c:

*  PressENTER
The command prompt changed to the following : C:\>
To view fileson drive Awhendrive Ciscurrent:
*  Typethe following at the command prompt : dira:

*  PressENTER

Copying Files : To copy a file, you will use the copy command. When you usé the copy command, you
mmst include two parameters : the location and name of the file you want to copy, or the source, and the location
_.to which you want to copy the file, or the destination. You separate the source and destination with a space. The

copy command follows this pattern : copy source destmatzon To copy TEXT.DOC file from MATH directory to

fheVUdmectory ,
*  Retumtoroot directory by typing the following at the command prompt :
od\

* . Tocopy the TEXT.DOC file, type the following at the command prompt :
C:>copy CAVUMATH\TEXT.DOCCA\VU
~*  PressRETURN
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..................................................................................................

Or
*  Gotothedirectory C:A\VUMATH>

v To copy the TEXT DOC file, type the following at the command prompt
‘ C:\VUWMATH>copy TEXT DOC. C\VU :
Press RETURN '
The following message appears :1 file(s) copied. '
Cobying a group of files, wildcards can be used. The asterisk (*) wildcard matches any character in that
positionand all other positions that follows it. For example, to copy the files witha TEXT extension to the VU
directory, iype the following at the Edmmand prompt: copy*.txt C :\VU |

Renaming Files : To rename a file, you will use the ren comméhd. The ren command stands for “rename”. When

‘you use the ren command, you must include two parameters. The first is the file you want to rename, and the
second is the new name for the file. You separate the two names with a space. The ren'command follows the
following pattern ; ‘ - e S S

ren oldnamenewname
F or example, to rename the file TEXT. DOC to MKS. DOC in the directory C:\VU>

*  Type the following at the command prompt : ren TEXT.DOC MKS.DOC
*  PressENTER |

lﬁve‘!eﬁng Files : To delete afile, you will use the del command. The del*command'stands-fof “delete”. -
To dvslete TEXT.DOC file '
* . Delete the TEXT.DOC file by typing the followmg at the command prompt :

* del TEXT.DOC |
- *  Toconfirmthat you deleted the file sucessfully, type the following at the commannd prompt :

dir

Delcting Folders : To delete the MATH directory
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*  Return to the root directory by typing the following at the command prompt.
. *  Toseethedirectory : dir ,
- * - Remove the MATH directory : ¢ MATH -
*  To veryfy that the MATH directory has been removed,: dir
1 he MATH directory should hot appear in the directory list.

Fomratting a Floppy Disk : When you purchase new floppy disks, you must generally format them before you
canuse them. You must remember that any data already in the disk will be ereased, if you format the disk. To
format a floppy disk ’

*  Typethe followihg at the command prompt: format a:

~* . Press ENTER : :
o The. followmg message appears : Insert new diskette for drive A:
‘-~ and press ENTER whenready: . e i : g

*  Insert the disk you want to format indrive A. When you are ready, press EN’I‘ER :

When the format is complete, the followmg message appears : Volume label (11 characters, ENTER for
none)? o o - ‘
*  Ifyouhave another diskto:fonnats preSSY Ifnot, press N.

4.1.1. Freeing Disk space
There are two processes, by which the more disk space can be obtamed (x) dcletmg unnecessary files, and
(ii) using scan disk.
Deleting unnecessary files : To delete unnecessary ﬁles, we use the del command. We use the following
~gu1delmes to decide which files to delete: , :
*  Delete any. temporary files created by your programs. Some programs store temporary filesina
directory specified by the TEMP environment variable. To determine whether the computer has a

directory designated for tempoxary files, we type set at the command prompt, and then check the
value that MSDOS displays for the TEMP variable. periodically delete any files in the directory specified
- by the TEMP environment variable. : :
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*+ - Ifyouhave not used a file in a long time, we consider copying it to a floppy disk and then deleting it

from the hard disk.

Using scandisk to free disk space : We can use the scandisk command to recover lost clusters that are taking
~up space on our hard disk. A cluster is a unit of storage that can get lost when a program unexbectedly‘stops
nunning without saving or deleting temporary files properly. A lost cluster Is marked as being in use; but it actually
contains o useful data. Over time; lost clusters can accumulate and take ﬁp disk space. When scandisk finds lost
clusters, it prompts yoti to specify whether we want save them. If we choose to save them, scandisk converts them
to files that have a .CHK extension. We can then examine the contents of these .CHK files and delete them if they
contain information we don’t need. To recover lost clusters, do the followings:
*  Quitall running programs, :
*  Change to the hard diék yo:.. want to check.
*  Type scandisk at the command prompt, and press ENTER. Then type Y at the prompt.
*  Thescandisk program checks the drive for problems, including lost clusters. If scandisk finds lost
“clusters, it prompts you to specify whether you want to save them. To save the infonnationtfhg;lost ~
clusters, choose Save. The scandisk program converts any lost clusters to fileswith ~ﬁlenarnés such as.
~ FILE0000.CHK. It stores these files in your rootdirectory. .
-* .- Toexamine the contents of .CHK file; use morecommand, Delete any.CHK files you do not want
~ using the del command. |
* . Delete any .CHK files you do not want by using the del command For example, to delete the file

FILE000.CHK file, type the following at the command prompt: del file0000.chk-

4.2 WINDOWS 95/98

- 4.2.1. Introduction : : :
Microsoft Windows is the very popular Graphical User Interface (GUI) for personal computers. The GUI

has the following commion features:
*  Secondary user-input devices. Usually a pointing device and typically a mouse.
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. Point and shoot ﬁmctibnality. with screen menus that appear or disappear under pointing-device-

control.
Windows that graphically display what the computer is doing.

Icons that represent files, directories and other application and system entities.

s Dxalog boxes, button, sliders, check boxes and many other graphxcal metaphors,

~ The major benefits of Windows are :

. Multi-tasking : Windows provides non-pre-emptive multi-tasking support, users can have several

application in progress at the same time. Each applicatibnfcan beactiveina separatejwindfow.'

Commson look : All windows applications have the same basic look and feel.

~Data Scharing : Windows allows data transfer between application clipboard. Any type of data can be

transferred from one window with the'clipboard, etc.

4.2.2. Structure of a Window
- Depending upon the type of application all windoes may not have every element. Some parts, such as title

bax and menu bar, are common for most of the windows. The following is the standard window. Ina window there

are dtﬁ’erem parts Whi(.h are discussed below:

228

*

Control menu box. It is in the upper left comer of each wmdow Chckxng on the Control menu box

: s'opens the Control menu. The menu contains the options by which you can move, size, and close a

window whxle working with the keyboard.

- Title bar: It displays the name of the application, document, ora folder name.

"~ Menu bar: It lists the available all menus which contam alist of’ commands.

Scroll bars : There are two types of scroll bar : horizontal and vertical. These are used to move through
adocument when the entire document does not fit ina window.

Minimize button : When you click on this button, it reduces the window to an icron and arranges it on

- the desktop. Minimizing the application window does not quit the application.

Maximize button : When you click on this button, it enlarges the active window so that it fits into the

entire desktop.
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*  Restore button : Clicking on this button returns the window to its previous size if it is maximized or

* - Window border : It is the outside edge of the window. The window can be resized by lengtheningor
shortenmg the border.

*  “Insetion point : Itis a flashing vertical bar that marks the place where text or graphxcs areto: appear on

= typmg or drawmg ‘ '

* Mouse pomter An arrow used for pointing items. It appears if the mouse is installed on the system. o

* Clientarea: It is the area inside the window which is under the application control.

. «}gg&c\w ﬁl'.");'iifff': ‘
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. 4.2.3Some common tools
Icon:Itisused to mdxcate a symbolic representation of any system such as ﬁlc folder. address, books, and

applications and soon.A specnﬁc type of icon represents ¢ dnﬁ'erent types of ObjeCtS For example; a folder icon
contains a group of files or other folder icons. Double clicking on the folderi xcon causes a window to be opened

- Menu:lt dlsplays alist of commands available withina apphcatxon From the menu, the end-user can select
different opemnonslsu,,ch as File, Edit, View, Window, Help etc. Instead of remembering oommands,,at each stage,
‘amenu can be used to brovide alist of items, Mehu item can be invoked by moving the cursor on the menu item
and selecting the item by clicking the mouse. When a menu item is accessed it could cause oth_or commands called
- the pull-down menu. Pull down menu is used to present a group of related commands. ’

Dialog box:A dxalog box is used to collect the mformanon from the user or to present information to the
user. . :

Basie Techniques for working Aini"Win"dOW&
keyboard but orie needs to know both mouse and key Itech r
has two buttons where one is the primary mouse botton and the otheris secondary In wind wsﬁ the lett mouse
button is set as the primary button by default. The primary button is used to perform the majomy of the tasks
whereas the secondary button is to display shortcut menu for the current window apphcat:on The fouowmg table

: Usingamouse is usually easier and faster than using the

.shows the functions of amouse.
Term | "Meaning
- Click- | To quickly press and release the primary mouse button to selecta

singleitem. . |

'Doublenclick Toclick the primary moust button twice in rapid succession o

‘ carry out an action after the item is selected -

Point E - To move the mouse until the mouse  pointer on the screen pomts -

to the item of choice ' |

230 Directorate of Distance Education

st



* . by P
et e sn st naesn s sessersessnenenesenessssainenss MOAUIR 55 : DOS & WINDOWS 95/98

.

Dreg To press and hold down the primary mouse button while moving

' the mouse
Pointing to the item of choice, press and hold down the primary

Drag and drop
mouse button while moving the mouse. Release the mouse button -

on reaching the desired location to place the item

4,2.4. Starting Windows 95/98
- When you switch on the computer, after booting you will come directly to Windoes 95 screen, whichis

«alled the desktop (metaphor)-whose apnearance is as follows:
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When you click the right mouse button on the desktop, it gives the properties by which you can adjust
‘settings such as desktop color and background, screen saver.etc. On the desktop, there are different items discussed
Task bar : The barthat is generally at the bottom of the first screen i.e., the desktop is called ths taks bar.

It contz.ins the Start button, which is used to quickly start different actions such as to find a file, to invoke an
" npplmtrcn etc. By default, the task bar and the Start menu are always visible shen Windoes is running, To customize
the task bar, right clrck onit, and then click on the Properties. . o . :
‘Start Menu ; When you click on the Start menu, thena popped-up menu will be displayed on the desktop.
This contains different options which are as follows: i

Option ' * Function
- Programs - Itdisplays alist of programs. ‘
Documents : It dispiays a list of documents that you have opened
previously. | | o _
: Settmgs EER | f It displays a list“of systern wmponents for which you .
Find - n enables you to find folder ﬁla, shared computer, or
- mail message : ' '
Hlp | hstantshelpsbout Windows9s e
Rmn ‘ Itstartsa program or opens a folder when you type an
» ,MSDOS command | ’
Shutdown e It shlutszdow,n or restarts your computer.g LT

When you clxck onthe optxon that hasa nght pornted arrow, a cascadmg menu appears If you want add or
remove programs to and from the Start menu, then follow the followmg steps:
*  Clickthe Start button and the choose the Semngs option
*  Clickonthe Taskbar
The Taskbar dialog box is displayed.
*  Clickonthe Start Menu programs tab
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*  Click on Add button and then click Browse to locate the program you want to add

*  Doubleclick to choose it

*  Click Nextand then double click the menu on which you want the program to appear
*  Type the name that you want to see on the menu

* Click on the Finish buiton

*  IfWindows prompts you to choose an icon, ¢lick one and then click the Finish.

Sct-up Screan Savet : Itis setto save thé wear and tear of the screen. When your computer is idle for the number
of minutes specified in the Wait box, then the screen saver starts to action, After ithas started if you want to remove’
this then move your mouse or press any key on the key board, The following steps are required to set up a screen
saver ; ‘ ‘

* * Rightclick on the desktop

- A pulled-down menu is displayed.
*  Choose the option Properties from the pulled-down menu
The display properties dialog box is display@dg
*  Click on the Screen Saver tab o : ,
"% Clickonthe down arrow under Sereen Saver field and browse through the different screen savers

* . Choose the one that you like o ’ -

*  Clickon Settings button to customize the way it works

*  Youcanset the password by choosing the option Password Protected

*  Click on the Set Password button when it is activated and specify the password

*  Sotthetimings : |

*  Click on the OK button,

Shorteut Menu ; 1t is the menu that appém, when the right clicks on any item, shows the most frequently used
commands for that item. To use shorteut menus, Right-click a file or folder. You can also right-click an empty space

on the taskbar or desktop. To display a sherteut menu that lists every available command for a file or folder, poin¢
o the file or folder, and then press SHIFT while right-clicking it. '

Directorate of Distance Education 233



Aladulejﬁ DOS & WINDOWS 95/98............. Cerrernesroent e et e ggsasrasnsones

Shutdown Windngg 95 ; To shut down your computer properly, do the following:
* . Click Start button
*  Choose Shut Down from !h@,. ggpp@cisup menu
. * " Thenclick Shut down. o
Impostant : do not tumn off your computer until a message appears telling you that it is safe to do so.

425 Maliaging Windows 95/98
- Windows 95 provides a lot of utilities for managing your system. These utilities include like disk utilities to

mainiain disks and access the maximum availgble space on the disk, Thedifferent utilities by which you can manage

Wmdow.s 95 are discussed below,

4.2.5.1 My Computer : It is the place wheie the things you have on computer like programs, documents; data
tiles are accessible in Windoes 95. Ifyou want see what is on your computer, then the following steps are required
*  Doubleclick on my My Computer icon
A window containing differenct items is opened
** Doubleclick on the icon for the drive you want to look at -
Windows displays the files and folders on the drive. Folders can contain ﬁles, programs and even other |

folders.
* To openalfile or folder, double click. it.

Action of right click on adrive, control panel and printer : Whenan object among the drives, control'panel,

and printer, is selected, the different options are displayed which are as follows:-

Option . ~ Function
Open Itopensthe selected object ina window
Explore . 1. Itopensthe explorerto se¢ the file structure ofthe drive
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TRl | it helps you search for files on the selcted rive or
R anywhere onthe ﬁﬂinggygtem ,
Sharing It lets you share the selected drive with @ther’uaersm
your organization that are conneeted on your computer
"Format | herasesor formates the selected drive | |
Create Shortcut"‘ It places a shortcut for the object on Windows 95
: o desktop for quick access. | o
Properties T displays the mfonnation about the selected objgci.
C§ose : . Itclosesthe open window.

Creating a shortcut ; A shortcut is a quick: way to start a program or opena file or folder without having to go to
its permanent location in Windows Explorer, Shortcuts are especially useful for programs files, and folders youuse

frequently, There are three ways you cancreate a shortcut:

‘To create a shortcut in a folder:
" .1. - InMy Computer or Windows Explorer, click the foldg: in Whlch you want to create the shortcut.

2. OntheFilemenu, pomt to New, and then clxck Shortcut.
3. Follow the instructions on the screen. .

Toputa shortcut on the desktop
1. . InMy Computer orinthe right pane of Windows Explorer, click the ltem, such asafile, program,

- folder, printer, or computer, for which you want to create a shortcut.
2. OntheFile menu, click Create Shortcut.
3. Drag the shortcut icon onto the desktop.

' To change any settings for the shortcut, such as what kind of window it starts in, right-click the shortcut,

~ andthenclick Properties.
*  Todeleteashortout, drag it to the Recycle Bin. The original item still exists on the disk.
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4.2.5.2. System settings : The system can be personalized by making interesting and ugeml changes to Windows
95 settings. There are many settmgs you can make to make your workplace more interesting. Some of these are
menticned helow: '

*  Change background of your desktop

*  Adjust the double-click speed for your mouse

. Change the capacity of the Regycle Bin

. Change number, currenoy, time and date settings

* Change printer semngs

*  Change the number of colars your monitor displays

*  Change settings for network service

¥ Change the screen resolution -

* . Hawe your monitor automatxcally tumn off

o Change display fonts

*  Protect your screen by setting up a screen saver

*  Configure multimedia devices

*  Vieworchange resource settings for g hardware device

* Enable multiple users to persbnalize ggtﬂngs

All these are explained below. You can start the setting of any cheige with the fnllowing atﬁps

*  Click on the Start menu on the desktop

~*  Choose the Settings option from the popped-up menu
V A cascading menu is displayed. |

* - Choose the one you want to do

4.2.5.2.1. Control Panel : When you click on the option C@mml Panel from the ggscading menu of Settlngs,
a window is opened that contains the icon of the utilities for changing hardware cenfiguration or gustomizmg the
Windows 95. You can also access the utilities of Control Panel, if you click on My Computgr and then on Control
Pariel icon, The icon of utilities dre Accessibility options, Add New Hardware, Add/Revae Programs Date/
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_‘Time, Display, Fonts, Joystick, Keyboard, Modems, Mouse, Multimedia, Netwotk, ODBC, Passwords, Printers,
-Regmml Settings, Sounds, System whose setting are discussed as follows: - SR
: Dtte and Time : To update date and time settings of your system, follow the stepsglven below:
% Select Date/Time icon from the displayed icons and double click on it
‘The Date and Time properties, 'dialog‘bdx isdisplayed.
*.. Clickthe down-arrow in the month field to choose the correct month
¢ Click the up or down arrow inthe year field to chidose the current year
" *  Click the current day in the calender
*  Setthe new time field by clicking the up or downarrow or.click anywhere in the text box and type a

new number n _ ‘

- To setthe correct time 7one, click the Time Zone tab and then click your: current location onthe map
‘of the world that is displayed.

- *  Click on the OK buiton.

Add New Hardware: Tosetupa new hardware, do the followings :
*  Choice the Add New Hardware icon '

¢ Doubleclickonit ,
The Add New Hardware wizard is displayed. It is recommendéd that you let Windows detect your

hardwareor installed its components in your computer before running the wizard.

*  Follow the instruction on your screen.

Fohts :In WindoWS 95,_there is a collection of Fonts. The fonts can be viewéd, added, or removed from the
available font list, which s discussed below. | |
To view fonts on youf computer, the fqllowing steps are required:
*  Double click the Fonts icon to open the Fonts Folder
*  Doubleclick the icon for the font

~ "Toadd anew font to your computer, do the followings:
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Open the Fonts Folder

On the File menu, click Install New Font _

Click the drive and folder that contain the fonts 'you want to add

Double clickthe icon for the font you want to add - _

To select more than one font to add, press and hold down the CTRL key, and then ¢lick the fonts you

want, To select a range of fonts in the’ lxst, press and hold down the SHIFT key while draggmg the

cursor over the fonts,
Open the Fonts folder

~ Click the icon for the font you want to delete

Click delete on the File meau

To select more.than one font to delete, press and hold down the CTRL key, and then click the fonts

_you want.

Look of Windows : It includes wallpaper and pattern in the background of the desktop, cursor blmk rate or item

size, colorand fonts, which are discussed as follow:

The steps to change the background of your desktop are as follows: -

*

“Choose the Display icon and double click it
- The Display propertied dialog box is displayed.
- Inthe Pattern or wallpaper list, click the pattern or wallpaper you want to use

To cover your entire screen with a small wallpaper i image, click Title
To center a wallpaper image, click center
Click on the Apply button and then OK.

The steps to change the way the items on your desktop look are as follows:

®

28

If you want to change the appearnace of only one screen element, click that element in the item list.

Then change the settings in the Item Size and Color and Font Size and Colorareas.

" Ifyouwant to change the appearance of all screen elements simultaneously, click an appe&maxce

scheme in the Scheme list.
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The steps to use larger or smaller display fonts are as follows:

‘.

*

.

In the Font Size box, click the size you want your dxsplayed fonts tobe

To customize the size of displayed fonts, click Custom:
If the Font Size area is unavailable, make sure your Desktop Area setting is lugher that 640 by 480

" pixels. If 640 by 480 pixels is the only setting available to you, you cannot change your display font.

To ad;; ust the rate at which your cursor blinks, drag the slider in the Cursor Blmk Rate area.

Key_board + Keyboard layout affects which characters appear when you press the keys on your keyboard.

Thé steps to change the keyboard layout are given below:

L

*

*

*

L

Choose the Keyboard icon
I'ne Keyboard Propemea dialog box is dnsplayed

Click the language tab
Click the Properties button

Select adifferent keyboard layout.
Click OK button,

'~ - The steps to change the way your keyboard responds are as tollows

&

L

Click the Speed tab after clicking the Keyboard icon

JIf you want to adjust how much time elapses before a held down key begms repeatmg, drga the

‘Repeat Delay slider |
Ifyou want to adjust how quickly characters repeat when you hold down a key, drag the Repeat Rate

slider

Click OK button.

Mouse : The settings for the mouse include the button configuration, double chck speed of the mouse pointer
speed and pointer trail, mouse pointer shapes, and smtchmg overto dlﬁ’erent mouse driver. Tochangethe settmgs

of mouse, follow the steps below

[ ]
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‘The Mouse Properties dialog box is displayed. It contains three tabs-Buttons, Pointers and Motion.
These tabs are for different purpose of settings. ' '
* Chposethe one that you wish to change the properties
The stepsto reverse your mouse buttons'are‘es follows:
*Click the Buttons tab,from the Mouze Properties dialog box
~*  Clickthe Right-Handed or Left-Handed in the Button Configuration
*  Click onthe OK button.
The stefas to adjust the double-click speed for your mouse are as follows:
*  Clickthe Buttons tab from the Mouze Prepertie's dialog box
*  Dragtheslider in the Double-Click Speed area
*  Totestthe speed, doubie-click the image in the Test area
*  "Click onthe OK button.
. The steps to change the appearance of your mouse pointer are.as follows:
*  Click on the Pointers tab from the Mcuse Properties diéileg box
* To change all your pointers at one time, selecta dxﬁ'erent scheme in the Scheme hst '
* To change only the pomter, clickit, click Browse and then double-click the ﬁlename of the pomter you |
want to use ‘ '
*  Click on the OK button.
The steps to adjust the speed of your mouse pointer are as follows:
E Click the Motion iab frem the Mouze Properties dialog box
*  Dragtheslider in the Pointer Speed area
*  Click onthe OK button.
Changmg the speed of your mouse pomter causes the pointer to respond more quickly or slowly tothe
movcments ofthe mouse itself.
To turn on and adjust the mouse pomter trml the followmg steps are:
*  Click the Motion tab from the Mouze Properties dialog box N
~ *  Inthe Pointer Trail area, make sure the Show Pointer Trails box is checked
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*  Toadjust the length of the pointer trail, drag the slider

*  Click o the OK button.
Regional Settings : While installing Windéws 95, ydu have to selecta country, on which the number formats,
currency, time and date formats are depended. These formats are used in various windows programs. To change
the settings, the steps are as follows: | o

*  Select the Regional Settings icon ﬁ‘om the Control Panel

The Regional Setting Properties dialog box is displayed.
*  Select the formats abpropriae for your country
- % Click on the Regional Settingstab
*  Onthemap dxsplayed click the region and Windows 95 changes its formats to match that region. -
*  For specnal adjustmems click the Number, Currency, Time, or Date Tab and change settings
* Chck onthe OK button. '

4.2.5.2.2 Printers : The steps to change printer settings are as follows: -
*+ . Select the Printers icon from the Contrbl Panel and double click on it
* Click the icon for the printer you are using from the Printers window . - -
* Chck Propemes onthe Filemenu - s
The settings youcan change dcpend onthetype of printer you have
*  (Click the different tabs to see all of the optionsyoucanset.
The steps to set up a new printer do the following! *
* . Click the Start menu |
The popped up menu is displayed.
*  Choose the Setting option
*  Choose the Printer option
"% Select Add Printer icon from the Printers window
""‘ . .- Follow the instruction when Add Printer Wizard is opened.

*  Ifyou wantto print atest page, first make sure your printer is on and ready to print.
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4.2.5.3 Back up : You can use Backup to back up files on your hard disk. You can back up files to floppy disks,

" atapedrive, or another computer on your network If your original files are damaged or lost, you can restore them
ﬁ'omthebackup : :
‘The steps to start Backup follow the: followmgs

%

*

*

*®

* Click Start meny, then pointing to Programs

Point to Accessories
Point to System Tools
Click the Backup.

Ifyou do not see Backup on the Accessories menu, it is not mstalled To install the Backup utility, follow the

msuucuons givenbelow::

L

L]

*

»

Start the Add/Remove Programs utility from the Control Panel window 2

_ Click the Wirdows Setup ta':
. Click the Disk Tools option in the window

Then click OK to install the Backup utility, and then follow the instructigns on'the screen.

To add or remove a Wmdows component

*

*

- Notes

242

To open the Add/Remove Programs Propertles dlalog box at the Windows Setup tab,

Under Components, click the component you wantto add or remove. e

* Toaddall parts of the component; select its check box.
*  Toremove all parts of the component, click to clear its check box.

*  Toadd or remove some parts of the component, click Details, and then click to select or clear

check boxes for those parts.

You can also open the Add/Remove Programs Properties dialog box at the Windows Setup tab
by clicking Start, pointing to Settings, clicking Control Panel, double-clicking Add/Remove
Programs, and then clicking the Windéws Setup tab. | .

If you used a compact disc to install Windows, you will be promptgd to iqsert itinto your computer.
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4.2.6. Disk drive utilities .
Windows 95 includes utilities to fonn__at diskettes, check disket_tes and ‘hard. drives for errors, defragment
- disks and so on, Some of these utilities are discuésed below. To access thesé utilities, the following steps are
*  Click the Start menuand then select Programs
oo Choose Accessories |
* . ThenChoose the System Tools
The cascading menu that appea!s mcludes the various Dlsk Drive utilities,

| 4.2.6.1. Disk Defragmenter : It is used to rearrange files and unused space on the hard disk so that programs
~ runfaster. To speed up your hard-disk by using Disk Defragmenter, follow the mstructxons givenbelow:
*  SelectDisk Deﬁ'agmenter from the cascading menu of System Tools -
' Select Drive dialog box vis'appeared. | | ‘

~ * Select the drive you want to defragmenter

- *  Click the drive you want to defragment

. % Clickthe OK button s ,

*  Ifyouwantto change the settings that Disk Defragmenter uses, click Advanced optnon.
wom - Oliek Start button: RO SR VP SR S .
-+ While Windows degragments the selected dlsk1t the computer can safely carry out othertasks However,

the computer will operate more slowly. To temporanly stop Disk Defragmenter so you can run other

- programs at full speed, click the Pause button,

4.2.6.2 Increase Disk Spacé The steps to determine how much space is available onadisk are as follows:l
¢ Double click the My Computer iconand the click the disk you want to check

*  Click Propemes ontheFilemenu.
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A pie chart shows how much free and used space is on the disk.

The steps to create more dxsk space by using Drxve Space to compress both hard and floppy disks are as

follows:
| )  Fromthe cascading menu of System Tools, select Drive Space optxon
i) " Inthe Drives On This Computer list, click the drive you want to. compress
i)  Click Compress on the Drive menu.
) Click Start
v)  Ifyouhave not backed up your files, click Back Up Files, and then follow the instructions on your
. screen. When you are done, proceed to step (vii).
Vi) Clxck Compress Now
vi)  IfWindows prompts you to restat your computer, click Yes e |
viii) . Ifyouwant to free up "m‘ore dié!c space after your computer restarts, start ihe'Disk Space Troubleshooter -
4.2.6.3. Check for Disk Errors : To check your disk’s surface, files and folders for errors, follow the following
steps: .
"* F roxﬁ the Cascading menu of System Tools, select of option Scan Disk
- *  Clickthedriveyou wanttocheck - et : "
*  Click Through. If you want to change the settings Scan Disk uses when checking the disk’s surface,
click the Options. If you want to change the settings Scan Disk uses when checking files and folders,
“click Advanced. |
*  Click Start button,
4.2.6.4 Format Disks |

Formatting a disk means establishing the tracks and sectors on the disk where files will be stored. It is
remembened that formating a disk removes all information from the disk. You cannot format a disk if there are files
openon that disk. Ifthe disk has been compressed use Drive Space, to format the disk. To format a disk, the

following steps are required:

»
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Ifthe disk you want to format is a floppy disk, insert in into its drive
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* Double-click the My Computcr icon, and then click the icon for the disk you want to format. Be sure
‘not to double click the disk icon, because you cannot a disk if it is open in My Computer or Windows Explorer.

*  Click the Format on the File menu. |

*  Click OK button. .

* The various options for formatting disks are ir the following table.

‘ Option , Function

Capacity ~ | Ttcould be low-density or high-density
~ Format Type: Quick . Formats the disk without checking forerrors
(erase) ’ '
Format Type : Full Checks for the disk erros and then reformats it - -
- Format Type : Copy | Ccpies the system files to the formatted disk to make
System Files Only it bootable |
Label .| Typethelabel name forthedisk
‘No Label | Thisoptionis selected if you do not require the label
'| - name for the disk after formatting it
" Display Summary To get information about the bad sectors (if any) after
oo swhenFinshed . . . | .ﬁxe,:diskifonnat"ted« e v b 1o s+ et b nse
. Copy System Files ~ Copies the system files during the formatting process.

4.2.6.5. Set-up user profiles : If morethan oné person uses the same computer, each one can cutomize the
‘settings according to his/her needs. In this case, each'user hasto create a profile so that when he/she logs on, their
personal windows settings are used. The steps to set-up user profiles are as follows:-
*  Click the Pass;WGrd ic;an from the Control Panel
The Password properties dialog box is di‘splayed, ,

*  Choose the 2nd option under User Profiles. When it is selected, the options under the head User

" Profile Settings are highlighted. -
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~ *  Choose the options as you reqire
*  Click on the OK button. o
This enables multiple users to personahze settmgs
The steps to log off your computer so someone else can use it are
* - Click the Start button, and then chck Shut Down ,, t
* Then click Close All ProgramsAnd Log OnAsADtﬁ'erent User

4, 2.7 Files and Folders . i
. The File system in Wmdows 95 is based on folders. Here folders hold files and other folders Windows

Explorerisa file management utility that provides a method of accessmg the file system in Wmdows 95.By
vExplorer you geta view of your entire file system To open Explorer, the following steps are follows

*  Select Programs from the Starf mznu or rlght click on the Start menu

*  Select Wndows Explorer from the cascadmg menu of Programs 1

The Explormg window is displayed. .

In this Explormg window, there are two parts lett and nght On the left part you can view the desktop,
drives, and folders. When you click a drive and folder, its contents are dxsplayed oh the right part. From this
5wxn_dow you can copy, move files from one folder toanother very easxly.
4271 Files R , |

" Files contain information like text, numeric and graphics, Initially these are created in the memory of the

- system, but then these are saved to a disk storage device. There are different types of files that are categortzed by |
the type of information they hold and these are discussed below. '

“File | TypeofInformation ' | | Example.
Program Files These contain computer readable code written - Calc. exe, Clock exe B
by pm_gmimers n e |
Support Files Some programs store informationinthesefiles, | Config, sys,

but they cannot execute or started. These files
have extension name as OLV, SYS, DRV and DLL
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Text Files These contain alphanumeric characters that Sample txt., |
follow the ASCII format Autoexec.bat
GraphicsFiles | These contain visual or graphic Rivets.bmp
information | o .
Multmedia | Hold soundand video informationin digita Passportmid
Files ' formi 4 | & ' | »
FortFiles | These contain information about various fonts | Coure.foc
Other Data ,Thes.econtain numbers, names, addresses, |
“Files '~ and other information created by database and
" spreedgheet programs

There are different operatxons on F iles, whichare discussed below:

Naming Conventios of a File in Windows 95 : For'nétnihg  file there are certain rules in Windows 95. These

‘are stated as follows:

¢ Windows 95 supports 256-character filename in both upper and lower case.

* F iles in the same folder cannot have the same name

"‘; You can use multiple period-separated extensions, like Budget. Sales 2006. Thisis also a strategy for

long filenames.
*  Namescan mclude spaces but not special characters such as ‘7\""!<> "

Searching a File : The steps for searching a file are as follows:
*  Click the Start hutton and the point to Find
*  Click Filesor Folders |
" Typeallorpart of the file’s name in the Named box

¢ Ifyoudonotknow thenameofa file or want fo refine the search, click the Date Modified or Advanced |

tabs
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*  Ifyoutype upper and lower case letters in the Contammg TExt box on the Advanced tab, and you
| want the search to be case-sensitive, chck the Options menu and make sure the Case Sensmve box is
checked. ‘ ; :
. - Ifyou want to specify where Windows should begin its search, click Browse
~*  ClickFindNow | LT
. If you want to save only the search cnterxa, make sure the Save Results box is clear
. Click the File metiu, and click Save Search Anicon representmg the search results or search criteria
. ‘ _ - appears on your desktop v :
Creatinga Fxle : You can use Notepad to create or edit text files thatdo not require formatting and are smaller
than 64 K. Notepad opens and saves text in ASCII (text only) format only. To create or edit files that requires
formattmg or is larger that 64K, uses WordPad. It is text editor for short documents.

Copy a File : The files can be copied from one destination to another. The steps to copy a ﬁle are as follows
*  In My Computer or Windows Explorer, chck the file you want to copy. Hold down the CTRL key to:
select more than one file to copy and click the items you want
*  Click the Copy option on the Editmenu _ . o
“  Open the folder or ‘disk where you want to pot the copy |
* . Click the Paste optxon from the Editmenu.
| The steps to copy a file to a floppy disk are gwen below
o Insertthe ﬂoppy diskinthe floppy disk drive o ;
. In My Computer or Windows Explorer, click the ﬁle you want to copy
*  OntheFile menu, point to Send To
*  Click the drive you want to copy the file. '
Move a File : The steps tomove a ﬂle are given below:
. In My Computer or Windows Explorer, chck the ﬁle or folder you want to move. To select more than
one file tomove, hold downthe CTRL key, and click the items you want o
*  Onthe det menu, chck Cut
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*  Open the folder where you want to put file
~ *  Click the Paste option on the Edit menu.
OR-
* I drag and drop technique, you use the mouse toclicka .ﬁle‘ or folder and drag it to hew location. This
‘ technique is uséd when both the souxce fileand the destmatxon folder, drivé or other object tomove the
~ source to are visible. .
* Delete a Fite : The steps to deletea file or folder are, glven below
* - InMyComputer or Windows Explorer, locate the file you want to deléte
* »Clxck the file
‘ *  Click the Delete option on the File menu. ‘
. Retneve a File : If you want toretricve a file you have deleted, look in the Recycle'Bin: Yourdeleted file remains

in the Recycle Bin until you emptry it. You cen also drag file or folder icons Recyéle Bin icon. If you press SHIFT
while dragging, the item will be deleted from your computer without being stored ihthe RecyclevBin. .
Finding information on a file : Sometimes you may need to get the following infomjation, about certain files,
whicharciternized below: o | s
¢ What types of file is this?
% Whatisitssize?
*  Whenwasit creaied orlastmodified?. .. .
¥ Whatare the attributes of the file?
To getall of this information, do the followmg
_* ' Right-click the file on which you want the information
*  Select Properties from the short-cut menu that is displayed
A dialog box is displayed. It gives the information on the selected files.

4.2.7.2. Folders

You now how to create, to delete, to controlling accessto a folder.

* Creating a Folder ; The steps to create a new folder are given below:
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%

®.

In My Computer or Windows Explorer, open the folder in which you want to create a new folder

" Onthe File menu, point to the New option, and then click the Folder option

The new folder appears with a temporary name.

- Type a name for the new folder

-Press Enter

Renamimg a Folder : To change the name of folder, follow the following steps :

."

»

*®

%

InMy Computer or Windows Explorer, click the folder you want to rename. You do not need to open

it. -

Click the Rename option on the File menu
type the new name

Press ENTER

-Viewing a Folder : To see the hiera-chy of foldersona disk drive, the steps are :

*
*
L

’l

Click the Start button

- Pointto Programs, and then Click Windows Explorer
- Click a folder on the left side of the window to display its contents on the right

Click the plus signs (+) to display more f’olders

Note : To change the size of either side of window, drag the bar that separates the two suies To quickly
. openafolder and display its sub-folder, double-click the folder on the left side of the window,-

Deleting a Folder : Deleting a folder removes all files and subfolders within it, follow the following steps:

]

*

L

OR’

®

OR

250

In My Computer or Windows Explorer, Iocate the folder you want to delete

Click the folder
Click the Delete option on the File menu.

Right-click the folder and select Delete from the menu
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*  Right-click and drag the folder to the Recycle Bin. .
The deleted files can be retrieved from the Recycle Bin. But if these are removed from recycle bin also, then

it is not possible to recover the deleted folders.

Cozxtrblling access to a Folder : You can control access to your folders by using passwords ér By listing
names of people you want to have access these resources, To contro] access to a folder, the steps are as follows:
I My Computer, click the shared folder you want to limit access ot '
*  OntheFile menu, clici( Properties
*  Click sharing _
*  Ifyouare using user-level access control, click Add to specify the people you want to be able to use
y;our'resources |

*f you are using share level acczss control, type the password you want to use for the folder.

4.2.7.3. Recycle Bin ; L

* The Windows 95 Recycle Bin protects you from accidentally deleting files, This is located on the desktop.
-You.san use it retrieve files you deleted by mistake, or empty it to create more disk spacé, The Recycle Bin holds
deleted files in a queue, with the most recently deleted files on the top. The oldest file is permanently deleted when
the.queue becomes full,-as Recycle Binhasa limited amount of space; T hedeieted files can be recovered by
dragging them out of the Recycle Bin to an appropriate drive and folder. The Recycle Bin folder hasa menu with
many familiar options, for example, the View option is to change the way files are listed or rearrange the orderof -
‘files, To elear out the Bin, choose Empty Recyele Bin from the File menu. Selecting them and choosing Delete on
the File menu can also delete individual files. This will'i:e,rmanently delete the files without any chance of recovering

4,2.8 Program and Accessories ,
Windows 95 comes with a set of programs called Accessories, These accessories are used to write, paint,

calculate, and perform a variety of other tasks. To run the accessory programs, follow the following instructions:
*  Clickthe Start button | |
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*  Click on Programs and then click on Accessories option

*  Click on the program you want to run from the cascading menu.

The steps to run other programs that have been created by the users are as follows:

*  Click on the Run option from the Start menu

Run dialog box is opened.

*  Enter the path name of the proéram you want to run, in the Open text box.

~* - Ifyoudonot femember the name of the file, click on the Browse button

* In the Browse window, look in text bos lists the available drives, folders, and files. Click on the down-
arrow. | ‘ |

** Toseeinside a folder, click it. The box below shows the folders and files in the selected location

* Dm‘xble-c’lick a fblder orfiletoepenit

*  Oncethefile is located, click on Open and then click on OK from the Run window.

Calendar : Windows-Calendar is used to view the current month’s calendar ihat shows the day and date,
and alsb the current day showing the ﬁmings to keep track of your appointments. To display either of the mentioned -
views,’ do the followings :

% Clickonthe Viw option

* ' Select whichever you require.

- Caleulator: You can use Caléulaten instandard view tdperfomﬁ»simple calculations, or in scientific view to
perform advanced scientific and statistical calculations. To start the Calculator, do the followiﬁg : |

v click the Start button _

. Pbint to Programs from the Start menu, then pointing to Accessories

*  Click the Caleulator option. o

Character Map : It works only with Windows based programs. This is used to inserta speciél character
_into adocument. The steps to inserta special character in the document ;

 * Select the Character Map from the cascading menu of Accessories

* Click the Font box, and then click a font
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*  Tomagnify a character in Character M’ép, click it and hold down the mouse button. Double-click each
' character you want. The character(s) will appear in the Characters To Copy box
*  Click The Copy option . ‘
. *  Inyour document, click where you want the character(s) to appear, click the Edit menu, and then click
Paste optxon
*  Selectthe character(s), and then change them to the same font you used in the Character Map
Paint $ It is a bitmap painting program with a full set of painting tools and a wide range of colors, You can use it to
ctaatc, edit and view pictures. The picture created by Paint can be pasted into another document you have created
ot use it as your desktop background. To work with Paint, do the following steps : '
*  Selectthe Paint option from the cascading menu of Accessories
The Paint window is opened which,consists of a workspace, or canvas, where you paint pictures. To
the left of the canvasa is the Toolbox, whizii contains asetof péinting tools. The color palette isat the bottohx ofthe
canvas. The selection box is on the left side, where you select the width of lines or pen tips to use for the Bursh,
'Line, Eraser, and other tools.
* Topaint, select atool, acolor,anda liné, and the start painting on the canvas.
WordPad : It is a text editor for s'ho‘rt documents. To start WordPad, do the following:
*  Clickonthe Start menu , o
- Point to Programs, and the click on the AéceSsories option
*  Choose the WordPad from the cascading menu
When WordPad .is runniné, you can do the following:
*  Specify the initial page layout for adocument, such as paper size and margin settings
* - Type, edit, and delete text, as well as copy'?or move text from one place to another.
*  {hange the font, style, and size of characters, and change the alignment and indents of paragraphs.
¥ Search forpre viously‘typed text or replace text with new text.
*  Create compound documents that contain pictures, spreadsheet data, charts, sound, and video éneated

in other applications.
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Notepad : You can use Notepad to create or edittext filesthat do not‘requine formatting and are smaller than 64K.
| Notepad opens and saves text in ASCII (text only) format only. To create oredit files those. require formatting or
are large than 64K, use WordPad. To start, follow the following:

© *  Click Notepad from the cascadmg menu of Accessories.

5.0 Unit Summary |
From this module, you can learn all basic operations such as copy, move a file, to create a folder, to deletea

folder, to rename a file and folder, to get the file information, to increase the memory size, to back up utility, to
check all drives, to access accessories, etc. in Windows 95.
6.0 Self Assessmen‘t Questions
1. Whatare the parts of Windows?
- How to set up the screen saver?
Name the various disk drive utilities.
How can you add Windows 95 components or accessories that were not installed before?
What is the function of Windows Explorer?
Whatisa Recycle Bin?
What are the Accessories of Windows?
~ Change the mouse double click speed.
Show how to retrieve the file from dustbin. -

0 0 NS W s W N

- 10." Add one program in Start menu.
7.0 Suggested further Readings
1.  Microsoft Windows 95 manual
2. IGNOU Books

R O conw
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1.0 Introduction

MS-WORD 95 is a word processor, whichisa software package that helps you {o create and edit a document
ﬁm@h fuster than the usual manual ways. The followmg functions can be accompﬂshed by a word processor.

. Creating and typing a document through the keyboard

® Savmgmedacument

Correetmg, deleting and msertmg charactem, words, lines and xmagw

‘ Openmganexnsungdwwnent S .

o  Moving of coping paragraphs orimages &om one placetoanothet
e Charigmg the texct fontand style’ ‘

. . Chéckmg for sﬁeihﬁg ertors

v Prmtmg the documeﬂtmvanous formats

- 20 Objechves

| The dlﬁ‘erent techniques are dxscussed in ﬂus unit, by w!uch a document can be prepmd completely and easily.

30 Ke)Words and Study guides .
Editing, Savmg,Openmg,Co_pmg, Pasting, Moving;&ligmnent;?mn&?ﬁnﬁng’,sSpell Checking .. ... ..
4.0 Main Discussion T |

4.1 s:.;a,‘,g MS-WORD

To mvoke MS-WORD first you see thei 1con Mlcrosoﬁ Word on the desktop Ifthere is the icon then double click
on the icon. This displays a document window. Otherwxse follow the following steps to invoke MS-WORD.

e Clickonthestart buttonin the taskber.
"o Selectthe Programs option from the start menu.
‘e Clicon the Microsoft Word option or Click MS Office groupand then Click on the Microsoft Word.
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Thiis invokes MS-WORD and simultaneously opens a word oocumem window.,
 4.1.1 The FirstMS-Word Screen |

When the word is started anew arid blank document s appears on the word screen. The various parts on thxs screen
are sbown below'

WENINARE e :

The Word document window has the following basic. components:. ... ... ..

¢ Titlebar: It displays the name of the program, the name of the currently active word document, the
control menu icon, the maximum button, the minimize button and the Restore and close buttons.

o 7Menu bar Itis posxtloned below the Tnle bar It contams options like File, Edit, View, Insert, Format,
Tools, Wmdow and Help each of these menu bar items has a  drop-down menu.,

° 'Ioolbar' It contains the buttons that provide quick access to commonly used commands. Clicking a
button has the same effect as sclecting the command from the menus, but can be donw in a single -

action.

e Ruler bar: Itallows you to accurately set the layout ot \he document, It allows you to set tabs, mdents
and change pagé mar gms.
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o  Statusbar: Itdisplays information about the active document or the task on which the user is currently
working. Thisincludes the page number, the column and the line number on which the cursor is positioned
and so on. The status bar is positioned at the bottom of the window.

e Scroll bar: Ithelps to scroll the contents of a document. The Word document consists of two scroll
" bars: '
@ Vertical scroll bar : THe vertical scroll bar is used tomove a document vertically. It has four

buttons, those with single arrows allow,the user to scroll up ordown in the document one line at
atime whﬂe those w1th double arrows allows the user to scroﬁ byone page ‘

(i) Honzontal scroll bar ‘t is used to move the document honzontally

o Workspace: Itis the area m the document window where the user can type the text of the document }

4.1, 2 To Create a Document
Tocreate anew document at any time, fol low the following steps

Select the New option from the File menu or click the new button onthe standard toolbar. A new
dtalog box wxll be dxsplayed
J Select the Blank document I’con.' |
o Click on the document radio button inthe Create New box.
° | Click onthe QK button. “
\ blank new document is dispiayed. |
once and becomes the active document.

When youopena documen't it is placed on the top of any existing

4.1.3 To Open a Document
’lc guickly open one of the last documents you worked on, choose it from the File Menu. Generally to open the

existing docurnent the following steps are required:
Select the Open option from the File menu.
An Open dialog box will be displayed.
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- Select the appropriate drive and folder in which place the file is saved.

o '[ype the name of the file to be opened in.t’hev File name box or select the file &om the list.

e  Clickonthe Open button

4, 1.4 To detText

When you open a new document in Word, the insertion point is at the top of the document, ready for you to begin
typing. Typing textin MS-WOR]j is very easy and straight forward task, because of the useful word processing
featutes suppon;ea by it. When you create a new document in Word you can just start typing. Press the Enter key
only when you havé finished a paragraph MS-Word automatically moves the text to the next hne when it reaches

the right edge of the screen. This feature is known as word-wrap,

When: you enter your text, you ar¢, quite likely to make mistakes. 'Cdrrectib‘nsbf these mistakes aer called editing,
Editing text includes selecting, deselecting, ¢ leting, i inserting, replacing text Before editing can begin, the insertion
point (cursor) needs to be positioned at the locatxon where the changes have tobe made To move thecursor the

followmg key and key combinations are required:

Name of Key(s)

Moves the Cursorto

Up arrow, Down arrow, Left
arrow, Right arrow -

One character up, down, left o

and right

Ctrl +right érrow

Next word

Ctrl + left arrow

Previous word '

Beginningiof the line |

"Home

| End | A End of the line
Ctrl + Home Begmnmg of the document
Ctl+End - i

| End of the document

‘Selecting text: In order to perform any edxtmg operatxon onthetextina document, the text needs to be selected.

The stepsto selecta text are as follows:

e Position the insertion pomt at the beginning of the text to be selected.

260
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',0 Hold down the left mouse button and drag the mouse in any direction across the text to be selected.
The selected text will be highlighted.

Deleting text: Text to be deleted by using either the “Delete” or “Backspace” keys Delete removes smgle
charac ter to the right of the cursor, while backspace removes smgle character to the left. Block deletions make it
eaey to delete sentences, paragraphs and sections of documents. Once you have selected the text you wnsh to
remove, pressing the “Delete” or “Backspace” key removes it from the document '

Moving text: To move the text from one location to another, do the followings:
o  Selectthetexttobe mot/ed
e Selectthe cut option from the Edit menu. o
o Position the insertion puint at the {ocation Qhere the tekt should appeeﬁ‘t
o - Select the Paste option from the Ed:t menu or click on the Paste button on the stendatd toolbar.
o o L
3hsd@gand dmp fedture cah be used to moye the text as kfo!flowszy |
) Seleet the text to be moved.
e Point to the selected text and holding down the mouse button. dra the selection to the desired location.
,‘" : Release the mouse button to drop the text | |

Inserting text: MS-WORD is normally in the insert mode. It oﬁ‘ers several ways of msertmg textintoan ethnngﬂ
Jdocument, The simplest among all, is to move the cursor to the required position and start typing. The existing text

will be pushed and adjusted accordingly.

Replacing text: Word can combine the steps of deleting unwanted text, positioning the insertion point, and

inserting replacement text. To replace text, do the following:
e  Seclect the text to be removed

e  Start typing the new text

+  Theselected text w:ll be removed and the new text accommodated.
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Undoing Edits: The Undo command in the Edit menu is used to reverse actions, For example, while deleting text
the user presses the “Delete” key. After deleting unmedxately if you wish not to be deleted then click Undo option
from the Edit menu.

Coping and Movmg. Copmg means to make a copy of the selected text or graphxcs and insert it in another
location, leaving the original unchanged. The steps to copy text to another pa,xt of the same document orina
- different document are as follows: :

. Select the text to be copied
e Rightclick onthe highlighted text,
A shortcut menu appears near the highli ghted text.
. e  Selectthe copy option' from the shortcut menu.
, '9 Position the cursor at the loc'mon where the textis to be pasted
®  Selectthe Paste option from the shortcut menu,

-

_ If aportion of the text is to be moved to a different place, select the text to be moved and then use the cut option
fro: the Edit menu. The selected text will be copied and deleted, Now the Paste: optlon is enabled in the Bdit
menu. To paste the text, place the cursor at the starting pomt of insertion and chovse. det menu and then Paste

opuon The text wxll be pasted there.

v(‘hanging the Case of text: The “Change Case” command in the “Format” menu allow youto change the Case
of the characters of the characters in text without havmg to retype them. The steps to convert the case of the text °

o Seloctthe textto be changed

e Selectthe Change Case option from the Format menu
o A Change Case dialog box is displayed.
o  Select thedesired option

e Click onthe OK button.
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There is different option on the Change Case dialog box, Whi,ch is discussed below:

Option | e T Function E
| Sentence-case Capatalmes only the first letter in the selected sentences '
: IDWGI: eese - Converts all selected text to lower case letters “*:

Upper ease o Ec;everts all selected text to upper case letters ;, :

_‘I:xtle —e;e;; R F Capltahzes theﬁrst letter of each word of the selected text ,
'Ioggle case ) Changee upper case to lower case: and- lower case to upper :

!

" | case in alI selected text

hesgct vt e s+ a8y a2

Creating Bulleted and Numbered lists: You can easily createa bulleted or numbered list by selecting a list and
then clicking the “Bullets and Numbetirg’ " button from the “Format” menu. Alternatively, you can click either of
these buttons before youtypea list. When you have finishied typmg the hst, just press ENTER.

Formatting Text

The fonnatting‘ features in Word sets each document apaﬁ from others. Formatting a document includes assigning
fontsand fontsizes, ahgnmg text, dividing text into columns, adjustmg the line and paragraphs, and setting margins. -

All these are discussed below:

Changing Font Styles: Font refers to the manner or style in which text is dxsplayed in the dOCument anferent
fonts comam different collection of characters and symbols The procedures are given below: Lay Pk

o Sclect the text whose fom has to be changed.

. Chck onthe down-an oW to the right of the Font hst box i m the formattmg tool bar.

Alisi of available foms is displayed.

. Select a font from the list.

Changing Font Size: Font size is measured in points; Points and picas are used for measuring spacing, line
thickness, and so on. There are 12 points to a pica and six picas to an inch; therefore, there are 72 points to an inch.

The steps to change the font size are:
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¢  Selectthe text whose»fon't size has to be changed.

. Chck on the down-armw to the nght of the F ont Size list box inthe formatung tool bar,
Alxstofavaxlable fom sizesis isplayed. - |

: . Selecr a font size ﬁ'om the list.
' Altematxvely, Font styleand Font size both can be changed simultaneously by Font dialog box. 'Ihe requixed steps
are given below: : :

§ : Select the Font option from the Format meou |
The Font dialog box is .displayed :
. Make the appropnate selectxons n the F ont dlalog box

In the Effects‘area, a black check mark on anoption mdlcates that the seleeted textexhibits that pamcular .'
- - attribute. Acompletely clear box foran option indicates that the selected text does not have the specific attribute,
Color _Choicez To change the color of the text; do the following |

g Choose thetext of interest s UFIN ; R
e Choose desired color from the Color option box inthe Font tab of the Font d1alog box of’ Format

- memu. .
B _‘?,ClnckontheOKbutton S

4.1.5 To Savea Document

When adocument is typed, itis stored in the main memory of the nia'chine. In order to preserve the document for
fiiture use, it nceds to be saved on the auxxlxary memory ie. orf the dxsk The steps to save a doeument are as

ﬁ)llows.
s . Select the Save option ﬁfom‘ﬂxe File xﬁenu.
The Save As dialog box is displayed. |
e Typeafilenameinthe File name box.
'« Clickon the Save button

By defauit, the new documeng is saved as a Word document with an exteosiokxi{doc.
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41,6 ’I’o View a Document

"Tagre is different view leve] to make a document easier to visualize which is diseissed below:

3

Normal View: Normal View is the default view in Word. It is used for most of the typing and editing.
The area outside the text body-the area containing headers, footers footnotes, page numbers and
margin spacing-does not appear i in the normal view. To dxsplay the normal view, select the Normal

option from the Vlew menu.

 Outline View: Outime vzew enables you to view the entire conterxts of the documents, only ¢hapter

headings or only sec‘tlon headings. Using the outline view, you can quickly move through adocument
and rearrange several lines of text by moving the headings. To dlsplay the outline view, select the

Quiline option from the *iew menu.

Page Layout View: {t shows e page of the document as it will appear when printed. The users can
sroll outside the text body 1. »¢e such items as headers, footers, page numbers and f'ootnotes To

v~.“-‘

dispiay the page layout view, select the Page Layout optxon from the View menu.

Master Document View: It allows you to group multiple word documents into one large document. To
display the master document view, Selcct the Master Document option from the View menu.

Full Screen View: It is used when you want to maximize the typing area. The title bar, menu bar,

- toolbars, scroli bars and status bar are removed from the screen in full screen view. To display the full
screen view, select the Full Screen option from the View menu. -

42 To Format u Document

42,3 LineSpacing

The steps for linc spacing are as follows:

k

Select the paragraph(s) to space »

Select the Paragraph option from the Format menu.
The Paragraph dialog box is displayed.

Select the Indents and Spacing tab.

Select an option from the Line Spacing drop-down list.
Select a value from the At list box.

Clisk on the (3K buiton ta close the dialog box.
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Look at the Preview area to check how the formatted text would appear,
4.2.2 Paragraph Spacing - ‘

'Wo:d enables each paragraph to give unique before and after spacing if you wish. The spacing settings can be in
points (pt), inches (in), centimeters (cm) or lines (li). One advantage to adding space this way is that the spacing
before and after paragraphs does not change the point size of your text, Another advantage is that you can use
different spacing combinations for different purposes. You can define the amount of white space that should be
placed before and after paragraphs by usjng the Paragraph dialog box. The steps to add a smgle ling of white space
before or after a paragraph are as folows: ' ’ : '

o Select the paragraph(s) _
0 Open the Paragraph diafog box clicking_the Paragraph from the Format menu
~» Select the Indents and Spacii.g tab. | |
J Enterthe specification in the Before or After Spacing spin box
e Clickon the OK button. | | |
4.2.3 Setting Tab Stops

Working with tabs is  two-part process. The first step s to set the tab stops. Word effers five types of tab stops
-Lef, Center, Right, Decimal and Bar tabs. The default tab stop is lefl. The second step in using tabs is to press the
Tab key as the document is typed. By default the tab stops are setat 0,5 inch internals from the left margin. The
insertion point can be moved to the next tab stgp in the current paragraph by pressing the TAB key, Toset tab
stops do the following:

e Select the paragraph in which you want to set orchange tab stops

*  Select the Tabs option from the Format r;zcnﬁ | _

*  Using the decimal numbers, type the position of the tab stop in the Tab Stop Position box

¢ Selectthe tableader style you want: 1 for no leader, 2 for a dotted leader, 3 fora dashed leader, or4
for an underfined leader from the Leader group |

»  Click on the Set button tg set the tah stop

¢ Click onthe OK button.
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‘To move atab stop, point to the tab marker and drag it to a new position. To clear a tab stop, either drag the tab; ,
marker off the ruler or, use the Clear button on the Tab dialog box to clear the tabs.

4.2.4 Indenting Text

Indenting is making your text look more eye-catching, Indents are added to margins, thereby increasing the white
space and decteasing the text area for specific paragraphs. Indent can be performed in two ways:

¢ ByRuler
» By Paragraphdialog &:':ox

By Ruler: The steps to set the ieﬁ and right indents with the ruler areas followsﬁ
e Seiect thg Paragraphg§) for which you want to set tabs

‘e Point to and then drag the appropriate triangular indent markers to the desired locations. When you
release the mouse button, lhé text will be indented according to the speciﬁcation.

By Paregraph dialog bex: Usmg ;g, you can specify the left, nght first line and hangmg indents. The steps to set
indents are as follows:

o  Ssleut paragraph(s) io be zpdem@d
e Select the paragraph option of the Format meny
The Paragraph s!ialog"ié% isdisplayed.
»  Enterthe specifications in the Leftor Right] Indentatlon spin box
You ean also select First Line or Hangmg mdent from the Special drop-down list box
e  Selectavalue in the By spin box.
e Cliconthe OK button.

,z,g Borders and Shading

You can add borders to any side of a paragraph and you can add background shadmg You can also add borders
and shading to ordinary text and 1o the g@;gg%&g in @g;g cells and frames. Chckmg Boxderg and Shadmg from
Format menu can do this.
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4.2.6 Aligning Text

 Alignment is a way of organizing the text, It refers to the position thh@ text relative to the margins, Ward
enables the user to left-ali gn, right-ali gn, center-ghgn and justify the text in the document in order the text in the
document in order to enhange it. Using the four formating toolbar buttons ean do this, By d@fault, Wgrd uses left

alignment.
"Left alizned: Textis said (o be left ahgned ifitisaligned with thleft margin thh@ page. This is thg default mode of
alxgmnem.

pamgmph, posmon the cursor on any !me thhm 1hg pamgraph and chck on tb@ Ahgx Right button on the F ormamng
toolbar.

-Centered; The center option is numally-used to center the heading and text. To centera line of text, position the
cursor on the line and click on the Center button gn' the Formatting toolbar.

Justified; This featurc aligns a paragraph with both the left and the right margins Inter word spacing is adjusted
such that each lme of text beings at the left margin and ends at the right margin. To justify a line of text, posxtxon the
| cursor on that lme and click on the Justify button on the formattmg toolbar,

4.2.7 Section Break

Section breaks divide a document into sections. The breaks appears as double-dottcd lmcs cqntafmpg the words
End of Section in Normal view. The following steps to insert a sectxon breaks are:

¢  Positionthe insertion pomt at the location where you want to in,sert, a break
e  Seloctthe Break option from the Insert menu
- The Break dialog box is appeared. .

®  Select one of the following options in the Section Breaks are of the Break dialog box,

&  Next page radio button to insert a section break and begin the new section at th@ top ofth@ next

" page ,
©  Continuous ragdio button to insert a section bmak ax;d begm the new seeucm on the same page
below the previous section
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©  Evenpage radio button to insert a section break and begin a new section on an even-numbered
page | B
@ ()dd page button to inéert a section break and begina ne§v section on an odd-numbered page.
’ Click on the OK button to close the Break dialog box. |
To delety a section break, select the section break and press the del key.
4.2.8 Paging |

Word offers a Qariety oftoolsto heli) you autornatically number pages. You can choose from many page numbering
format and style choices and position page numbers ﬁearly anywhere that pleases you. If you plan to break a
document into multiple sections, you may want to insert page numbers before you split the document into sections.
Otherwise, you will have to repeat the page numbering for each section of your document.

Page Breaks: Word uses “Soft” and “Hard” page breaks to indicate when one page ends and another begins.
There are two categories of page breaks
e  Soft Page Break: Word ‘automaticalvly inserts it, when text reaches the bottom of the page and is
" represented by a dotted line across the document, The text beneath it will appear on the second page
if we print this document. The posmon of Soft Page Breaksina document automatxcally changes when

text is added or deleted to reflect the new page boundarxes

e Hard Page Breaks: Your insert Hard Page Break when you want to end one pége and ‘:Begin'anot‘her.'
- Thisisdone via the “Break” command in the Insert menu or by pressirig “Ctrl+Enter”, Hard Page

-+ Break appears with the words “Page Break” on the line. They remain at the exact same spot in the-

“document regardless of a‘nyftext“'changes you make. To removea hard page break you position the:
cursor just after it and press the backspace key, or position the cursor at the start of the page berak

and press the “Delete” key.
The page number are placed in a frame in the header or footer area. There are two methods, which aer as follows:
»  Using The Header and Footer Toolbar method: The steps to add page numbers by this technique are
as follows: '

©  Openthe header and Footer area by double-clicking on the header or footer in the document.
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©  Click on the Insert Page Number button in the Heder and Footer toolbat.
A number isinserted in theﬁeader or footer area at the i msemon pomt

T e Usmg the Page Numbers option: This option provides a variety of numbering options mc!udmg Page
numbering formats and styles and Suppressing first page numbers. The steps to insert page numbers
_ areas foliows:

©  Selectthe pége Numbers from the Insert menu.
: The Page Numbers dialog box will be displayed.

@  Specify the position and alignment for the page r:umber using the Position and ah gnment drop-
down boxes, respectively. . ;

'Putacheck mark in the Show Nurnber‘on the First Page Check box.

©

@ Click on the Format button in the Page Numbers dialog box.
The page Number F ormat dialog box will be displayed. |
©  Make the appropriate selections in the Page Number Format dialog box. *
Dk Click on the OK button to close the Page Number Format dxalog box.
' 6 Click on the OK button to close the Page Numberdlalog box.

4. 2 9 Addrtmg Headers and Footers

l\”leasders and footers contain text that needs to be displayed on each page of a document. Headers get displayed
atthe top while footers at the bottom of a document. You can use identical headers and footers on all pages in your
document, or. you can specify different contents for each section of the documents Odd and even pages can have
different designs if you wish. Toentera header that repeats onall pages in'your decument, do the following;

e  Firstchoose View from the menu and then Header and Footer
. The Header and Footer toolbar is displayed. ‘
@ Create and edit header text. You can also paste ‘graphics.-
e Clickonthe Close button or double-click in the main document.

The steps to add footer are as follows: ,

~® Sclect the Header and Footer option from the View menu.

270 ‘ Directorate of Distance Education



BBa s iINbNNRabI U NEi It davanderiodiidbidrriiidataisivnenne bebesiddbiraincinariennis Wesorbieriieiisdiiibiaiaccenss Vbessieibisocodvitonidine MlcrOSQﬂ ord

]

Type or edit the footer text.

Click on the close button,

4.2.10 Paper Size and Page Orientation

The paper size tab in the Page Setup dialog box chosen from the Page Setup in the File menu can be used for
selecting the paper size. The options that are available depend on the c,apabilitiés of the printer you have selected.
To use a custom paper size, type the dimensions of the paper you want to use and also be sure that the printer is
capable of feeding the custom paper size through its printing mechanism.

Page orientation can be vertical (Portrait) or horizontal (Landscape). To select the paper size and page orientation

follows the following steps:
| & Select the text you want to have a different paper size or page orientation.
e FromtheF ile menu, choose Page Setup and then select the Paper size tab.
>0‘ Select the paper size on which you wantto print and th¢ page o_rientation.
o IntheApply To bo_k, select how much .of the document you Want to print on the selected paper’size or
in the selected orfentation. ' ' '

¢  Thenclick the OK button.

4.2, li Paper margin

Margin detenhine the distance between the té;xf and tAhe‘;‘)ag'e of the ;Saper. In Word, text and gxabhics are normally
printed inside the margins while headers; footers and page numbers are printed in the margins. The most straight
forward method is as follows: '

Place the insertion poinf on the page where you want margin settings to be changed (unless you plan to

see the whole document choice).
Click the Page Setup from the File menu.
The Page Setup dialog box is displayed.

If need be, change paper size and orientation by using the Paper Size tab.

 Switch to the margins tab if it is not already displayed.
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®  Current settings are shown in the various margin dimension boxes.

¢ Typethe dimensions you desire, of click the little triangles to increase and decrease settings. The
Preview will change as you work.

o Whensatisfied, click OK.

' Mu-ror (Facing) Margins: Select the Mirror Margins feature in the Margins tab of the Page Set up dialog box
when you want different left margins widths and your final output will be two-sided. Word makes inside margins of
odd and even numbered pages the same size; and does the same with the outside margms of odd and even page.
When adjusting margins in Print Preview, if you have chosen thé Mirror Odd/Even feature.

4.2.12 Bookmarks

Bookmarks are used to identify the beginning of a chapter, tables or the place in the document where you left off,
- Youcan mark a section, a chapter, a ran; - of characters, graphics or any other Word element, Bookmarks can be
vsed 1o jumy: tc specify points in a docunient wnhout having to scroll or search through the pages in the document

Tocreatea bookmatk, the follo wmg steps are
e . Position the insertion point at the location where you want to create a bookmark,
e  Selectthe Bookmork option from the Insert menu.. |
The Bookmark dialog box is disp)ayed.
¢ T ype aname for the bookmark in the Bookmark Name tht box

e Chck on theAdd button. . .

Bookmark names can obtain up to 40 characters. A name must begin with a letter and can include numbers, letters
and underlines but not spaces, punctuation marks or other characters. The stepsto go toa predefined bookmark

are as follows:
e Select the Go To eption from the Edit menu.
The Go To dialog box is aplpeared.
2 Choose the bookmark option from the Go To what scioll list.

¢ Choose the name of the bookmark from the Enter Bookmark Name drop-down list -
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e Click the Go To button.
To delete the bookmarks the following steps are requierd:
. ~ Choose the }Bookmar{kﬂ épgion from the Insert menn. (}
»  Select the name of thé bookmark to be deleted.
e Clickthe Delete button.
*  Clickthe Close button.

4.2.13 Table

Word's Table feature enables you to ¢ wrange columns of numbers and textina docunient without usmg tabs. It
consists of horizontal rows and ver:ical columns. The intersection of a column and row is & rcctangular or square
box called a cell. You do typing in the celis. Cells can contain text, numbers, or graphics. A number of table specific
features let you control the size, shape, and appearance of cells. Border and shading features are available. It is

-also easy to insert the delete rows and columns. The text wraps to the next line according to the width of the cell.

ifthe width of the cell is adjusted, the text also adjusts to the new width.
Creating'a Table: To insert a table in a document the following steps are required:
» Placetheinsertion point where you want to.inserta table.
e Choose the Insert option from the Table menu
-The Insert Table dialog box is appeared -
e  Mention the number of columns and rows for the table in the Number of Columns and Number of
Rows text boxes respectively. |
‘- You can use the Auto Format button to apply predefined formats to the table when Word createsiit.
e  Click the OK button.

Entering and editing text in a table: You navitage, enter and edit table text just as you do any other Word text.
The mouse or arrow keys are ‘used to position the i insertion point. The cells are thought ofas mxmature pages and
the cell borders as margins. Type the text normaily within these cells and Word will automatically wrap text within
the cell as you reach the nght edge Rows will automatlcally grow taller as necessary to accommodate your typing.

Remember the followings:
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To move from cell to cell within a tablc, cither use the Tab key to go forward and Shift + Tab to go

backward.

Pressing Tab in the right most column will 1 move down the insertion point to the begmmng of the next
row and pressing Shift + Tab past the left most column will move the insertion point to the end of the

previous row.

Acell can contain more than one paragraph. Paragraph creation is done in the usual way.

Converting Tables to Text: To convert an existing table to text, do the followings:

- Select the table cells you wish to convest, ot A&t—kdo\xbie click to select the whole table

Choose the Convert option from the Table menu

| Choose the Table To Iext optxon

The: Convert Table To Text dialog. box is dxsplayed

** Choose one of the options: paragraph marks, tab-delimited text, comma-delimited text, and others.
" The paragraph option will convert each old table cell into at least one paragraph. If the table’s cell

contains multiple paragraphs, the paragraph marks are retained during conversion. If you pick the
comma or tab options, Word will convert each row of’ “your table into the paragraph Cells from the
tables will be separated within the paragraphs by tabs or commas.

Click on the OK button,

Converting Text to Table: To convert text to a table, do the followings:

- Highlight the text you want to turn into a table

Choose the Convert option from the Table menu,

Choose the Convert Text To Table option.

The Convert Text To Table dialog box is displayed.

Click on the appropriate option button.

The Convcrt TextTo Table contains dxﬁ'ercnt options. Among these some are explained below:

“Tab: Lines of text separated by paragraph marks or the breaks will bccomc rows in your table. Tab-separated
strings of text within those lines will become cell entries in the row. Word will automatically create the necessary
number of columns based on the maximum number of tabs in a line.
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{>omma: Lines of text sepated by paragraph marks or line breaks will become rows in your table. Comma-
scparated strings of text within those lines will become cell entries in the row. Word will autpmatically create the.
aecessary number of columns based on the maximum number of commas ina lme Beware of commas that might

creats uninternational cells.

Parag:aph: Word will propose a single column and create as many rows as you have paragraphs." Changing the
number of columns will distribute paragraphs among the columns from left toright. Ina two-column lay-out, the
first paragraph would end up in the top-left cell of the new table, the second paragraph in the top-right cell, the third

in the left cell of row two, and so on.

‘Aodrfymg a Table: Modtfymg a tﬂhle mvolves selectmg, inserting, deletmg, copymg and moving rows, columns '
and cells. It also describes how to change the spacmg and column width and how to splxt a table The steps to insert

arowinthe table are as follows:
o Select the row where you want 2 new row to be inserted
B ‘ Select the Insert Rows option f;om the Table menu
o Click on the OK button. |
Whe: a row is inserted, Wdrd shifts the selected row down to make room for the inserted row. The steps to insert
a cohun in the tabie are given eblow: : ’
o  Selectthe column where you wanta new column to be inserted
. Sélect the Insert Columns option from the Table melxu
s+ Clickonthe OK button,

When a column is inserted, Word shlﬁs the selected column to <ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>